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Preface

Preface

Thank you for purchasing your Topcon receiver, survey product or
accessory (the “Product”). The materials available in this manual (the
“Manual”) have been prepared by Topcon Positioning Systems, Inc.
(“TPS”) for owners of Topcon products. This Manual is designed to
assist owners with the use of software (the “Software”) to be used
with the Product and its use is subject to these terms and conditions
(the “Terms and Conditions”).

@ Please read these Terms and Conditions carefully.

Terms and Conditions

USE This product is designed to be used by a professional. The user
should have a good knowledge of the safe use of the product and
implement the types of safety procedures recommended by the local
government protection agency for both private use and commercial
job sites.

COPYRIGHT All information contained in this Manual is the
intellectual property of, and copyrighted material of TPS. All rights
are reserved. You may not use, access, copy, store, display, create
derivative works of, sell, modify, publish, distribute, or allow any
third party access to, any graphics, content, information or data in this
Manual without TPS’ express written consent and may only use such
information for the care and operation of your receiver. The
information and data in this Manual are a valuable asset of TPS and
are developed by the expenditure of considerable work, time and
money, and are the result of original selection, coordination and
arrangement by TPS.
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TRADEMARKS Topcon®, HiPer®, TopSURV™, Topcon Link™,
Topcon Tools™, and Topcon Positioning Systems™ are trademarks
or registered trademarks of TPS. Windows® and ActiveSync® are
registered trademarks of Microsoft Corporation. Bluetooth® is a
registered trademark owned by Bluetooth SIG, Inc. and is used by
Topcon Positioning Systems, Inc. under license. Sokkia Corporation
and the names of Sokkia Corporation products referenced herein are
either trademarks or registered trademarks of Sokkia Corporation.
Satel is a trademark of Satel, Oy. Other product and company names
mentioned herein may be trademarks of their respective owners.

DISCLAIMER OF WARRANTY EXCEPT FOR ANY
WARRANTIES IN AN APPENDIX OR A WARRANTY CARD
ACCOMPANYING THE PRODUCT, THIS MANUAL AND THE
RECEIVER ARE PROVIDED “AS-IS.” THERE ARE NO OTHER
WARRANTIES. TPS DISCLAIMS ANY IMPLIED WARRANTY
OF MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR
USE OR PURPOSE. TPS AND ITS DISTRIBUTORS SHALL NOT
BE LIABLE FOR TECHNICAL OR EDITORIAL ERRORS OR
OMISSIONS CONTAINED HEREIN; NOR FOR INCIDENTAL OR
CONSEQUENTIAL DAMAGES RESULTING FROM THE
FURNISHING, PERFORMANCE OR USE OF THIS MATERIAL
OR THE RECEIVER. SUCH DISCLAIMED DAMAGES
INCLUDE BUT ARE NOT LIMITED TO LOSS OF TIME, LOSS
OR DESTRUCTION OF DATA, LOSS OF PROFIT, SAVINGS OR
REVENUE, OR LOSS OF THE PRODUCT’S USE. IN ADDITION
TPS IS NOT RESPONSIBLE OR LIABLE FOR DAMAGES OR
COSTS INCURRED IN CONNECTION WITH OBTAINING
SUBSTITUTE PRODUCTS OR SOFTWARE, CLAIMS BY
OTHERS, INCONVENIENCE, OR ANY OTHER COSTS. IN ANY
EVENT, TPS SHALL HAVE NO LIABILITY FOR DAMAGES OR
OTHERWISE TO YOU OR ANY OTHER PERSON OR ENTITY
IN EXCESS OF THE PURCHASE PRICE FOR THE RECEIVER.

LICENSE AGREEMENT Use of any computer programs or software
supplied by TPS or downloaded from a TPS website (the “Software”)
in connection with the receiver constitutes acceptance of these Terms
and Conditions in this Manual and an agreement to abide by these

Terms and Conditions. The user is granted a personal, non-exclusive,
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Terms and Conditions

non-transferable license to use such Software under the terms stated
herein and in any case only with a single receiver or single computer.
You may not assign or transfer the Software or this license without
the express written consent of TPS. This license is effective until
terminated. You may terminate the license at any time by destroying
the Software and Manual. TPS may terminate the license if you fail to
comply with any of the Terms or Conditions. You agree to destroy the
Software and manual upon termination of your use of the receiver. All
ownership, copyright and other intellectual property rights in and to
the Software belong to TPS. If these license terms are not acceptable,
return any unused software and manual.

CONFIDENTIALITY This Manual, its contents and the Software
(collectively, the “Confidential Information”) are the confidential and
proprietary information of TPS. You agree to treat TPS’ Confidential
Information with a degree of care no less stringent that the degree of
care you would use in safeguarding your own most valuable trade
secrets. Nothing in this paragraph shall restrict you from disclosing
Confidential Information to your employees as may be necessary or
appropriate to operate or care for the receiver. Such employees must
also keep the Confidentiality Information confidential. In the event you
become legally compelled to disclose any of the Confidential
Information, you shall give TPS immediate notice so that it may seek a
protective order or other appropriate remedy.

WEBSITE; OTHER STATEMENTS No statement contained at the
TPS website (or any other website) or in any other advertisements or
TPS literature or made by an employee or independent contractor of
TPS modifies these Terms and Conditions (including the Software
license, warranty and limitation of liability).

SAFETY Improper use of the receiver can lead to injury to persons or
property and/or malfunction of the product. The receiver should only
be repaired by authorized TPS warranty service centers. Users should
review and heed the safety warnings in an Appendix.

MISCELLANEOUS The above Terms and Conditions may be
amended, modified, superseded, or canceled, at any time by TPS. The
above Terms and Conditions will be governed by, and construed in

P/N 7010-0493 iX
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accordance with, the laws of the State of California, without reference
to conflict of laws.

Manual Conventions

This manual uses the following conventions:

Example Description

File » Exit Tap the File menu and tap Exit.

Enter Indicates the button or key labeled Enter.

Topo Indicates the name of a dialog box or screen.
Notes Indicates a field on a dialog box or screen, or a tab

within a dialog box or screen.

Supplementary information that can help you
configure, maintain, or set up a system.

on system operation, system performance,

@ Supplementary information that can have an affect
measurements, personal safety.

TopSURYV User’s Manual



What's New

What's New with
TopSURV

The chapter briefly describes new features and functions for version
7.2 of TopSURV.

IS Robot [ T it [ Canced

IS Robot is added to the list of Robotic i
instruments in the TS configurations. Mot [Erober  H
For details on TS configurations, see
“Creating a Total Station Configuration”
on page 4-52.

I<< Back] :Nent ;;‘:

Point Line Area
Editing of codes is updated to include a N d_torr —

Code Style of Point, Line or Area. g ast

Type Area -

Buom =[]

Point | Line | Areax | attribute
Styla

Fill Styla |::'o||r.| b

Culur
Trarsparency 7o e

For details on editing codes, see “Editing
Codes” on page 6-12.

Option to Select Receiver Type

e Ruzcw

Canced.

Option to select receiver type for GPS

surve Rezcosiveer Moded  [Topoon Generic

y. Elavation Mask 10 deg
For details on GPS configurations, see RTK Format  [CMR+
“Creating a GPS+ Configuration” on

J\rmann,m T
page 4-3, ant |t fronn

Peripherals| | << Dack | | Next =
J
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SBAS setup

Setup of a satellite-based augmentation
system is updated.

For details on the setup, see “RT DGPS
Survey Configuration” on page 4-39.

[ smas setup

PRN B GPSF | Typer *

¥ 120 ADRF 2 FGHNOS
121
122 AOR-W WAAS
123
124 Artemis EGNOS
128 et
< >
lono Coer
Usar sat oanly it avail w

[<<Iiatk]:nan>>:

Internal CDMA/GPRS Network
Connection

Now automatic connection is available
for internal CDMA and GPRS network
connection.

For details on network connection, see
“NTRIP Internet Configuration” on
page 4-30.

[ vetwork conn Il BT
Signal [

Querying Sigral Quuality
~ Making PPP connection
¥ Querying Mount Points
¥ Conrwecting to NTRIP Serves

F----------------
Mot Net-1 R23 MNoGL

Modem Sat Successfully

Prism Constant

Separate BS/FC prism constant is now
available for setting.

For details on the setting TS survey
parameters, see “Creating a Total Station
Configuration” on page 4-52.

Bl survey pares. | (200
Meas Type  [HASVASSD "
EDM Moda  [Firm: tmm -
Backsight . |U Offset w
Foresight P.¢ [0 Offset = ...

Point Guid |Prism

Auto Topo

Method =
Inturval PRI

(< ook ][t 2

Traverse Adjustment

Traverse adjustment of a surveyed
traverse is added.

For details on traverse adjustment in
COGO calculations, see “Traverse
Adjustment” on page 10-24.

@‘US}

FRotate Trarckite
+ +

Rotate
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Chapter 1

Introduction

TopSURY is Topcon’s survey software available for hand-held
controllers. TopSURYV is used for surveying, common layout, and GIS
purposes including:

* Field data collection with Topcon GPS receivers; Topcon, Sokkia,
Nikon and Leica Total Stations; and Topcon Digital Levels

* Roads design to create cross section templates, horizontal, and
vertical alignments

* Stakeout designed objects
» Data conversions to a variety of file formats
COGO calculations

TopSURY installs on hand-held controllers that run Windows® CE
operating system, such as Topcon’s FC-2000, FC-2200, FC-2,500,
FC-200 (with Windows Mobile 5 as well) and the integrated
controller of GMS-2 and GMS-2 Pro. Topcon Link PC software is
included with TopSURYV providing data integration with your current
office software.

Also, TopSURYV 7 for Windows PC is available from Topcon website.
It will operate in a ‘demonstration’ mode, allowing 25 points to be
added to a job. To fully activate, a separate license must be purchased.

P/N 7010-0493 1-1



Introduction

TopSURYV on Controller

The TopSURY setup file will first be loaded onto a computer. To
install TopSURYV onto the controller, use ActiveSync and a
connection between the computer and the controller receiving the
software download.

Microsoft® ActiveSync® must be installed on the
computer before installing TopSURV.

website. (For downloading, access the website
http://www.microsoft.com/windowsmobile/).

‘i ; i ActiveSync is available for free from the Microsoft

System Requirements

Minimum system requirements includes display 240x320 or 320x240
pixels, 64 MB RAM and 50 MB flash disk space (internal), and
Windows® CE version 4.0 or higher.

ActiveSync

Using ActiveSync, the controller can exchange data to a computer via
USB cable.

1. Install ActiveSync in the computer and turn on the controller.
2. Connect the controller to the computer with the USB cable.

3. The controller will give the prompt, Connecting to Host.
4

The computer will prompt to set up a partnership or set up as a
guest. Select the desired type of connection.

5. Once a connection has been established, the ActiveSync
window will display on the computer.

1-2 TopSURYV User’s Manual



TopSURYV on Controller

Installing TopSURV

Use the steps below to install TopSURV onto the computer and
controller.

1. Run TopSURVSetup.exe on your computer. The Welcome
screen displays (Figure 1-1).
TopSURV - Instalshick Wizard x|

il ivsinll TopSLEY on your
Hit

o e

Figure 1-1. Welcome Screen

If TopSURYV is already installed, the Maintenance wizard
displays the following screen (Figure 1-2):

TopSURY - InstallShield Wizard

u ‘r"__—|
o
Plansn wnawhila the IninlSheid Wisnrd peapasns the 1oup |

TopSURY Setup is
process. Please wat

sfefnfefefe]x
BBl o vouwant to completdy remarve the seectid applcation and al of it features? ]

e e |

Figure 1-2. Confirm Uninstall

Click OK to remove the previous installation of TopSURYV from
your computer.

TopSURYV will NOT be removed from the
controller.
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2.

1-4

Once the previous TopSURYV installation is removed, run
TopSURVSetup.exe again.

Review the License Agreement (Figure 1-3).

SpSURN - Instalstield Wizatd
Licanze Agroesant

P falmwing

ANDOBEOE

[Topcan Postioning Sysims, Inc.
[TopS LAY cominolker Ecfwan

[ECFTWARE LICENEE AGREEMENT

[READ THES BEFOFE USE

puschazhg you Frducr].

T sk Topcon
[Frationing Systeme, Ine. (TP or mamars of Tapean Prockicts. Tha Manwsl s dasigna
LT

asbjenct ot e & arecd e diicns [ “Tams and Condiicns].

=l

I | acoopt theamms 01ha lcansa sgeemant
3

< Back s concal |

Figure 1-3. License Agreement

* To accept the terms and continue, click the “T accept...” radio
button and click Next.

* To decline the terms and quit installing TopSURY, click the “I
do not accept...” radio button and click Next. The
InstallShield Wizard will close and TopSURYV will not install
onto the computer or controller.

Select the features to install (Figure 1-4) and click Next.

TopSURY - InstalShiek] Wizard

Description
& rjProjaction Filss TopSURY, Tepean's Usiversel
UK CETHIE Corfrales i the Mein
Hetherends FONASTRANSTH) Applcation prograen thal ngad
Bolghm o b ingtalied inta the CE
Mtherlards ROMARTRANS(TM) - 2004 (FTiir AR
Fun
Gewid Fil
UK G
Metharandy
# [ Canaria
Duich 2004 Geoid ﬂ
27 ME ol space meuned on the C dive
1512832 MB of epace sniaiila on the C drive
¢Bock B 3 concsl |

Figure 1-4. Select Features to Install

After detecting device information, the wizard will begin the
installation process.

Click Install to begin (Figure 1-5 on page 1-5).
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TopSURYV on Controller

TopSUEY - Instaltshickd wWirard slulnlelc|e]|x|

Fandy 1o Install tha Program 2

Chick Install 19 begin the installation.

muiew ar chang click Bnck. Click C
wizerd,

< Back Ingtal Cancel

Figure 1-5. Select Device

During the setup process, installation files are copied to the
appropriate directories in your computer for ActiveSync to access.

Once finished, TopSURYV installation accesses ActiveSync and
launches Add/Remove Programs to install TopSURYV in the controller
(Figure 1-6).

OpSURY - InstaliShisid wizand

Hetep Hralua ‘-

TopSURN iscaniguringrou new sobwere instellsion

Ieling

© A T2pSURVToRSL Y. HPC2D00_] M5 CAB

Figure 1-6. Setup Status

If the controller is disconnected from the computer, the following
screen displays (Figure 1-7). After connecting the controller and
computer, click OK to continue.

srerwline Appcation Trstal s[efwfelc|e]x|
0 s et ok it cormachion, the Instaled applcations wilbe dawrikoadsd 1 the device,

Figure 1-7. Install Completion Pending Controller Connection
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ActiveSync starts the Add/Remove Programs process, which
automatically detects an available installation and attempts to install it

on the controller (Figure 1-8).

| Appications Already Installed slefrfefe]|ef=|

TTPS TopSLRV™ s aready o procend

[
Figure 1-8. Data Retrieved From Mobile Device

6. Click Yes at the Installing Applications screen (Figure 1-9) to
install TopSURY into the default directory in the controller.

Trstal "TPS TopSURY™ using the default appication instal drectory?

e | e | cmes |
Figure 1-9. Installing TopSURV

If the controller does not have space available (Figure 1-10), a prompt
will display to delete some files or programs to make room for
TopSURY, or to select other destination media.

st Detination Media_ x|

reor coppeg e IEDOBOEY m—
There i not encugh free desk space on the moblls device. EZ2E —
Deleta ore or mars fles o fee diek space and then iy agan. Spnce required 15 16EHK

=1 P

[ ] _ oot |

Figure 1-10. Delete Files to Provide Space or Select Destination Media
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7. After clicking Yes, ActiveSync copies the installation file (CAB
file) from the computer to the controller.

.%.Add/Remove x|

Select a program's check box if you want ta inztall it on your
mobile device, or clear the check box if you want to remove the
program from pour device.

Mote: If a program that you installed is not listed, the program was
not designed to be uged on your mobile device.

Installing Applications 5 | LU| D| R| D|

Installing TPS TopSURY...

Space available on device:
[V Install program into the default installation folder

Remave from both location

To remove the selected program from bath R

your device and this computer, click Remove, _ DETEVE |
[k I Cancel | Help |

Figure 1-11. Installation Complete

8. Once the transfer completes, follow the steps indicated on the
controller’s screen to complete the TopSURYV installation.

Then the Setup Status screen displays to configure software
installation. When finished, the InstallSheild Wizard Complete
screen displays.

9. Click Finish to exit the install program.

10. Once the installation completes, the TopSURYV icon will display
on the controller screen to start TopSURV.
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Uninstalling TopSURV

The Remove Programs tool in Windows CE or through the Add/
Remove Programs tool in ActiveSync both uninstall (remove)
TopSURYV from the controller.

recommended before installing a software upgrade.

‘i ; i Removing TopSURYV from the controller is
Be sure to save all necessary job files first.

Starting TopSURV

To start TopSURY, tap the TopSURYV icon on the controller screen
and then press the Enter button. Upon initial startup, TopSURV
requires an access code to run (Figure 1-12). Contact a Topcon
representative to acquire the necessary codes.

* Key Value — the identification number of the device; record to give
to a Topcon representative.

* Activation IDs — the fields in which to enter the security codes
received from a Topcon representative to activate either one or
more of the following purchased modes: TS, Contractor, Robotic,
GPS+, GIS (RT DGPS and PP DGPS), Roads, and mmGPS.

ZT o o

Key Walue I322DE|D2?45

Activation IDs

TS I
Contractor —
Robotic

GRS+ [
als [
Roads
mmGPS

Figure 1-12. Security
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Demo Mode

Once entered, the access codes are saved in the hidden tsv_setup file
in the directory where TopSURY is located.

To view existing codes or add a new code, tap the Topcon Logo Help
Icon in the top-left corner of the screen and select the Activate
Modules option.

If upgrading existing TopSURYV of previous version
@ to TopSURYV 7, the updated security key is required

to complete the installation of this upgrade.

For help in acquiring this security key, contact

topsurv_updates @topcon.com.

Demo Mode

Upon initial startup, a Demo version of TopSURV is accessible after
tapping either OK or Cancel on the Security screen. To run the demo
version, tap OK on the warning message that displays (Figure 1-13).

W T <8

Job Configure Export

Tle——

Security not enabled for
GPS Mode! The contraller
will run in Derno Mode with
limited functionality!

T TR

A (1
b 4 3
rE L B
Calc Wiew Map  Switch Mode

Job

Figure 1-13. Access to Demo

A full-featured demo version of TopSURYV will be available with
operational data limited. This demo version can store up to 25
surveyed points and roads of 100 meters in length.
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Chapter 2

Getting Started

TopSURY initially creates a Default job upon program installation.
By default, all jobs are stored in the Job folder of the TopSURV
directory (Figure 2-1).

Created: 09f30f2007 22:33
Modified:  09f30f2007 22:33
\...\TPS\TopSURV\lobs

[ Exit || New |[Browse || open |

Figure 2-1. Open Job

* Open — makes the Default job current and opens the main screen
(see Figure 2-6 on page 2-5).

* New — press to create a new job.
* Exit — quits the program.

* Browse — press to display browse directories to navigate to a
desired job. Highlight the file and press OK to open the job from
a remote directory (Figure 2-2 on page 2-2).
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EOpen Job OK | Cancel

Type: |J|:|b Files (*.tsj) »
\Storage Card\TPS}

[(1TopSURV

fg 3road. ts3]

Name |3r|:|a|:|.tsj

Figure 2-2. Open Existing Job

Starting from version 7, TopSURYV job’s files are made universal for
using on controllers and personal computers. They have the #sj
extension and need no conversion. You can transfer the *.tsj files
between Windows CE and Windows PC databases directly using:

* A flash memory card and the PC card reader.

* Copy/paste procedure and ActiveSync connection.

to copy these folders from the directory where the
job resides. The copied job will work correctly but
the previous job history will be lost.

@ If the job has photo notes and the job history, be sure

* Topcon Link conversion utility installed on the PC (For detail see
“Using Topcon Link with TopSURYV Job Files” on page B-1) and
ActiveSync connection.

» Topcon Tools data processing software installed on the PC and
ActiveSync connection.

* TopSURYV PC installed on the PC through import/export
procedure from/to the Device and ActiveSync connection.
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Opening Old Jobs

To open a job created in a previous version of TopSURY, click

Job » Open Job and tap the Browse button in the Open Job screen
(Figure 2-2 on page 2-2). Then select the T's6 Job Files (*.tsv) type,
navigate to the desired tsv job, highlight it, and press OK

(Figure 2-3).

;F}_—_" I ! EOpen Job Canl:el
Type: s6 Job Files (*.tsv )Y
Job Cpen Job

\...\TPS\TopSURV}Jobs}

3road.tsy

Name |

Figure 2-3. Open Old Job

Tapping OK starts upgrading the job. Tap the Cancel button to abort
upgrading. When the process is complete, the Cancel button turns
into the Done button (Figure 2-4 on page 2-4), which opens the main
screen for the upgraded job.
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Ejub Upgrade Progress |

Upgrade Complete!

Figure 2-4. Job Upgrade Progress

After pressing the Done button, the *.tsv file turns into the *.tsj file
and the Archive folder is created in the directory where the *.tsv file
was located. This folder stores the .zsv jobs. If the job had a job
history, a directory using the same name as the job, is also created to
store the *.xml file with the job history (Figure 2-5).

Fle Edit View Go | |l§? X
4 9 T mR=0

arne | Size | Type
idroad | File Falder
7 Archive File Folder
# Jroad.ts) 885KE  TopSury Job
F Default.ts) S86KE  TopSury Job
< >

Figure 2-5. Upgraded Jobs
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Automatic Backup of Jobs

To increase the reliability of work with jobs in TopSURY, a backup
copy is automatically created of the current job. This automatic
renewal occurs about every ten minutes and is safely stored with a
new name, i.e., file_name!YYY-MM-DD!.tsj.bak in a folder where the
original *.tsj file is located.

TopSURYV will create a separate *.bak file for the current job every
time the user opens the *.tsj file during the day with another date, but
there cannot be more than three such files. If the *.tsj file is opened in
subsequent days, the *.bak files previously formed will be overwritten
to the ones with the newer dates.

If, for any reason, there is a problem opening the original *.ts file in
TopSURY, Topcon Tools, or Topcon Link, you can rename the latest
* bak file to the *.tsj file and try to open the renamed file.

Main Screen

The TopSURV main screen opens to work in the current job
(Figure 2-6).

EDefault . Q &
e
g ‘ T J/
Job Configure Import
- Tl
L, L\ | Q\?
[ 4
Export Edit Job Edit Roads
.
Setup GPS Survey Stake
vor E
A .
-, v T
COGO Map Mode
Job

Figure 2-6. TopSURV Main Screen
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TopSURYV has two implementations of graphical

@ user interface: Icon-based and List-based. By
default, TopSURYV uses the Icon-based interface for

fast and easy program operation.

To toggle between the Icon and List Menus

(Figure 2-7), tap the Topcon Logo Help Icon in
the top-left corner of the screen and select the Switch
Menus option.

PFrsite 1 B @K
Job Edt ¥w Srv Stk Cg H

%Iﬂ%@ﬂ

—————50m

Figure 2-7. List Menu

Title Bar

The title bar of the main menu screen shows the name of the job that

is open and the following icons (Table 2-1).
Table 2-1. Title Bar Icons

Icon Description

Topcon Logo Help Icon — opens a pop-up menu giving access to the
help files and some options specific to the current open screen

Controller Power Status Icon — shows power status

Reconnect Icon — reconnects other Bluetooth enabled devices to the
controller
Connection Status Icon — shows connection status

B
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Main Screen

Table 2-1. Title Bar Icons (Continued)

Icon

Description

X]

Exit Icon — closes TopSURV.

Return Icon — returns to the previous menu. When in a submenu, the
Exit Icon turns into the this button.

When within a menu option, the title bar displays the Topcon Logo
Help Icon, the name of the open screen, and any system buttons (e.g.,
OK, Cancel, Finish) required for various operations (Figure 2-2 on

page 2-2).

Main Icons

The TopSURYV Icon Menu on the main screen contains the following
icons to provide access to job configuration, setup, display, and other
jobsite functions, and to control data (Table 2-2):

Table 2-2. Main Menu Icons

Icon

Description

Job — opens a submenu to create, open, delete a job or get information
about an active job.

Configure — opens a submenu to create or change a configuration for a
job. The icon changes its appearance and reflects the instrument set for
use in the current job.

Export — opens a submenu to export job data to a new job, controller
or a file.

Import — opens a submenu to import data from a job, controller or a
file.

Edit Job

Edit Job — opens a submenu to edit the job data.

2

Edit Roads

Edit Roads — opens a submenu to edit roads.
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Table 2-2. Main Menu Icons (Continued)

Icon Description
" Setup Base — sets up GPS surveying.
Setup GPS

Setup — sets up backsight and occupation points to start a Total Station

/’i’\ survey,

Setup

»

Suryey

J Stake — opens a submenu to stake out objects.

Survey — opens a submenu to conduct a survey.

Stake

COGO - opens a submenu to calculate cogo tasks.

amd

L ]
|
-

COGO

v

Map

Map - opens the map for the current job.

: Mode - switches between GPS and Total Station instruments for a
T‘E survey.
B

Mode

Viewing Port Traffic

To view or save to a file incoming and outgoing traffic information of
a controller port connected with TopSURY, tap the Topcon Logo Help
Icon in the top-left corner of the Icon Menu screen and select
the Port Data Logging option.

1. The Port Logging screen (Figure 2-8 on page 2-9) initially
shows no data. Tap the Help Icon in the upper-left corner of the
screen to open a pop-up menu and select one of the following
options:
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Viewing Port Traffic

» Show incoming port data — check mark to view incoming
data.

» Show outgoing port data — check mark to view outgoing data.

* Pause logging to screen — check mark to freeze the show of
port traffic.

o o]

Port traffic
=T -~

R

DLOZE, DLIMK, 1,4C,C,0000,399,0000,0000,100.0
nr@az

|[o01F

CPO0E. ity
SG012*F
GTO07 5.
PS009...

R

DLOZE, DLIMK, 1,4C,C,0000,399,0000,0000,100.0
nr@az

|[o01F

[l

Append

Figure 2-8. Port Logging

2. Check mark the Log to file box to save the data to a file. When
the Save File screen (Figure 2-9) displays, assign a name and
select a desired directory in the controller to save the file.

ool

Type: |Text Files {*.txt) -
\Storage Card\TPS}

[CATopsURy

MNarme ||:|:|mm.||:|g.txt

Figure 2-9. Save File
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3. Tap OK to return to the Port Logging screen to view the data
being saved to the file. The file name is also shown on the
screen (Figure 2-10).

ot cosono N (200

Port traffic

nr@az -~
|[o01F

REQ163FILEINFO% 1 rsss000s ]
REODE3:CURLOG

RE01636AEOUT_SN% SQIIIABPCSG

05 2™,

PGOIE =.=..7. RaC.7. K.AdE ~@.,

DPOOEGe.? 2.7, 7.

P@7.2.0=.

DLOZE, DLIMK, 1,4C,C,0000,399,0000,0000,100.0
nr@az
|[o01F

[ ]&ppend

cornm.log. txt

Figure 2-10. Logging to File

4. Check mark the Append box to add new data to the existing file
on every start of TopSURV. Press the OK button to confirm the

operation.

2-10
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Accessing Help Files

Tap the Topcon Logo Help Icon in the top-left corner of any
screen and select the Help option to open the general TopSURYV Help
topics or a specific option for the current screen (Figure 2-11).

Eosite_1 R
[romr )
Su «=20DB &

{ TopSURV

Help :
Job
Edit
Wiy
Help —
TS Survey He
GPS+ Survey
TS Stakeaut A

Figure 2-11. TopSURYV General Help Topics

Before Surveying

To start surveying with TopSURYV, make several preparations of the
available equipment (see “Preparation” on page 3-1), and create a job
to perform specific tasks on the jobsite (see “Creating a New Job” on
page 4-1).

The following sections describe the various TopSURYV functions to
assist in getting started with the software.

Data corruption can occur during data collection if

@ the controller is low on power. If a warning about
low power level displays, save and close the current
job.
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Notes:
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Chapter 3

Preparation

Global Navigation Satellite
System (GPS+) Setup

1. Plumb the survey antenna over the mark and switch on the
receiver and the controller.

2. If the receiver and the controller are Bluetooth® enabled, set
the Instrument type to GPS+ and check the Bluetooth option in
TopSURYV (change this setting later in the Observation Mode
screen).

To change the Bluetooth device that the controller is

connected to, click the Reconnect icon in the upper right
corner of the main screen.

3. If the receiver or the controller are not Bluetooth enabled, or the
Bluetooth option is unchecked, connect the receiver to the
controller with the cable and set the Instrument type to GPS+ in
TopSURYV (change this setting later in the Observation Mode
screen) (Figure 3-1 on page 3-2).
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Z I o o)

Select Instrument Type

(O Total Station | | Contractor

[]Bluetooth ICOMﬁ

Figure 3-1. Observation Mode — GPS

Total Station (TS) Setup

1. Set up a tripod and then center the instrument over the mark.

2. By adjusting the tripod legs, center the cross hairs on the
ground mark. Complete the process by using the leveling
screws of the instrument so that the bubble indicates a level
position. Switch on the total station and the controller.

3. If the total station and the controller are Bluetooth enabled,
perform the following operations:
* In the total station — select Bluetooth option and set PIN code.

e In TopSURYV - set the Instrument type to Total Station in the
Observation Mode screen; select the TS model and set the
Connection mode to Bluetooth TS; enable the Bluetooth
option in the Observation Mode screen.
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Total Station (TS) Setup

Select Instrument Type

[] Contractor

Bluetooth

Figure 3-2. Observation Mode — Total Station

* Select the TS from the list of devices and set the Passkey
value to PIN code (use the same code used in the total
station).

To change the Bluetooth device that the controller is

connected to, click the Reconnect icon in the upper right
corner of the main screen.

4. If the total station or the controller are not Bluetooth enabled, or
the Bluetooth option is no check marked, connect the controller
to the total station with the cable and set the Instrument type to
Total Station in TopSURV. Make sure the data transfer
parameters in the total station correspond to those in the
controller.
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Level Setup

1.

Set up the instrument in a desired location, with the tripod legs
well spread and tapped into the ground.

By adjusting the tripod legs, roughly level the instrument.
Complete the process by turning the level screws of the
instrument to center the bubble within the circle. Switch on the
instrument and the controller. Make sure that in the level the
Out Module is set to RS-232C and the Measure option is
selected from the Menu.

Connect the controller to the instrument with the cable and set
the Instrument type to Total Station in TopSURV.

Eobs Mode m Cancel

Select Instrument Type
O GPS+

[] contractor

Bluetooth

Figure 3-3. Observation Mode — Level



Chapter 4

Creating a New Job

Follow the procedure below to begin working with TopSURYV and to
create a New Job file.

1.

Tap the Mode icon on the main screen and select the survey
mode, GPS+ or Total Station, then tap OK (Figure 4-1).
Choose Contractor Mode in Total Station survey mode for use
by non-surveyors for Topo and Stakeout with total stations.
Choose Total Station survey mode to configure a Level survey.

TE ZE o [l
L Select Instrument Type

Mode ]
O

Station Contractor

[]Bluetooth ICOMﬁ

Figure 4-1. Observation Mode

To create a new job, tap Job » New Job or tap the New button
on the Open Job screen during initial startup (see Figure 2-1 on
page 2-1). The New Job screen displays (see Figure 4-2 on
page 4-2). Enter the Name of the job and corresponding
information (that is, the name of the surveyor and any necessary
comments). The date is stored automatically. Tap Next to move
to the next screen. At any stage, select the Finish button to
create a new job. See the following sections to create a new job
for your mode of survey.
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P ] B G
I3 V.. ATPS\TopSURVY Jobs),
Job Mewe Job

Name BITE 1]
Created By Isurvevur

Comments |

Current Date
9/2{2008 0:15 AM

Browse Next >

Figure 4-2. New Job

A Job file contains all the pertinent data for the work being done:
settings of the performed work and information on the Survey
Configuration.

A Survey Configuration is a set of settings, such as instrument
parameters or radio settings, which are independent of the job
(one configuration can be used on several jobs).

Configuration settings are applied to the equipment
@ only after opening a screen that measures and stores

data in the job file.

Survey configurations are stored in the Styles.tsstyles file in the
TopSURY directory.

3. By default all job files are stored in the Job folder of the
TopSURYV directory. To change the location of the job being
created, tap Browse on the New Job screen.

Tap Finish to make the new job current and use the
settings from the previously open job.

4. On the Survey Style screen (Figure 4-3 on page 4-3), select the
Survey Configuration, for both the GPS+ and TS and tap Next.
A Survey Configuration is a set of parameters that describe
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Creating a GPS+ Configuration

work conditions and depend upon the instrument used for the
survey.

The last open configuration will initially display.

oo sve [EIEE

Select the Configuration for the
Job or create a New
Configuration.

GPS+ Config
Name [ZVA1E v E

TS Config

Name IMy Conventiona + E

I << Back ] I Next >3 ]

Figure 4-3. Select Survey Configuration

See the following sections for procedures to create and edit survey
configurations.

* “Creating a GPS+ Configuration” on page 4-3
* “Creating a Total Station Configuration” on page 4-52

@ A user-friendly Wizard interface guides you
through the steps to create a job configuration.

Creating a GPS+ Configuration

A new configuration is performed with the help of a Wizard.

When creating a GPS+ configuration, use pre-defined configurations
or create new ones. The pre-defined configurations are listed in drop-
down menus in the corresponding fields. In the GPS+ Configuration
field, choose one of the pre-defined configurations or tap the List

(.- | button to create a new one or edit the parameters of an existing
configuration. The Configurations screen displays.
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The Configurations screen contains a list of available GPS+
configurations (Figure 4-4). Either edit an existing configuration or
create a new configuration.

ECDnﬁguratiuns m

My Metwork RTE
My Metwork DGPS
My RT DGPS

My PP Static

My PP Kinernatic
My PP DGPS

| pelete || Edt || add |

Figure 4-4. Create/Edit a Configuration

1. To create a new configuration, tap the Add button (Figure 4-4).

2. On the Srv (survey) screen, choose the configuration type
(either RTK, Network RTK, Real Time DGPS, Network DGPS,
PP Static, PP Kinematic, or PP DGPS) and enter the name of
the configuration (Figure 4-5).

ES[V Finish | Cancel
Name IM|

Type RTK v

[ ] Post Processing
[ ] mmGPS+
[] simulation Mode

Figure 4-5. Configure an RTK Survey
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Creating a GPS+ Configuration

For Network RTK, Network DGPS and RT DGPS survey modes,
select the corrections type (Figure 4-6):

* VRS, FKP, Single Base or External Config for Network RTK and
Network DGPS surveys.

e User Base, Beacon, SBAS, CDGPS, OmniSTAR-VBS or
OmniSTAR-HP for RT and Network DGPS surveys.

&G o

Name IMV Network RTK Name IMV RT DGPS
Type INetwurk RTK - Type IReaI Time DGPS -

Corrections |VRS

Single Base

[]Post Pro Qe xternal Config []Post Prog
[ ] mmGPS+
|:| Simulation Mode D SimulatiolOmniSTAR-HP

Figure 4-6. Configure a Network RTK, Network DGPS, and RT DGPS

3. Post Processing — check mark and enable to configure a post
processing survey type in either RTK, Network RTK, Network
DGPS, RT DGPS mode.

4. mmGPS+ — check mark and enable to configure a mmGPS+
aided survey type in RTK and Network RTK mode.

5. Simulation Mode — check mark and enable to run TopSURV
GPS mode in a GPS simulation mode.

If Simulation Mode is selected, the Set Simulator icon
becomes available in the Edit Job menu.

6. Depending on the mode, continue creating the configuration:
* For RTK see page 4-6.
* For Network RTK and Network DGPS see page 4-28.
* For RT DGPS see page 4-39.
* For PP Static survey mode see page 4-49.
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* For PP Kinematic and PP DGPS see page 4-45.

RTK Survey Configuration

Real time kinematic (RTK) surveying is used for topographic survey
and stakeout, and is the most precise method of real-time surveying.

RTK requires at least two receivers (Base and Rover) collecting
navigation data simultaneously and being linked via a communication
system. The Base receiver is usually at a known location and serves as
a reference station. The Base receiver collects carrier phase
measurements, generates RTK corrections, and transmits this data to
the Rover. The Rover receiver processes its carrier phase observations
with the received corrections, computing its relative position. The
closer the Rover is to the Base, the higher the probability of
determining the integer values of ambiguities. Typically, the distance
between the Base and Rover should not be more than 10-15 km.

To enable logging Base and Rover data for post processing in RTK
survey, check and enable the Post Processing box in the Survey
screen.

To configure a mmGPS+ aided RTK survey, check and enable the
mmGPS+ box on the Survey screen.

After naming the configuration and selecting its type, tap Next on the
Survey screen (Figure 4-5 on page 4-4) and continue below to finish
the configuration for an RTK survey.

1. Set the parameters for the Base Receiver (Figure 4-7), and tap
Next:

* Select Receiver Model of the Topcon receiver being used for
survey. Select either GR-3, GMS-2/GMS-2 Pro, GMS X, NET
G3, or Topcon Generic for any other Topcon receiver.

e Set Elevation Mask not to use data from satellites below this
elevation.

e Select RTK Format of the Base receiver corrections
transmitted to the Rover.
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* Select the TPS Antenna type from the list and set the height
and its type (either Vertical measured to the antenna reference
point or Slant measured to the antenna edge).

EBase Recyr Cancel

Receiver Model |Topcon Generic

Elevation Mask |10 deg

RTK Format ICMR+ -

Antenn |HiPer LitefLity «
Ant Ht [0.000 m

ISIant v

Figure 4-7. Configure Base Receiver

* Press the Peripherals button to enable the Multiple Ports
option if needed to transmit data from different ports of the
base receiver to use for peripherals (see Figure 4-8 on
page 4-8).

* Select the Receiver Settings option from the Help Icon menu
in the upper left corner of the Base Receiver screen to turn
charging mode of the receiver battery off as needed.

* If it is necessary to use relative parameters at the base with
CMR+ data transmission, select the Use Relative
Calibrations option from the Help Icon menu.

Note: You can select this option when editing the base.

By default, TopSURV uses Absolute calibration offsets for
antennas.
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Eperipherals m Cancel

Multiple Ports: |2 "

Figure 4-8. Peripherals

2. Set the Base Radio — choose the modem to be used and its
parameters, and tap Next (Figure 4-9).

EBase Radio Cancel
Radio Modem
|Intemal HiPer Lite v

Receiver Port Connected to Radio

Port C

Baud 38400 v
Data 8 v
Parity None v

Figure 4-9. Configure Base Radio

If Multiple Ports are set for peripherals (see Figure 4-8), depending
on the number of ports selected, there can be several radios for
correction data output.
3. Custom modems use a standard set of parameters: port, parity,
the number of data bits, the baud rate and the number of stop
bits. Tap the Default button to set default settings for the port.

AirLink GPRS, CDMA, CDPDl, CDMA2000, Generic, Sierra
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Wireless MP200 CDPD and Internal HiPer Pro modem types
do not require additional parameters.

Other modems require additional parameters to be set. These
parameters are available for setting in the Base Radio
Parameters screen.

¢ For Digital UHF modems (Internal GR-3 Digital UHF, Internal
HiPer Digital UHF, TRL-2 and TRL-35 External Digital UHF),
set the operation protocol and modulation type (Figure 4-10).

Finish lCanceI]

Protocol

Modulation IDEIPSK v

Figure 4-10. Parameters for Digital UHF Modems

¢ Pacific Crest and Internal HiPer (Pacific Crest) modems need a
channel and sensitivity to be chosen (Figure 4-11 on page 4-10).

1. CDPD stands for “Cellular Digital Packet Data”. CDPD is an open
packet data service, defined as an autonomous overlay network,
specified for the cellular TDMA network.
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EBase GEGLEEEY Finish | Cancel
el [T v

Sensitivity Loy v

Figure 4-11. Pacific Crest Radio Parameters

* For FH915 modem (Internal Hiper® Lite), set the operating
channel of the modem (Figure 4-12).

Camrel [T

Figure 4-12. Parameters for the FH915 Modem

¢ For FH915Plus modem (Internal HiPer Lite+ FH915Plus,
Internal GR-3 FH915Plus and RE-S1 radio), in addition to the
operating channel, select the territory (North America, Australia
or New Zealand) to adjust the frequency range and RF power
level for the modem and the operating protocol to communicate
with different types of FH915 modem at the base/rover side.
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FH915 Ext is recommended if all receivers on the jobsite are
equipped with FH915Plus radios only (Figure 4-13),

Finish lCanceI]

Location

Protocol IFHQ 15 Ext v
Channel I 1 v

Sorth America

Figure 4-13. Parameters for FH915+ Modems

* For the Satel modem, set the model, channel and frequency of
connection (Figure 4-14).

EBase LELLNEEY Finish lCanceI]
Model
Channel IB hd
Frequency I469.SDDD MHz

Figure 4-14. Satel Radio Parameters

* For HiPerXT UHF modem, set the protocol, channel, and power
(Figure 4-15 on page 4-12).
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EBase GEGLEEEY Finish | Cancel

Protocol S0L v
Channel ID v
Power 2 v

Figure 4-15. UHF Modem

¢ For AirLink CDMA (Multicast UDP), set IP addresses for data
transmission from the Base Station to more than one Rover
Receiver using CDMA modems (Figure 4-16).

(oo oo v N 2

Address to Add |225.D.055

IP Addresses list

225.0.055

Figure 4-16. Base Multicast Parameters

¢ For the Internal HiPer GSM, Internal HiPerXT GSM, Internal
CR-3(GSM), Internal CR-3Satel(GSM), Motorola V60, Motorola
V710, MultiTech GSM/GPRS, Siemens TC35, Siemens M20,
Wavecom Fastrack GSM or Nextel 158sr Cell Phone modem
types, set the Base PIN (see Figure 4-17 on page 4-13).
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Finish ICanceI]

Base PIN [i111]

Figure 4-17. Base Cell Phone Parameters

4. Set parameters for the Rover Receiver, and tap Next.

Receiver Model |Topcon Generic

Elevation Mask |10 deg

RTK Format |CMR+ -

Antenn |HiPer LitefLiti « | .=

Ant Ht [2.000 m H
I\."ertil:a v

Figure 4-18. Configure RTK Rover Receiver

* Select Receiver Model of the Topcon receiver being used for
survey, either GR-3, GMS-2/GMS-2 Pro, GMS X, NET G3, or
Topcon Generic for any other Topcon receiver.

e Set Elevation Mask not to use data from satellites below this
elevation.

e Select RTK Format of the which needs to coincide with this
set for the Base station.

P/N 7010-0493 4-13



Creating a New Job

* Select the TPS Antenna type from the list and set the height
and its type, either Vertical (measured to the antenna
reference point) or Slant (measured to the antenna edge).

5. Press the Peripherals button if peripherals are used.

* To output NMEA messages, check mark the NMEA Ports box
and select the number of ports for output.

* To input data from peripherals, check mark the Multiple Ports
box and set the number of ports.

* To use a hand held laser measurement system, check mark
the External Laser box and select the device the laser is
connected to. Press the Parameters button to configure the
laser device. For this configuration, see “Laser
Configuration” on page 4-23.

Eperipherals m Cancel

NMEA Ports |1 v
Multiple Ports Iﬁ
External Laser

|Receiver + | | Parameters

Figure 4-19. Rover Receiver Options

6. Select the Receiver Settings option from the Help Icon menu in
the upper left corner of the Rover Receiver screen, to turn
charging mode of the receiver battery off as needed.

7. Ifitis necessary to use Relative antenna model at the base
station that transmits CMR+ data, check mark the Relative
calibrations on Base box from the Help Icon menu. By default,
TopSURYV 7.2 uses Absolute calibration offsets for antennas.
Also, you can select this option when editing the Base.
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8. To use the CSD form of data transmission for receiving RTK
corrections through a cellular phone used as a modem, select
the RTK protocol option from the Help Icon menu in the upper
left corner of the screen (Figure 4-19 on page 4-14).

9. Set the Rover Radio in a manner similar to the Base Radio
setting (see Figure 4-9 on page 4-8) and tap Next.
If Multiple Ports are set for peripherals (see Figure 4-19 on
page 4-14), depending on the number of ports selected, there can
be up to two Rover Radio screens to configure radios for data
input.

@ Use only one radio to receive correction from the
Base.

If NMEA Ports are set (see Figure 4-19 on page 4-14), depending
on the number of output ports selected, there can be up to two
Config: Output Radio screens to configure radios for NMEA data
output.

10. For a mmGPS+ aided RTK survey, on the mmGPS+ Params
screen, select options to use a mmGPS+ system (Figure 4-20 on
page 4-16). For this configuration see “mmGPS+
Configuration” on page 4-25.

include the height of the PZS-1 sensor with a 5/8

, When measuring the height of the rover antenna,
Fas
inch plug.
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EmmGPS+ ZElH Finish | Cancel

Receiver Port: ID v
Sensor Gain IAuto v

Height Difference Limit

ID.SDD m

Figure 4-20. Configuration of mmGPS+ Parameters

11. On the Survey Parms screen, enter Survey parameters and tap
Next (Figure 4-21). These parameters can be changed by

pressing the Settings button from any Survey screen in GPS+
mode.

O o

Solution Type

|Fix Only »
Auto Accept

Murn Meas to svg |3

[ ]Precision {m}

Hz [20150  wvert [0.0300
Auto Topo

Method IEly Hz Dist v
Interval IlS.DD m

Figure 4-21. Survey Parameters (RTK)

* Select the Solution Type filter to be used for data logging (Fix
Only; Fix and Float; Fix, Float, DGPS; or All).

* Set the Auto Accept conditions for a simple Topo survey: number

of measurements to be averaged and acceptable horizontal and
vertical precision.
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* Set Auto Topo survey parameters: method of automatic data
logging and the interval in corresponding units.

12. To define the incremental value for the numbering of survey
points, on the Point Properties screen, select the Point
Increment by number from the drop-down list (Figure 4-22) or
from the Help Icon menu in the upper left corner of the Srv
Parms screen.

Epuint Pmpertil:m::

Point Increment by Iw v

Figure 4-22. Set the Point Properties Option

13. On the Stk Parms screen, enter Stakeout parameters and tap
Next (Figure 4-23 on page 4-18). These parameters can be
changed by pressing the Settings button from any Stakeout
screen in GPS+ mode.

¢ Set the horizontal distance tolerance and the reference direction.
* Select the Solution Type filter to be used for data logging.

* Set the Auto Accept settings for Stakeout which are separate from
the Survey auto-accept settings: number of measurements to be
averaged and acceptable horizontal and vertical precision.
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Hz Dist Tolerance IM| m

Reference Direction

|M0ving Directian v
Solution Type
|Fix Only »

Auto Accept

Murn Meas to svg |3

[ ]Precision {m}
Hz  J00150 | vert J0.0300

Figure 4-23. Stakeout Parameters

14. To display the icon for the staked point on the map, select the
Display option from the menu in the upper left corner of the Stk
Parms screen (Figure 4-23). On the Staked Point Icon screen
(Figure 4-24), set appropriate parameters for the icon.

il ok |cancel

Staked point

Icon ITriangIe Flag v
Calar E

p

Figure 4-24. Staked Point Icon

15. In the next Stk Parms screen, if necessary, set the rule for
generating the point name and Note of the staked point
(Figure 4-25 on page 4-19).

* Set the rule for defining names for the staked points: like a design
point name, or the next point name, or a design point name with a
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pre-defined prefix, or a design point name with a pre-defined
suffix.

The choice of the prefix or suffix appears only when the
corresponding item is chosen from the drop-down menu. Also, a
specified numerical constant can be added to automatically
generate the staked point name.

* Set the rule for setting Notes for staked points. If the Station &
Offset option is selected, an edit box for entering an alphanumeric
prefix appears (Figure 4-25). For the United States, this prefix is
“Sta”, for the international markets the prefix is “Cha”, and for
the Korean/Japanese markets the prefix is “No”. With this option
activated, depending on the choice for the prefix, TopSURV
automatically generates one note for each stakeout point: either
Sta5+5.5R5.0, Cha505.5R5.0, or No.5+5.5R5.0 respectively.

Finish ICanceI]

Store Staked Point As

Paoint IDesign Pt+Constant s
1000

Station & Offset

MNote

Figure 4-25. Storing Staked Points

16. Set advanced parameters for the survey (Figure 4-26 on
page 4-20) and tap Next.

* Multipath Reduction — check and enable this field during the
survey to use when a signal received represents multiple
reflections from nearby objects. Enable this field to use this mode
during the survey.

* Co-Op Tracking — check and enable to allow a higher efficiency
of multipath reduction.
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* Define the Satellite system to be used.

* Set the RTK Position computation mode that determines whether
or not to Extrapolate the Base Station carrier phase
measurements when computing the rover's current RTK position.
If Delay is selected, the RTK engine will compute either a
delayed RTK position (for the epoch to which the newly received
RTCM/CMR message corresponds) or the current stand-alone
position (while waiting for new RTCM/CMR messages coming
from the base).

2 I o [ ol

]

[] €o-Op Tracking

Satellite SystemIGPS+GLONASS v
RTK Position IExtrapuIatiun -

Figure 4-26. Advanced Parameters

17. To set ambiguity resolution parameters for RTK engine, select
the RTK Settings option from the menu in the upper left corner
of the Advanced screen. In the RTK Settings screen, set
appropriate parameters (see Figure 4-27 on page 4-21).

 Select the Ambiguity Level: governs the RTK engine when
determining whether or not to fix ambiguities. Low, Medium
and High correspond to the indicator's 95%, 99.5% and
99.9% states, respectively. The higher the specified
confidence level, the longer the ambiguity search time.

* Set the Resolution Period that defines the differential
correction update interval. Before entering a value, know the
exact rate at which the reference station broadcasts
differential correction data. This interval will only be used if
the receiver is ran in Delay mode. The interval also provides
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more reliable synchronization between the Base station and

Rover receiver

e ok |cance

Ambiguity
Level Im v
Resolution Period
IT sec
Expected Correction
IT sec

Figure 4-27. RTK Settings

18. On the Miscellaneous screen (Figure 4-28), select the
necessary options to customize the user interface during GPS
measurements: display of computed coordinates, prompts for
antenna height and feature codes, and beeps upon storing

points.

EMiscellaneuus Finish lCanl:eI

Prompt for feature codes
v Beep on storing points

Display coordinates after meas.
Prompt for antenna height

Figure 4-28. Miscellaneous

19. Tap Finish to store the settings and to return to the Select
Survey Config screen. The name of the created configuration
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will display in the drop-down menu in the GPS+ Config field.
This configuration can be used on several jobs.

Configurations are stored in a file called
Styles.tsstyles located in the TopSURYV directory.

NMEA Output Configuration

To enable outputting NMEA messages (Figure 4-29 on page 4-23),
take the following steps:

1. Press the Peripherals button on the Rover Receiver screen (see
Figure 4-18 on page 4-13).
2. Check and enable the NMEA Ports box on the Peripherals

screen (Figure 4-19 on page 4-14) and select the number of
ports for output of NMEA messages.

3. Configure all output radios in the Quiput Radio screens
available depending on the number of output ports selected.

4. Select the types of messages to issue via the specified receiver
port at the interval set in seconds (up to 0.1 sec).

* GGA - outputs data on time, position, and positioning.

* GLL - outputs data on the current latitude/longitude and
positioning state.

* GNS - outputs data on time, position, and positioning of
GPS+GLONASS (GNSS).

* GRS - outputs the residual error of distance, is used to
support RAIM.

* GSA - outputs the operation mode of the GNSS receiver, the
satellite used for positioning, and DOP.

* GST - outputs the statistics of position errors.

* GSV - outputs the number of satellites, satellite number,
elevation angle, azimuthal angle, and SNR.

* HDT - outputs the direction (heading).

* RMC - outputs time, date, position, course and speed data
provided by a GNSS navigation receiver.
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* VTG - outputs the traveling direction and velocity.

* ZDA - outputs UTC, day, month, year, and local time zone.

ECDnﬁg: Outpu g5y lCanceI]
NMES Me... | ~
v | G54
v GLL
vINTG

GRS

ZDa

G5T

GMHS

G558

G5Y v
Interval 1.00 Sec

Figure 4-29. Config: Output NMEA

Laser Configuration
To use a hand held laser measurement system, take the following
steps:
1. Press the Peripherals button on the Rover Receiver screen (see
Figure 4-18 on page 4-13).
2. Check and enable the External Laser box on the Peripherals

screen (Figure 4-19 on page 4-14) and select the device (either
Receiver or Controller) the laser is connected to.

3. Press the Parameters button to configure the laser device.

4. In the Config: Laser screen, set the properties for the laser
device: a laser manufacturer, the instrument model and type,
and laser port settings (see Figure 4-30 on page 4-24). Tap OK.
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Manufacturer v
Model Im
Type Im

Laser Port Setting

Port IC e
Parity IN':'"E h
Data IB et
Baud IQEDD v
Stop ﬁ

Figure 4-30. Laser Configuration

Table 4-1 lists the supported manufacturers and models of laser
devices.

Table 4-1. Laser Device Manufacturer and Model

Type of Laser measurement

Manufacturer Model
system
MDL LaserAce 300 Range Finder Only
Range Finder with Encoder
Laser Technology, Inc. Impulse 200 Impulse Only

Impulse with Compass

Laser Technology, Inc. TruPulse 200 TruPulse Only
TruPulse with Encoder

Laser Technology, Inc. TruPulse 360 TruPulse Only
TruPulse with Compass
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mmGPS+ Configuration

An RTK mmGPS+ survey system uses a wireless PZS-1 sensor at the
Rover and the PZL-1 transmitter to obtain accurate (millimeter)
elevations.

1. Check and enable the mmGPS+ box in the Survey screen to
configure the mmGPS+ during the RTK survey configuration.

2. Select the options in the mmGPS+ Parameters screen
(Figure 4-31) and tap Next.

* Select a port from the Receiver port drop-down list used for
communication between receiver and PZS-1 sensor (typically
port D).

* Select Auto from the Sensor Gain drop-down list to
automatically control the mmGPS receiver's detection level of
the transmitter's signal.

¢ Enter the threshold for the difference between GPS and
mmGPS+ height measurements in the Height Difference
Limit field.

EmmGPS+ EUH Finish lCanl:eI
Receiver Port: ID v
Sensor Gain IAuto v

Height Difference Limit

ID.SDD m

Figure 4-31. mmGPS+ Parameters Screen Options
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PP Enabled RTK Survey Configuration

In RTK survey with enabled post processing, the collected Base and
Rover data are written to files for further post processing.

1.

Enable logging the Base and Rover data by selecting the Post
Processing check box in the Survey screen (Figure 4-5 on
page 4-4).

Set the parameters for the Base Receiver (see Figure 4-7 on
page 4-7), and tap Next.

Set the logging parameters for the Base receiver: the file name,
logging rate and the device in which raw data is logged to
(currently only the Receiver is available). Tap the Next button.

EBase PP Setup Cancel

Raw Data Logging

File Name IDefauIt v
Log To v
Logging Rate |5-UU secs

Figure 4-32. Config: Base PP Setup

Configure the Base Radio (see Figure 4-9 on page 4-8) and tap
Next.

Set the parameters for the Rover Receiver (see Figure 4-18 on
page 4-13), and tap Next.

On the Rover PP Setup screen (Figure 4-33 on page 4-27), set
the logging parameters for the Rover receiver: the file name,
logging rate, and the device in which raw data is logged to
(currently only the Receiver is available). Select whether to
start logging manually or automatically as data is being
collected. Tap the Next button.
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ERuver PP Setur iz15]] lCanl:eI

Raw Data Logging

File Name v
Log To IReceiver v
Logging Rate |5-UU secs

Start Log Im

Figure 4-33. Rover PP Setup

7. Configure the Rover Radio, and the mmGPS+ system if used,
then tap Next.

8. On the Init Times screen (see Figure 4-34 on page 4-28), set
the Initialization Times parameters, the times required for
ambiguity resolution in the specific operating environment.
These are used during automatic mode of the survey and
depends upon the number of satellites available and the number
of frequencies being used. For example, the default for six
GPS/GLONASS (6+) dual frequency satellites is ten minutes.
This means that the complete Rover file should be at least this
long. Then tap Next.

9. On the Survey Parameters screen, be sure to set the Auto Topo
Interval multiple to the logging rate in the receiver.

10. Complete the configuration of the PP enabled RTK in a manner
similar to RTK.
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(= I [

Occupation times in minutes:

Mum SWs  Single Freq  Dual Freg
4
5
6+

111

e
-
o

Figure 4-34. Initialization Times

Network RTK Survey Configuration

Network Real Time Kinematic (Network RTK) surveying is similar to
RTK surveying but the correction data for the Rover is derived from
the reference station network solution. Today’s operating reference
station networks are creating either Virtual Reference Station (VRS)
data or network area corrections (FKP parameters). The concept of
Network RTK allows performing RTK positioning in reference
station networks with distances of up to 40 km.

1. After naming the configuration and selecting its type in the
Survey screen, select the desired correction type (Figure 4-6 on
page 4-5) and tap Next.

¢ VRS —to receive RTK corrections from a VRS base station.

FKP — if the base is transmitting FKP corrections.
* Single Base — to receive RTK corrections from a single base.

» External Config — when the receiver uses an External
program to configure RTK corrections.

2. Continue below to finish the configuration for a Network RTK
survey.
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Survey Configuration for VRS and FKP
Methods

1.

On the Rover Recvr screen, select the Receiver Model, set the
Elevation Mask and antenna parameters for the Rover Receiver,
then select one of the following protocols from the Protocol
drop-down list (Figure 4-35). Tap Next.

* NTRIP — (default) Networked Transport of RTCM via
Internet Protocol to receive RTK corrections from a NTRIP
Caster.

» TCP/IP — select to receive RTK corrections through the
Internet.

* CSD Data — select to use the CSD form of data transmission
to receive RTK corrections through a cellular phone used as a
modem.

ERuver Recyr Cancel

Receiver Model |Topcon Generic

Elevation Mask |10 deg

Protocol NTRIP v
Antenn |HiPer LitefLiti « | .=
Ant Ht [2.000 m H

I\."ertil:a v

Figure 4-35. Rover Receiver

2. On the Config: Modem screen (Figure 4-36 on page 4-30)

select Controller if the modem is connected to the controller or
Receiver if the modem is internal or external, but connected
directly to the receiver.
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3.

ECDnﬁg: LGl =0l Finish | Cancel

Modem Connect I ontroller JE9

Figure 4-36. Modem Connect

If connecting to the Controller, use the Dialup Network
Connection for connecting to the Internet to get correction data.
Tapping Next displays the Modem Internet Info screen
(Figure 4-38 on page 4-31).

If connecting to the Receiver, configure the connection
parameters for External Modem Firmware Dialup, External
Modem Software Dialup, Generic, Internal CDMA or Internal
GPRS modem and tap Next.

NTRIP Internet Configuration

First contact the network administrator to gain access to the system.
You will need the IP address and Port to connect to, the user name and
password for NTRIP. Use the following methods to connect to the
network:

1.

If the receiver currently being used has an internal GSM/GPRS/
CDMA modem, use the Internal Modem along with a SIM
Card obtained from a service provider. Note that the receiver
must have the appropriate firmware version.

If an external modem is connected to the receiver, use either
Firmware or Software Dialup, depending on the modem type
supported by the firmware.
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3. If using a cellular phone that is data enabled and connected to
the controller, use Dialup Networking Connection in TopSURV
to connect to the network.

The following setup is an example of a GPRS connection

(Figure 4-37). However, any generic method for connecting to the
Internet can be used. Note that a Network RTK setup requires two-
way communication links (like GSM and GPRS setups).

ERuver Radio Finish lCanl:eI

Radio Modem

Receiver Port Connected to Radio

Port C v
Baud 38400 v
Data g v
Parity Mone v
Stop 1 v

Figure 4-37. Rover Radio

4. Select a base IP address and port from the list and tap Next. IP
addresses/ports can be deleted or added to the list.

ECDnﬁg: Mudem. Finish Canl:el

Internet Info
IP Address:

62.105.138.117/8082

IP Address list:

62.105.138.117/8082

Figure 4-38. Modem Internet Info
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5. Tapping Next displays the Config: NTRIP Login Info screen
(Figure 4-39) only if NTRIP was selected as the protocol to
receive RTK corrections via the Internet.

6. Enter the NTRIP user name and password provided by the VRS
service provider and tap Next.

ECDnﬁg: NTRIP I.“ Cancel

NTRIP Server

Server 62,105,138.117:8052
User ID ==}
Password

Figure 4-39. NTRIP Login Info

7. Use the Config: Modem Dialup Info screen (Figure 4-40) to
input Internet User ID, Password, PIN number, and APN
(Access Point Name). If connected to a HiPer or a GR-3
receiver, select this.

ECDnﬁg: Modem Cancel

Pravider IOther v
Dialup Murm |*gg***1#

User 1D mts

Password mnts

PIN fpooo—
APM nternet.mts.ru

IGR-3 Digital UHF v
Defaults

Figure 4-40. Config: Modem Dialup Info
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8. Clicking the Defaults button will reset all settings to default
values of the selected provider.

9. Select a port for Advance Input Mode from the Virtual Radio
Port field. Only a port currently not in use can be selected as a
Virtual Radio Port.

ECDnﬁg: Modem QLT lCanl:eI

Receiver Info

Wirtual Radio Part

[

Figure 4-41. Modem Receiver Info
10. Continue configuring the Network RTK survey type in a
manner similar to RTK.

11. After completing the survey configuration, and tapping the
Finish button, automatic connection to the NTRIP server is
performed for Internal CDMA and GPRS network connections.
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E Network Conn m
Signal |
Querying Signal Quality
¥/Making PPP connection

Querying Mount Points
Connecting to NTRIP Server

k L | |
Mount INet—l_CMR {Net-1

[PPP: Connected Speed 115200

Jisconnect Connect

Figure 4-42. PPP Connection

After making PPP connection and querying Mount Points
(Figure 4-42), the Radio port starts to connect with the NTRIP server
(Figure 4-43).

E Network Conn m
Signal I

Querying Signal Quality
v |Making PPP connection
v Querying Mount Points
[ Connecting to NTRIP Server

2

TTTTT] p———
I

Mount INet— 1_CMR(Net-1

| Starting Radio Port

Jisconnect Connect

Figure 4-43. Starting Radio Port

A message displays that the modem has been successfully set to
receive correctional data from the NTRIP server.
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I o (o
Signal l—

Querying Signal Quality
+|Making PPP connection
v Querying Mount Points
v Connecting to NTRIP Server

TTTTTTT T 1]

Mount INet- 1_R23_NoGL

| Modem Set Successfully

Disconnect Connect

Figure 4-44. Modem is Set Successfully

An automatic connection is performed in every new job that uses the
given Network RTK style.

12. Tapping the Cancel button aborts the automatic connection. In
this case, you can configure the modem from the Status or Topo
screens.

13. Tap Setup GPS » Status. Select Config Modem from the Help
Icon menu in the upper-left corner of the Status screen to make
a connection (Figure 4-45 on page 4-36).

14. Tapping the red icon [ next to the OK button on the Config

Modem screen will open the Internet Connect screen
(Figure 4-46).
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ECunﬁg Mod @ m Cancel

Type Internal GPRS
Modern Connected to

|R0ver

Port |C v
Base IP |62. 105.138.117/3082

MrtPts | v

l Update "Discunnect" Connect

Figure 4-45. Config Modem

15. The Internet Connect screen displays all of the parameters you
will need for PPP connection. Make sure all values are correct
and tap the Connect button to make the PPP connection.

Elntemet Cunnem Cancel

Pravider IOther v
Dialup Murn I*QQ***l#

Lzer I riits
Password riits
FIN IDDDD

APN Iinternet.mts.ru
IGR-3 Digital UHF v

Figure 4-46. Internet Connect

16. Tapping the OK button returns to the Config Modem screen.
When doing the connection, PPP connection starts to cycle
through the baud rates: first 9600, then19200, and finally it
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should connect at 38400. It can take a few minutes to do so.

Once connected the red icon will turn to green .

17. If the Internet connection is configured as NTRIP, tap:

Modem Connected

IRmrer
Type Internal GPRS
Radio Port IC .

Base Addres I62.105.138.11?{8I v
Mount Pts INET1(NET1;CMR v
Stream Info

| PPP connection is: Connected

[ Update "Discunnect" Connect

Figure 4-47. Config: Modem

» Update — after the PPP connection is established, retrieve
Mount Points from the NTRIP Caster at the specified IP

address and Port; select the correct Mount Point.

* Stream Info — to display information on the selected Mount

Point.

¢ Disconnect — to disconnect from the selected Mount Point.

* Connect — to get correction data from the Mount Point. A

confirmation message will display (see Figure 4-48 on

page 4-38).
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osonconia |

Network connection started.
Ntrip server
'62.105.138.117:8082"
Mount point ‘Net-1_CMR+"
Correction format CMRfCMR+
GGA enabled

Close |

Figure 4-48. Network Connection Started

PP Enabled Network RTK Survey Configuration

In Network RTK survey with enabled post processing, the correction
data at the reference station and the collected Rover data are written
to files for further post processing.

1.

Enable logging Rover data by selecting the Post Processing
checkbox in the Survey screen (Figure 4-5 on page 4-4).

Set the logging parameters for the Rover receiver: the file
name, logging rate and the device in which raw data is logged
to (currently only “Receiver” is available). Select whether to
start logging manually or automatically as data are being
collected (Figure 4-33 on page 4-27). Tap the Next button.

Continue configuring the PP enabled Network RTK in a
manner similar to Network RTK until the Init Times screen.

On the Init Times screen (Figure 4-34 on page 4-28), set the
Initialization Times parameters, the times required for
ambiguity resolution in the specific operating environment.
These are used during automatic mode of the survey and
depend upon the number of satellites available and the number
of frequencies being used. Then tap Next.

Complete configuring the PP enabled Network RTK in a
manner similar to Network RTK.
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Network DGPS

The configuring of the Network DGPS survey type is the same as for
Network RTK. For details on configuring Network survey, see
“Network RTK Survey Configuration” on page 4-28. The difference
is that the Solution type is set to DGPS. The same applies to the PP
enabled Network DGPS configuration. For details on configuring a
PP enabled Network survey, see “PP Enabled Network RTK Survey
Configuration” on page 4-38.

RT DGPS Survey Configuration

Real time differential (DGPS) surveying is used for topographic
survey and stakeout. RT DGPS typically uses the measurements from
two or more remote receivers to calculate the difference between
measurements, providing more accurate position solutions.

One or more Base receivers are placed at known locations and serves
as reference stations. These reference stations collect the range
measurements from each GPS satellite in view and forms the
differences (corrections) between the calculated distances to the
satellites and the measured pseudo-ranges to the satellites. These
corrections are then built up to the industry standard (RTCM or
various proprietary standards) established for transmitting differential
corrections and broadcast to the rover receiver(s) using a data
communication link. The Rover receiver applies the transmitted
DGPS corrections to its range measurements of the same satellites.

A number of differential services exist to transmit differential
correctional data, including maritime radio beacons, geostationary
satellites (as with the OmniSTAR service), and the wide area
augmentation system (WAAS) service.

To enable logging rover data for post-processing in RT DGPS survey,
select and enable the Post Processing box in the Survey screen.

After naming the configuration, selecting a type and correction type,
(see Figure 4-6 on page 4-5), and continue below to finish the
configuration for a RT DGPS Survey configuration.

In user-based mode, the Base and Rover receivers are set in a manner
similar to setting RTK receivers.
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1. Set the parameters for the Rover Receiver: DGPS Format and/
or Elevation Mask and Antenna parameters in the same way as
for RTK survey (see Figure 4-18 on page 4-13), then tap Next.

2. Set appropriate parameters to use differential correction data
from a differential service enabled for the Rover, and tap Next.

» For Radio Beacons, select the country and the name of the
beacon station (Figure 4-49).

courtry  [EEN

Station  |ACUSHNET, Ma v

[]Beacan Carrections from BR1

I << Back ” Next >3 ]

Figure 4-49. Config: Beacon

¢ To use the beacon receiver BR-1 as a source of differential
corrections for the rover, select Beacon Corrections from
BR-1 option on the Config: Beacon screen (Figure 4-50 on
page 4-41).
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ECDnﬁg: ;R Finish | Cancel

Cauntry |USA

Station  |ACUSHHET, M&

Beacon Caorrections from ER1

I << Back ” Next >3 ]

Figure 4-50. Use BR-1

— To get the Beacon signal automatically, check and enable
the Automatic Scan Mode option to search broadcasting
frequencies and output RTCM corrections from the best
signal. Tap Next.

— Set the port for connection to the receiver or the
controller and the baud rate for data transfer. Other
options are not available for this device. Tap Next.

(oo o I EE

Connected to

Zontroller

Port Connected to BR1

Port COomM1
Baud 38400
Data =]

Parity Mone

Stop 1

Defaults

Figure 4-51. Configure BR-1
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— Select a port from the Virtual Radio Port drop-down list,
the receiver port on which the receiver will receive the
RTCM messages from the controller (Figure 4-52). Tap
Next.

[ cono: o o N 2

Receiver Info

Wirtual Radio Part

[

Figure 4-52. Virtual Radio Port

» For SBAS (Satellite-Based Augmentation Systems), select
satellites of a satellite-based augmentation system (WAAS/
EGNOS/MSAS) to improve accuracy of DGPS solutions
(Figure 4-53 on page 4-43):

— Check the boxes near the PRN numbers of the satellites.
All satellites can be selected. The satellite most available
from those selected will be used in Code DGPS solution.

— Enable use of ionospheric corrections from the selected
satellites when computing positions.

None: ionospheric corrections are not used
Apply if avail: use ionospheric corrections if available

Use sat only if avail: use only the satellites for which
ionospheric corrections are available.
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| £ EEEEN Finish || cancel

PRN Name GPS# Type

v/120 AOR-E 2 EGNOS
121
122 AOR-W WAAS
123
124 Artemis EGNOS
125 et
< >
Iono Corr
Use sat only if avail »

Figure 4-53. SBAS Setup

¢ For OmniSTAR-VBS and OmniSTAR-HP (a wide-area,
satellite delivered, differential Virtual Base Station and High
Performance GPS services), select the name of the satellite to
be used (Figure 4-54).

P/N 7010-0493

ECDnﬁg: [o],14Ti8 Finish ICanceI]
Satelite
E&_SAT Lon 25E

I << Back ” Next >3 ]

Figure 4-54. Config: OmniSTAR

4-43



Creating a New Job

e For CDGPS (Canadian nation-wide DGPS service), set the
parameters for the receiver port connected to the CDGPS
radio (Figure 4-55).

S e Finish | cancel |
Radio Modem

Jcoars

Receiver Port Connected to Radio

Port  [CNMEEE—

Baud  [38400 v
Data g v
Parity Mone v
Stop 1 v

Figure 4-55. CDGPS Radio

3. The remaining steps are similar to those for an RTK survey

configuration.

PP Enabled RT DGPS Survey Configuration

In RT DGPS surveys with enabled post processing, the differential
correction data and the collected rover data are written to files for
further post processing.

1.

Enable logging the rover data for post processing in the DGPS
survey by checking the Post Processing box in the Survey
screen (Figure 4-5 on page 4-4).

Configure the Rover Receiver. Then tap Next.

Set the logging parameters for the Rover receiver: the file
name, logging rate, and the device in which raw data is logged
to (currently only “Receiver” is available). Select whether to
start logging manually or automatically as data are being
collected (Figure 4-33 on page 4-27). Tap the Next button.

Set appropriate parameters to use differential correction data
from a differential service enabled for the Rover (for details
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refer to “RT DGPS Survey Configuration” on page 4-39), and
tap Next
5. On the Init Times screen (Figure 4-34 on page 4-28), set the
Initialization Times parameters, the times required for
ambiguity resolution in the specific operating environment.
The parameters are used during automatic mode of the survey and
depend upon the number of satellites available and the number of
frequencies being used. Then tap Next.
6. Complete the configuration of the PP enabled Real Time DGPS
in a manner similar to Real Time DGPS.

PP Kinematic and PP DGPS Survey
Configurations

After naming the configuration, selecting its type and correction type,
continue below to finish the configuration for a PP Kinematic and PP
DGPS Survey configuration.

1. Set the parameters for the Base Receiver: Receiver Model,
Elevation Mask and Base antenna parameters (Figure 4-56),
then tap Next.

EBase Recyr Cancel

Receiver Model |Topcon Generic

Elevation Mask |10 deg
Antenn |HiPer LitefLit +
Ant Ht |0.000 m

ISIant v

lPeripheralsl l <« Back

Figure 4-56. Base Receiver (PP Kinematic or PP DGPS)

2. Set Raw Data Logging parameters: select a file name, device
where raw data is logged, and the logging rate (Figure 4-57 on
page 4-46). Tap Next.
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EBase (22l Finish | Cancel

Raw Data Logging

File Name IDefauIt v
Log To v
Logging Rate |5-UU secs

Figure 4-57. Base PP Setup

% Raw data always records into the receiver memory.

TopSURYV allows the logging to the controller when
in PP DGPS mode of survey only.

3. Set the parameters for the Rover Receiver: Receiver Model,
Elevation Mask, and Rover antenna parameters (Figure 4-58),
then tap Next.

ERuver Recyr Cancel

Receiver Model |Topcon Generic

Elevation Mask |10 deg

Antenn [Map Ant B v | g5

Ant Ht [0.000 m H
I\."ertil:a v

lPeripheralsl l <« Back l

Figure 4-58. Rover Receiver (PP Kinematic or PP DGPS)

4. Set the Raw Data Logging parameters for the Rover Receiver
(Figure 4-59 on page 4-47).

4-46 TopSURYV User’'s Manual



Creating a GPS+ Configuration

Finish ICanceI]

Raw Data Logging

File Name v

Log To IReceiver v
Logging Rate |5-UU secs

Figure 4-59. Rover Receiver (PP Kinematic and PP DGPS)

In PP Kinematic mode, set Initialization times for a given
number of satellites and frequency modes on the Init Times
screen (Figure 4-60), and tap Next. Initialization Times are the
times required to estimate fixed ambiguity positions, which
depend upon the number of satellites available and the number

of frequencies being used.

Occupation times in minutes:

MNum SWs  Single Freq  Dual Freq

Figure 4-60. Initialization Times

6. On the Srv Parms screen, set the Number of Epochs for the

Topo survey (see Figure 4-61 on page 4-48).
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ES[V Parms Finish | Cancel

Topo

Murmber of Epochs |§|

Auto Topo

Method IElv Time v
Interval IS.DD sec

Figure 4-61. Survey Parms (PP Kinematic and PP DGPS)

7. For an Auto Topo survey, select the Method from the drop-
down list and set the Interval multiple to the logging rate in the
Receiver.

8. Complete configuring the PP Kinematic and PP DGPS survey
type in a manner similar to RTK.

9. Tap Finish to store the settings and to return to the Survey
Config screen. The name of the created configuration displays
in the GPS+ Config field drop-down menu.
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PP Static Survey Configuration

After naming the configuration and selecting its type, continue below
to finish the configuration.

1. Set the Receiver Model, Elevation Mask, and the static antenna
parameters (Figure 4-62), then tap Next.

Estatic Recyr Cancel

Receiver Model |Topcon Generic

Elevation Mask |10 deg
Antenn |HiPer LitefLit +
Ant Ht |0.000 m

ISIant v

lPeripheralsl l <« Back l [

Figure 4-62. Static Receiver

2. Set the Raw Data Logging parameters: File Name, device
where raw data is logged to, and logging rate (Figure 4-63).

EBase PP Setup BauTHEy] lCanl:eI

Raw Data Logging

File Name IDefauIt v
Log To v
Logging Rate |5-UU secs

Figure 4-63. Base PP Setup
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3. Set the Occupation Times parameters, the times required for
ambiguity resolution in the common operating environment
(Figure 4-64). These are used during automatic mode of a PP
Static Survey and depend upon the number of satellites
available and the number of frequencies being used.

(B occuo 1e: I EE

Tnitidlization tirme in minutes:

MNum SWs  Single Freq  Dual Freq

Figure 4-64. Occupation Times

4. Set Stakeout Parameters in the Stk Parms screens
(Figure 4-65), then tap Next.

Estk Parms Finish | Cancel "" Stk Parms

Store Staked Point As

Hz Dist Tolerance 1.|:||:||:||Z mm
Reference Direction Point |D95|gn Pt+Constant |54
|Moving Direction v 1000

MNote

Auto Accept

Murn Meas to svg |3

[]Precision {m}
Hz  J00150  vert |0.0300

Figure 4-65. Stakeout Parameters Screens

For details on stakeout parameters, refer to the description on
page 4-17.
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5. Set the advanced parameters for the survey (Figure 4-66) and
tap Next.

» Multipath reduction is used when a signal received represents
multiple reflections from nearby objects. Enable this field to
use this mode during a survey.

* To use the Co-Op Tracking mode, allowing higher efficiency
of multipath reduction, check and enable this field and select
the satellite system to be used.

Finish lCanceI]

[] €o-Op Tracking

Satellite SystemIGPS+GLONASS v

Figure 4-66. Config: Advanced

6. Select needed options in the Miscellaneous screen (see
Figure 4-28 on page 4-21).

7. Tap Finish to store the settings, return to the Survey Config
screen and continue with the configuration setup. The name of
the created configuration displays in the GPS+ Config field
drop-down menu.
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Creating a Total Station
Configuration

When creating a Total Station configuration, use pre-defined
configurations or create new ones. The pre-defined configurations are
listed in the drop-down menus in the corresponding fields in the
Survey Configurations screen (Figure 4-3 on page 4-3). In the TS
Configuration field choose one of the pre-defined configurations or
tap the List [.."] button to create a new configuration or to edit an

existing one. The Configurations screen displays (Figure 4-67)
which contains a list of available TS configurations. Either edit the
existing configuration or create a new one.

"" Configurations m Cancel

Configuration Mame
My Conventional

My Reflectorless

My Robotic

My Level

| Delete || Edt || add |

Figure 4-67. Configurations

Station survey mode is chosen. If Contractor Mode
is selected, the existing Total Station configurations
will be scaled down to a restricted Conventional and
Reflectorless configuration.

@ A Level survey can be configured when a Total

1. To create a new configuration, tap the Add button. To edit an
existing configuration, select it from the list and tap Edit.

2. On the Survey screen, enter a name for the Configuration and
select its type, then tap Next (Figure 4-68 on page 4-53).
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» Use the Robotic type if the survey can be performed by one
person and the instrument is motorized.

* If a reflector is not used, choose the Reflectorless type.

* In all other cases of surveying with Total Station, use the
Conventional type.

» Use the Level type to perform Levelling with digital level.

ESurvey Cancel
Marme IMy Conventional

Type

Figure 4-68. Survey

3. In the Instrument screen, enter the manufacturer and model of
the device, then tap Next (Figure 4-69 on page 4-54). Note that
the models shown in the list correspond to the chosen type of
survey. To simulate a real survey, select Manual Mode. In this
mode, no measurements are performed, all the data is entered
manually.

For the Monitor survey with robotic total stations, select
Monitor from the context menu in the upper-left corner of the
screen to set the format and destination of the output file.
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4. On the Conn Mode screen, select the connection mode (the
Initial TS Connection parameter from the drop-down list) and
tap the Next button (Figure 4-70). Selections depend on the
instrument type. For Conventional and Reflectorless modes,
only Cable; for Robotic, also Radios Only, RC2 with Radios,

Elnstrument Finish | Cancel

Manufacturer ITDpl:l:ln v
Model IGTS Series v

Figure 4-69. Instrument

RC2 Only, and RC2 Only (Bluetooth®).

5. On the Cable screen, select the communication settings for the
cable connection: Baud (baud rate), Parity, Data (number of the

4-54

ECunn Mode Finish | Cancel

Initial TS Connection

[EET——
Optical
|N|:|ne v

Note: The connection mode
can be changed in any of the
measurement screens.

Figure 4-70. Conn Mode
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data bits), and Stop (number of the stop bits) and tap the Next
button (Figure 4-71).

ECable Finish | Cancel

Cable Comm Settings

Baud 200 v
Parity IEven v
Data ﬁ
Stop I 1 v

Default

I << Back " Next >3 ]

Figure 4-71. Cable

The Radio screen displays (for a Robotic survey): select either
Mode (for motorized Conventional or Reflectorless surveys), or
Survey Parameters (for Conventional, Reflectorless, or Level
Surveys).

6. For a Robotic Survey, choose the modem to be used and its
parameters, then tap Next (Figure 4-72 on page 4-56).

* Generic modems use a standard set of parameters: port,
parity, the number of data bits, the baud rate, and the number
of stop bits.

* Pacific Crest modems also need a channel and sensitivity to
be chosen (these parameters are selected by pressing the
Configure Radio button).

* The Satel modem also requires the model, the channel
number, and the frequency of the Radio Modem to be chosen
(these parameters are selected by pressing the Configure
Radio button).
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ERadiu Finish | Cancel
Type ISateI »

Radio Comm Settings

Baud v
Parity INone v
Data h
Stop I 1 v

Configure Radio

I << Back " Next >3 ]

Figure 4-72. TS Radio

7. For the motorized instruments in the Conventional mode of
operation, check and enable the Enable Motor Turning box on
the Mode screen to turn the motor.

Auto Tracking

|N|:| AimingfNo Tracking »

Figure 4-73. Mode

Also, the instrument can be set with auto tracking or auto aiming
tasks from the Auto Tracking drop-down list:

* The Auto Tracking mode causes the total station to track the
reflector while the surveyor moves from point to point.

* The Auto Tracking/Auto Aiming mode causes the instrument
to find the prism in the predefined region.
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* The No Aiming/No Tracking mode disables the total station
operation program.

8. On the Search/Track screen (Figure 4-74), set the search
parameters for a Robotic Survey: the range of search along the
vertical and horizontal axes, pattern, track speed, sensitivity,
delay between the loss of signal and a new search start, turning
speed (measured in revolutions per minute) and the scan range
(the width of the signal), then tap Next.

Finish lCanceI]

Turning Speed 10 ~| rpm

Start Search After |2 | sec

Pattern IPattem 1

Trk Speed |Survey

Sensitivity  |High

v
v
v
Track Light |Off v

Scan Range |wide
Range (dms)
Hz |5 | vert |5 v

Figure 4-74. Search/Track

9. On the Survey Parms screen, set the method for performing
measurements and tap Next (Figure 4-75 on page 4-58).

* For the Angle/Dist - Dir/Rev method, select the sequence for
measuring angles: FS is foresight point (the next occupation
point), BS is backsight point (the previous occupation point),
and Plunge is a rotation of the total station telescope and
body by 180 degrees. These are used for reduction of angular
errors. Also, select the number measurement sets for the
angles.

¢ To enable the reverse distance measurements, check the
corresponding field. These are used for the reduction of the
distance measurement errors.

* The Automatic Repetition of the measurements is available
only in the Robotic mode (for the motorized instrument).
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¢ Insert the allowable tolerances for the measurements and
enable distance averaging (indicates if distance is measured
using one signal or computed as the average of several
signals), if desired.

ESurvey 25741348 Finish | Cancel

Meas Method
Sideshot-Direct o
Angle Seguence
|BS/FS Plunge FS{BS
Num Sets Tolerances
Il— Hz 5.0 sec
Dist. |0.006 m
VA 5.0 sec
Auto Advance Set
Auto Accept Meas
Distance Averaging
|:| Measure Reverse Dist

Figure 4-75. Survey Parms

10. In the next Survey Parms screen, set the following parameters
(Figure 4-76 on page 4-59):

* Meas Type — the order and the type of the measurements in
one set).

e EDM mode — determines the sensitivity of the distance
measurements; coarse or fine.

* Backsight/Foresight PC (Prism Constant) — the parameter of
the prism, characterizing the difference between the
reflection plane and the center of the prism for backsight and
foresight, respectively.

* Point Guide — operates the tracking lights.
* Non-Prism — enables the non-prism mode.

* AutoTopo (only for the Robotic survey) — the parameters of
the automatic survey.

 If necessary, use the List (... | button to edit the prism.
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Finish ICanl:eI
Meas Type IW
EDM Mode IFine 1mm v
Backsight P.C Im
Foresight P.C IWE]

point Guid [Prism |

Auto Topo

Method v
Interval |1.IIIIII sec

Figure 4-76. Survey Parms. Second Screen.

11. If needed, set the point increment value for Survey points. To
do this, select the Point Properties option from the Help Icon
menu in the upper-left corner of the Survey Parameters screen
(see Figure 4-22 on page 4-17).

12. Set the Stakeout Parameters in two Stk Params screens: the
Horizontal distance tolerance, reference direction, the rule for
generating the name and Note of the staked point (if necessary),
and the way the total station is to be turned towards the design
point. Tap Next (Figure 4-77).

= o

e ror:  EEIETD

Store Staked Point As

Hz Dist Tolerance Iﬁ m

Reference Direction Point IDesign Pt Suffix v
|Instrument Reference v _stk
Turn TS to Design Pt Note IW
|HA only »

[ ]search After Turn

—»

Figure 4-77. Stakeout Parms
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The reference point for a Conventional Survey

% . coincides with the total station and for a Robotic
survey, with the point where the controller is
located.

13. To display an icon for the staked point on the map, select the
Display option from the Help Icon menu in the upper-left
corner of the Stakeout Parameters screen. In the Staked Point
Icon screen, select the desired parameters for the icon (see
Figure 4-24 on page 4-18).

14. Select additional customizing parameters in the Miscellaneous
screen (Figure 4-78).

EMiscellaneuus
Prompt for Rod Height S
Prompt for BS Check
Prompt for Feature Codes

¥|Stakeout Sound
Manual Stakeout Update (Rc

v Beep on Storing Points
VA Zero at Level
Use Horizontal Angle Left

v| Automatically display BS Seti

¥/ Hold Offset Measurement

v|BS Is Always Required -
< >

Figure 4-78. Miscellaneous

15. Tap Finish to store the settings, return to the Select Survey
Config screen and continue with the configuration setup. The
name of the created configuration displays in the drop-down
menu in the TS Config field.
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Creating TS Configuration in
Contractor Mode

Contractor Mode is designed for use by non-surveyors for Topo and
Stakeout with total stations. In this mode, a restricted functionality of
the existing Total Station module is available to the user. Follow the
procedure below to begin working with TopSURYV in TS Contractor
Mode (TS CM).

1. Select the Mode icon from the main icon menu and choose
Contractor Mode in Total Station survey mode, then tap OK
(see Figure 4-1 on page 4-1).

Select Instrument Type

(Oars+
Total Station

Bluetooth

Figure 4-79. Select Contractor Mode

2. Inthe TS Configuration field of the Select Survey Config
screen choose one of the pre-defined configurations or tap the
browse button to create a new configuration or edit an existing
one. The Configurations screen displays a list of available TS
configurations. Only two configurations, Conventional and
Reflectorless, are supported in the contractor mode (see
Figure 4-80 on page 4-62).
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Cunﬁguratiuns OK | Cancel

Configuration Name
My Conventional
My Reflectorless

| Delete || Edt || add |

Figure 4-80. Contractor Mode Configurations

3. The remaining steps are similar to those for an usual TS survey
configuration (for details, see the steps beginning on
page 4-53).

In contractor mode, Sideshot-Direct is the only method available for
performing measurements (Figure 4-81).

ESurvey Parms Cancel
Meas Method
ISideshut—Direct v

Tolerances

Hz 5.0 sec
Dist. |0.006 m
VA 5.0 sec

Figure 4-81. Contractor Mode Survey Parameters
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Configuration Setup

Once the survey configuration has been saved, other job settings can

be selected by tapping Next on the Survey Configuration screen. The
Survey Style screen displays (Figure 4-82).

Finish lCanceI]

Select the Configuration for the
Job or create a New
Configuration.

GPS+ Config
Name [ZVA1E v E

TS Config

Name IMy Conventiona + E

I << Back ] I Next >3 ]

Figure 4-82. Select Survey Configuration

Coordinate System

1. On the Coord System screen, set the parameters of the

coordinate system used: the projection, the Datum, and/or
Geoid, then tap Next (Figure 4-83).

ECDD[C' System QEUTHY] lCanl:eI

Projection

[JTHRorth Zone_37 : S6ERS [

[]vse Grid to Ground

Datum [WGS84 vi[ ..

Geoid I{nune> V’

Figure 4-83. Coordinate System
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The NADS83 datum has three independent realizations in TopSURV
with respect to the WGS84 datum: NADS83, NAD83(ITRF96) and
NADS83_NO_TRANS to reflect the updates to these datums.

The original intent was for WGS 84 and NAD 83 to be identical. The
mathematical definition of the ellipsoids (WGS 84 and GRS 80)
differs slightly due to the choice of defining constants and number of
significant figures. The maximum discrepancy between a Cartesian
X.,Y,Z coordinate projected onto both ellipsoids is 0.1 mm at 45
degrees latitude. So, for all intents and purposes the ellipsoids can be
considered to be identical.

Confusion arises when we start to talk about the realization of the
WGS 84 and NAD 83 datums. When NAD 83 was first realized in
1986 it used the same control stations as WGS 84, some of which
were Doppler stations, which were accurate to about one meter. At
this time you could consider the datums to be identical.

Since this time there have been several realizations of WGS 84, the
latest being WGS 84 (G1150), which was performed using data from
IGS tracking stations collected during GPS Week 1150. Recent
studies have shown that WGS 84 (G1150) is essentially identical to
the International Terrestrial Reference Frame of 2000 (ITRF0O0).
Also, during this time there have been no new realization of NAD 83.
What this means is that WGS 84 and NAD 83 can no longer be
considered identical and are in fact different by more than one meter.
This is because the WGS 84 datum has been updated over time using
GPS and the NAD 83 datum has remained constant since 1986.
However, most software manufacturers still consider WGS 84 to be
identical with NAD 83.

To be compatible with other manufacturers, Topcon provides
transformation parameters from WGS 84 to NAD 83 where all the
parameters are zero. This means WGS 84 equals NAD 83. This set of
datum transformation parameters is called NAD 83 No_Trans.

Topcon also provides another set of datum transformation parameters
called NAD 83 which reflects the updates to WGS 84. These
parameters are taken from the National Geodetic Survey.

Topcon only uses the first seven parameters, three translations, three
rotations, and scale.
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1. To manipulate projections/datums/geoids, tap the List [ ]
button (Figure 4-83 on page 4-63) in the corresponding field
(for these operations, see the sections below).

2. If necessary, perform the Grid-to-Ground coordinate
transformation to produce near ground distance values by
checking and enabling the Use Grid to Ground check box (for
this operation, see the section below).

Adding a Projection

From the Coord System screen (Figure 4-83 on page 4-63), select a
projection from the drop-down list in the Projection field or add a
projection by tapping the List [ ... ] button next to the Projection
field.

1. On the Projections screen, highlight the desired projection
from the Predefined list (Figure 4-84).

o o]

[Custom

~

-- Asia

-- Australia and New Zealand
- Canada

. Furnne

hd
Active m

UTMNorth-Zone_37 : 36E to 42E

Figure 4-84. Projections

2. Hit the Down Arrow [g]button to insert the projection into the

Active list of projections (to delete the projection from the list,
use the Cross button).

3. Tap OK to see the added projection in the Projections drop-
down list of the Coord System screen.

4. To manipulate the custom projections, tap the Custom button.
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To create a custom projection , tap the Custom button in the
Projections screen (Figure 4-84 on page 4-65). The Custom
Projections screen displays and contains a list of custom grid
projections. Initially, this list is empty.

ECustum Projections Close

Projection
TM Local

< 4

lDeIete ] [ Edit H Add ]

Figure 4-85. Custom Projections

* Tap the Add button. On the Custom Projection screen, enter
the name for the new custom grid system and select a sample
projection and datum from the lists of available types, enter
the region and any additional information (Figure 4-86). Tap
Next.

ECustum PrDjEC::::

Name M Local

Type |Transverse Mercato

Datum  |[WGS84 v

Region |0hi|:|

Note Ohio TM projection

Figure 4-86. Custom Projection
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* On the next Custom Projection screen, enter the new
projection specifications depending on the selected sample
projection.

The projection types available for selection are as follows:
* Albers Equal Area (orthembadic): conic projection.
* Cassini-Soldner: cylindrical projection.
* Double Stereographic: conformal azimuthal projection.
* Lambert: conformal conic projection.
* Oblique Mercator: conformal cylindrical projection.
* Stereographic: conformal azimuthal projection.
» Transverse Mercator: conformal cylindrical projection.

If the Transverse Mercator projection is selected for example, enter
the following parameters and tap Finish (see Figure 4-87 on
page 4-68):

* Central Meridian — longitude of the central meridian of a zone.
* Scale — scale factor on the central meridian.
* Lat0 — latitude of the origin of the projection.

* FEast0 — false Easting of the origin of the projection.

North0 — false Northing of the origin of the projection.
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ECustum = {n)[=1el Finish | Cancel

Central [82.3000000]
Scale W
Lato [40.0700000
East0 [10000.000 m

Northo Ill]l]l]l].l]l]l] m

Figure 4-87. New Projection Specifications

; The Latitudes are entered as a positive number in
N,

the Northern Hemisphere, and as a negative number
in the Southern Hemisphere. The Longitudes are
positive for Eastern directions and negative for
Western directions relative to the GMT line.

Adding a Custom Datum

1. To add a datum, tap the List =] button from the drop-down

list in the Datum field on the Coord System screen (Figure 4-83
on

page 4-63). The Custom Datums screen displays (Figure 4-88
on page 4-69).
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2. On the Custom Datums screen, which is initially empty, press
the Add button (Figure 4-88).

o ovom: Y
Datum

£ >
lDeIete ] [ Edit H add ]

Figure 4-88. Custom Datums List

3. On the next Custom Datums screen (Figure 4-89), enter the
name of the new custom datum and select the ellipsoid for the
datum from the drop-down list of the Ellipsoid field. Tap Next.

Name  [TECHE]

Ellipsoid |WGS84 &

Note

Figure 4-89. Custom Datum Name

4. On the next Custom Datums screen (Figure 4-90 on

page 4-70), set offsets, rotations, and scale for the new datum.
Tap Finish when done.
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ECustum EY] Finish | Cancel

Offsets{m)

dx Il].l]l]l]l]l]l]

dYy |0.000000
dZz |0.000000

Rotations (secs)

rx ID.DDDDDDDD
Y Il].l]l]l]l]l]l]l]l]
rZ Il].l]l]l]l]l]l]l]l]

Scale IIII.IIIIIIIIIIIIIIIIZI ppm

Figure 4-90. Custom Datum Parameters

Adding a Geoid File

Geoid is a physical reference surface. Its shape reflects the
distribution of mass inside the earth. Geoid undulations are important
for converting GPS-derived ellipsoidal height differences to
orthometric height differences.

Install the geoid file on the controller prior to adding it to the list.
Global geoid files can be opened and truncated in Topcon Link to fit
the file to the job area.

Some geoid files can be installed on the controller during TopSURV
installation. They are provided to the user with the TopSURV
installation program as ‘.gff” files.

To add a geoid file to the drop-down list in the Geoids field of the
Coordinate System screen, tap the List (... | button next to this field.
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1. On the Geoid List screen, which is initially is empty, press the
Add button (Figure 4-91).

Al ok | cancel|

Name Full Path
g2003u0? [\Storage Card\TPS\g

< 4

Remove| | Edit | | add |

Figure 4-91. Geoid List

2. Onthe Add Geoid screen (Figure 4-92), select a Geoid file from
the controller directory to view the boundaries of the geoid
application. Select either Geoid 99/2003, Australian, Canadian
2000, Canadian 95, Geoid File Format, Mexico 97, Sweden,
Denmark, Dutch2004 Files, or Norwegian Files.

T o e

Geoid forma IGeuid 992003

el

Geoid Boundary

T~ Lat |42°uu'u.u'N
L |95°59'59.9'w

4 Lat |24°IZIIZI'IZI.IZI'N
Lon |77°uu'u.u'w

Figure 4-92. Geoid Parameters

3. Press OK to return to the Geoid List screen (Figure 4-91 on
page 4-71) with the geoid file added. This list corresponds to
the Geoids drop-down list in the Coord System screen.
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Grid to/from Ground Transformation

If necessary, perform the Grid to Ground coordinate transformation.
A ground projection is a grid mapping projection rescaled to convert
point coordinates to another reference surface (up to the average
project elevation) to produce near ground distance values. The ground
system can be rotated and shifted relative to the grid system. The
ground coordinates can be converted back to the grid projection.

1. Check and enable the Use Grid to Ground box on the
Coordinate System screen.

TopSURY has three modes to set up grid-to-ground parameters.
Select either Scale Factor, Average Job Height, or Origin Point
from the Parameters field (see Figure 4-93).

¢ In Scale Factor mode, set the Combined Scale Factor for
Grid-to-Ground or Ground-to-Grid coordinate
transformation and the angle that defines the reference
direction for ground azimuths. Also, enter offsets values of
the grid origin along the North and East axes to reduce
ground coordinates to manageable values

"" Grid toffrom [l ok [cancel|

Parameters SCale Factor
Direction IGrid to Ground v
Cormbined SF Il.DDDDDDDDDD

Az Rotation 2.00000  dms

Offsets (m)

Marth IlDDD.DDD
East IlDDD.DDD

Figure 4-93. Grid to/from Ground - Scale Factor

* In Average Job Height mode (Figure 4-94 on page 4-73), do
the following:

— The Average Height of the job points for Grid-to-Ground
coordinate transformation to compute the elevation scale
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factor. An elevation factor is determined by using a
constant value for the mean radius of the earth. An

approximation of the earth’s radius used in TopSURYV is
6,371,000 meters.

— The Map Scale that defines how many grid distance units
correspond to one distance unit on the ellipsoid.

— The angle between the axes of the grid and the ground
coordinate systems. This angle defines the reference
direction for ground.

— Offset values of the origin along the North and East axes
to reduce ground coordinates to manageable values.

o ool

EETE =R 4 vg Job HE

Ayg Job Ht IlSD.DDD m
Map Scale Il.DDDDDDDD

Az Rotation 2.00000  dms

Offsets (m)

Marth IlDDD.DDD
East IlDDD.DDD

Figure 4-94. Grid to Ground - Average Job Height

* In Origin Point mode, set a desired grid point from the job as
the origin of the ground coordinates for the Grid to Ground
coordinate transformation (Figure 4-95 on page 4-74). Also
set Azimuth Rotation, the angle between the axes of the grid
and the ground coordinate systems. This angle defines the
reference direction for ground. To compute the Azimuth
Rotation value, use the List [ button.

The scale factor for this mode is a calculated value. The value
(not equal to "1") depends on the height of the origin point.
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EGrid to Gmunc:m:
v

Parameters Crigin Pt

Direction Grid to Ground

Combined SF ID.Q?QE@S? 149

azRotation  [355.000 dms [ ...
Orig Pt |102
Ground Pt {m)

Marth IlDDD.DDD
East IlDDD.DDD

Figure 4-95. Grid to Ground - Origin Point

In the setup of a TS configuration in the Contractor
mode, the Coord System screen will not appear as
only ground coordinates are used in this mode.

Units

Set the distance and angle units of the job on the Units screen and tap
Next (Figure 4-96). For the Total Station mode (except when in the
Contractor Mode), also select the temperature and pressure units.

B

Distance

Angle

|oms v
Temperature

|Celsius () »
Pressure

|mmHg v

I << Back " Next >3 ]

Figure 4-96. Set Distance and Angle Units
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¢ Select either Meters, IFeet (International Feet, 1 Ifoot = 0.3048
Meters), US Feet (1 USFt = 1200/3937 Meters); [Feet and Inches,
or US Feet and Inches (the latter two are calculated taking into
account that 1 Foot = 12 Inches).

be entered as meters, or international feet by

, If the selected units are US Feet, linear values can
N,
% appending “m” or “if” to the entered value.

If the selected units are in meters, then a linear
value in US Feet or International Feet is entered by
appending “f”or “if” to the end of the entered value.

If the selected units are in International Feet, enter
linear values in meters or USfeet by appending
“m”or “f” to the entered value. The appended
characters “m”, “f”, or “if”” are not case insensitive.
You can also enter “M”, “F”, or “IF”.

If the selected units are US or International Feet and
Inches, you can enter feet and inches in the
following formats:

- feet.inches.fracNumerator.fracDenominator
(displays as the next format)

- feet’inches” fracNumerator/fracDenominator

(where the fracDenominator can be either 2, 4, 8, or
16)

* Select either DMS (degrees, minutes, seconds), Grads (Gons),
Radians (for Cogo use only), or Mils (for Cogo use only). (360
degrees = 400 grads = 2= radians = 6400 mils.)

T3 ENTR L]

separated by “-”, “)” or *;”. Certain angles can be
entered as three points separated by “-”, “)” or *;”.
For instance, a value of 100-101 indicates the

Azimuth or Distance from Point 100 to Point 101.

; Azimuth and distances can be entered as two points
~,

* For raw measurements in TS mode only, select either Celsius (C),
or Fahrenheit (F) units of temperature.
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* For raw measurements in T'S mode only, select either mmHg, hPa,
inHg, or bbar units of atmosphere pressure.

Display

On the Display screen (Figure 4-97), select the Display parameters:
the type of Coordinates displayed, the plane coordinates order, the
reference direction for Azimuth and representation type and the
method for displaying position on the CenterLine (Station or
Chainage). If the Station is selected as representation type to display
position on the CL, set the Full Station value. Then tap Next.

o EOER

Coord Type
v
Coord Order
|N0rthing,Easting,EIevatiDn »

Azimuth Crigin INorth v
Disp Dir &5 [ezmoth ]
Disp CLPos A5 [Station v
Full Station [iooomo

I << Back " Next >3 ]

Figure 4-97. Display

In the setup of a TS configuration in Contractor
@ mode, the Coord Type field is absent because no
coordinate system is set in this mode.

4-78 TopSURYV User’s Manual



Configuration Setup

Alarms

On the Alarms screen, check and enable the Audible Alarm field to
enable a sound for alarms in the Controller, Receiver, or Total Station.
Place the check marks, where necessary (Figure 4-98).

e EIEE

[ ] Audible Alarm
Instrument Controller  GPS+ TS
Pawer Alarm vV ¥ ¥
Memary Alarm v v
Radiio Link [v
Fix-Float/ Track v [

Figure 4-98. Alarms

In the setup of a TS configuration in the Contractor
mode the Alarms screen is not displayed.

Tap Finish to save the settings for the newly created job.
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Global Settings

Set general settings in TopSURYV if needed to use with the currently
selected job. Tap the Config » Global icons.

_I r Eﬁlubal Ll OK | Cancel

Use Bold Font
Configure [ ]Enable Job History

Data Entry ICudes »
Code File I

Code with Descriptio

[] Allow Custom Control Code:
Allow Persistent Control Codes

Control Code Delimiter ISpace v

Figure 4-99. Global Settings
1. Check and enable the Use Bold Font box to use the bold font on
the controller display to see more clearly.
2. Check and enable the Enable Job History box to save every
surveyor’s operation on the job in a history file.
3. Select either Codes or Notes as the type of data being entered in
the field during survey along with the name of the point.

4. If needed, set a Global Data Dictionary file to use the file’s
codes and layers with the currently selected job. Use the
Browse button to select the necessary file.

When using a Global Data Dictionary file, the codes

@ immediately become available for selection from
the Code drop-down list. The layers from the
Global Data Dictionary file display in the Layer list
of the current job only as points are saved with the
file’s codes.

5. Check and enable the Code with Description box to use
descriptions, along with code names, to select during survey.
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6. Check and enable the Allow Custom Control Code box to be
able to enter any string to mark it as a control code; TopSURV
will not interpret these control codes.

7. Check and enable the Allow Persistent Control Code box to
make the control codes persistent between recorded points and
not cleared when surveying. The box becomes available for
selection only if the Allow Custom Control Code option is
turned on.

8. Check and enable the Control Code Delimiter from the drop-
down list to enter control codes, along with codes in a single
field when surveying in Line or Area mode.

Customizing Menus

1. Some rarely used functions are not displayed, but can be
enabled. To do this, tap the Configure » Menus icons. The
Config Menus screen displays.

iT >

g2

Configure Menus

Sub Menu to Display ~
| Global

¥/ To Job

¥| To Controller

¥ From Job

| From Contraller b’
< >

[Juse kans

Figure 4-100. Config Menus

2. On the Config Menus screen (Figure 4-100), select the desired
menu from the Menu list and choose the necessary options
from the Sub Menu to Display list.
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Setting Background Images

To position a geographic image under observed data on the map, use

the

1.
2.

Background Images function.

To load an image, tap Edit Job » Images.

On the Background Images screen (Figure 4-101) select the
image. It is possible to select multiple background images.
Using multiple background images is limited by the amount of
free space in the controller memory.

Tap Add to add the appropriate file to the list.

| EBgmund Image:m: Cancel
\ﬂ,_ For... |Filename |Units |

Edit Job Inages v|G... TESTGED... m

[+

[ Prop ] [Delete | Ada |

Figure 4-101. Select Background Images

To be imported into TopSURV correctly, any images need to be
geo-referenced. GeoTIFF images have their own geo-referenced
data while other images need a separate World file that references
the geographic location of the image. The World file must have
the filename extension associated with the image format (TFW,
JGW or BPW) and should be located in the same directory as the
image file.
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To map a Background Image correctly, the image
@ (it’s geo-reference point) should be in the job’s

current coordinate system or at least in a very
similar one (e.g., in a corresponding UTM zone).

If the selected image uses a World File, tap Properties to select
the projection in which the coordinates in the World File are
given.

4. To use a file once it is added, make sure the file is checked in
the list. Tap OK. Tap OK to open the selected file. If no world
file exists for the background image file selected, a warning
displays, and the Background Images screen will appear again
to select another file.
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Notes:
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Chapter 5

Importing and
Exporting Data

TopSURYV can import/export data from/to jobs, devices and different
formats. TopSURYV supports all major file formats.

Importing Data

TopSURYV can import points, codes and attributes, Code Libraries,
Roads, Cross Section Templates, Point Lists and Localization data
from another job, from a file, or from another controller device.

Import from Job

1. Tap Import » From Job. The Select Job screen (Figure 5-1 on
page 5-2) displays and highlights the name of the job file in the
Job List; or tap Browse to select the Job file from the disk, then
tap Select.
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2.

9-2

Current Job: 06-224

ESelect Job Close

Created:  10f15f2007 23:35
Modified:  10f24f2007 00:19
\...\TPS\TopSURV1obs

Figure 5-1. Select Job

Paints
Jall Paints v

[]code Library
[ Localization

[ ]Horizantal aligments

[ wertical Aligments
[ ]¥-5ection Sets

[JRoads

Figure 5-2. Import from Job

In the From <Job> screen (Figure 5-2) select whether points
are to be imported, and if necessary, filter the imported points
either by type, by range and code, or by type, range, and code.
Place appropriate check marks if the following parameters
should be imported along with points: Code Library,
Localization, Point Lists, Horizontal Alignments, Vertical
Alignments, X-Section Sets, or Roads. Tap the Next button..

Eme 06-224 . Cancel
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3. If By Type or By Type, Range and Code is selected in the Points
drop-down menu of the From <Job> screen (Figure 5-2 on
page 5-2), select the types of points to be imported on the
Select Point Type(s) to Import screen.

Ept ISR Finish lCanl:eI

Point Types -~
Design Points
| Contral Points
Cogo Paints
Ease Station
Topo Paints
Offset Topo Points
Auta Topo Points v
< >

Check Uncheck

Next ==

Figure 5-3. Select Point Type(s) to Import

4. If available, tap the Next button to open the next screen to
select objects. Once the button becomes grayed out, tap Finish
to start the export process.

5. If By Range and Code is selected in the Points drop-down list of
the From <Job> screen (Figure 5-2 on page 5-2), on the Points
to Import screen, select the codes and/or the range of points to
be imported (Figure 5-4 on page 5-4).

To select codes, tap the Select button, check the codes
associated with the points to be imported in the Code screen,
and tap the OK button. The Range of Points sets a range of
point names that should be imported. The symbols *;, ¢ or ¢}’

can be used to differentiate individual point names, whereas the
symbol ‘-’ is to be used for specifying a range.
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5-4

Epuints @]l Finish | Cancel

Filter by Codes

F
Filter by Range
5-58

Marne Separator I, v

Usg -' for Range Separator

Figure 5-4. Points to Import

If available, tap the Next button to open the next screen to
select objects. Once the button becomes grayed out, tap Finish
to start the export process.

If All or None is selected in the Points drop-down list of the
From <Job> screen, based on the other selections in this
screen, tapping the Next button on subsequent pages will result
in appropriate screens being displayed.

On the Pt List to Imp screen (Figure 5-5) select the point lists to

import.

Ept List to Imp Cancel

Pairt Lists |
v PointListl

Check

Uncheck

Figure 5-5. Select Point List(s) to Import
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9. Tap Next if other data is chosen to import into the From <Job>
screen. The next screen opens to select other objects (horizontal
alignments, vertical alignments, roads or x-section sets) which
are similar to the Pt List to Im screen (Figure 5-5 on page 5-4).

10. In the final screen for importing from a job, the Next button
will be disabled. Tap Finish to start the Import process.

11. When names of these imported objects coincide with existing
ones in the current job, the Duplicate Objects screen

(Figure 5-6) issues a warning that prevents the loss of points,
roads, or point lists.

EDuplicate Codes . Close
Warning:  Code already exists!
MName: BOCO
dm: MfA
dE: MfA
dH: NfA
Crerwrite?
o R
Start Mam
() Prefixe () suffixe
’ Yes ] ’ Yes To All ]
[ skip | [ skipal |

Figure 5-6. Duplicate <Objects>

Select either to overwrite, or to rename, or to save with prefix/suffix.
Then press Yes to accept the decision for one or for all similar cases.
Pressing Skip leaves such objects not imported.

@ The import process cannot skip duplicate templates.
These objects must be renamed.
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Import from Device

1.

Tap Import » From Device to import a job (or any other file)
from one controller to another.

On the Settings screen, select the means of communication,
then tap Next (Figure 5-7).

ESettings Cancel

Com Part

Figure 5-7. Import/Export Settings
Choose the location for the imported file, then tap OK. The
Select directory screen displays (Figure 5-8 on page 5-7).

If Bluetooth is chosen to perform the connection between the
controllers, highlight the appropriate Bluetooth Device and tap
Select.

Prepare the other controller device for the export process as
described in the “Export to Device” on page 5-18.

Tap OK on the File Import Directory screen (Figure 5-8 on
page 5-7).
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\...\TPS\TopSURV\IEFiles}

[#] 1.hal

[#RS.fc4
[y dxf

Figure 5-8. File Import Directory

Import from File
1.

Importing Data

Tap Import » From File. On the From File screen select the

type of data to be imported, the type of file to be imported from
(Figure 5-9). Then tap Next.

o

Fram File

Data
®-Section Sets

Farmat

Eme File Cancel

S55 Cross Section Set (*.rd)

Figure 5-9. From File

2. Using the standard Windows® CE interface, browse for the file

to import from or type the name of the file, and tap OK.
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Points from Text File Formats

1. If data type is Points or Point Lists, select the point type to

import from the Data drop-down list (Figure 5-10). If the Text
file type is chosen, check the ASCII File Properties field

buttons, if necessary. These conditions use the same type
attributes and quotes for the text values.

Eme File Cancel
Data

|P0ints v
Farmat

Topcon Text custam [

Point Type

|Design Points

ASCII File Properties
LUse Type for Attributes
Use Quotes for Text Yalues

Figure 5-10. From Text File

2. Specify the format in which data is stored in the file
(Figure 5-11).

EText [ZIW 1R Finish | Cancel

Delimiter

(Jspace (@)¥omma
() Tabs () Other I |

[]Header in First Row
File Style

|Name,N(Lat),E(LDn),EIev,CDdes »

[ Delete | [ Edit... | [ Add... |

Figure 5-11. Text File Format
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Importing Data

¢ Choose the delimiter between different fields.

e If a header is provided in the first row of the file, check the
appropriate field.

¢ Select the File Format (the order of the fields), using the
drop-down menu. Or create a new file format using the
procedure below.

Tap Next to select the coordinate system of the data in the
imported file.

Tap Finish to start the import process.

To customize the format, enter the order of data using the Custom
Style screen (Figure 5-12).

1.
2.

Tap Add Format on the Text File Format screen.

Select parameters from the Available list and tap the right arrow
button to move them to the Order list.

To arrange the options in sequence, use the up and down arrow
buttons. The order of items in the Order list should correspond
to that in the selected file.

Tap Save (Figure 5-12). The combination will display in the
Select File Format drop-down list on the Text File Format
screen.

ECustum Style Close

Lyailable |
Ell kit

MNotes

Codes&Strings
Codesgattributes

FullCodes

[=i[s]
Crder |
s [#]
E(Lon)
El
Cst\;es E'

Save

Figure 5-12. Custom Style
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Points from AutoCAD DXF and AutoCAD
Drawing Files

1. If the AutoCAD DXF or AutoCAD Drawing format is selected,

select the Point Type on the From File screen (Figure 5-13).

Eme File Cancel
Data
|P0ints

v
Farmat

|Aut0CAD Drawing (*.cwg)
Point Type
|Design Points

v

v

Figure 5-13. From AutoCAD DXF

TopSURYV only imports AutoCAD 2000 format
@ DWG files. TopSURYV imports layers from DWG/

DXEF files, along with the appropriate data types.

2. Tap the Settings button. On the Settings screen, select the

following drawing styles to represent points and lines
(Figure 5-14).

ESettings m Cancel

|:| Load as background image

Figure 5-14. Settings
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Importing Data

* Check and enable the Import block base points box to import
central points in blocks as points (Figure 5-14 on page 5-10).

* Check and enable the Load as background image box to load
data as background (Figure 5-14 on page 5-10).

Points from TDS Coordinates Format

The TDS Coordinate format demands points have only numerical
names. The screen displays a number at which TopSURV will start
renaming points with alphanumeric names (Figure 5-15).

Eme File Cancel

Data
|P0ints v

Farmat

TDS Coordinates (*.cr5)

Point Type
Design Points v

Alphanumeric Points will be l—
Renumbered Starting at: 1

Figure 5-15. From TDS Coordinates

Tap Next to follow next screens with the help of the export wizard.

Importing Lines

TopSURYV linework consists of lines and points, whereas imported
linework contains no points; it includes positions only (names start
with a question mark). Figure 5-16 on page 5-12 illustrates the
contents of the imported linework.
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Linework Mame

[#][ st of Poin ~ ¥y
7 #00000
7 #00000
7 #00000
7 #00000
7 #00000
7 #00000
? #00000

m < 4 —=20m E

[ Point Info Sel pts |- |

Figure 5-16. Edit Imported Linework

Importing Multiple Data Types

1. On the Data selection screen, select specific data type from the
appropriate file (Figure 5-17).

EData selection Cancel

File contents

[ Paint Lists i
Lines b
Aligrmerts I
Lodes oo
[]surfaces i
¥-Sections FR
Parcels b

Figure 5-17. Import From LandXML

2. Select an object to import and tap Next to start the import
process.

2000 format. TopSURYV imports layers to DWG/

@ TopSURYV can import DWG files only in AutoCAD
DXEF files, along with the appropriate data types.
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Exporting Data

Importing Roads
In TopSURYV or TDS Road format, select a desired distance units.

Eme File Cancel

Data
|R0ads v

Farmat

W Road (*.thl; *. bl *trd) IR

Dist Units

IMeters v

Figure 5-18. Roads from TopSURV Road

The header of the TopSURV Road format contains the starting
azimuth if the Road is not a straight line.

For details on the formats of the files from which
@ TopSURYV can import data, refer to the TopSURV
Reference Manual.

Exporting Data

TopSURY can export points, codes and attributes, Code Libraries,
Roads, Cross Section Templates, Point Lists, Localization, Road
Survey, and Raw Data to another job, to a file, and to another
controller device. Sessions can be exported to receivers (in GPS+
mode).
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Export to Job

1. Select the Export » To Job icons. On the Select Job screen,
highlight the destination job to export to and tap Select. If there
is no job in the Job List that you want, press the Browse button

to select a job from the disk (Figure 5-19).

Expar

ESelect Job

Current Job: 06-224

Close

Created:  10f15f2007 23:35
Modified:  10f24f2007 00:19
\...\TPS\TopSURV1obs

Figure 5-19. Select Job

2. Inthe To <Job> screen select whether points are to be exported,
and if necessary, filter the exported points either by type, by
range and code, or by type, range, and code (Figure 5-20 on
page 5-15). Also, place appropriate check marks, if the
following data should be exported along with points: Code
Library, Localization, Point Lists, Horizontal Alignment,

Vertical Alignment, X-Section Sets or Roads.

3. Tap the Next button.

9-14
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Finish [Cancel]

Paints
Jall Paints v

Cade Library
Localization

Point Lists
Horizontal Aligrments
wertical Aligrents

Roads

Figure 5-20. Export to Job

4. If By Type or By Type, Range and Code was selected in the
Points drop-down list, on the Point Type(s) to Export screen,
select the types of points to be exported (Figure 5-21).

[ e 7o oo N B2

Point Types -~
Design Points
| Contral Points
Cogo Paints
Ease Station
Topo Paints
Offset Topo Points
Auta Topo Points v
< >

Check Uncheck

Next ==

Figure 5-21. Select Point Type(s) to Export

5. 1If By Range and Code was selected in the Points drop-down
menu, on the Points to Export screen, select the codes and/or
the range of points to be exported (Figure 5-22 on page 5-16).
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5-16

Epuints to Export Cancel
Filter by Codes

F2,F0,F3,FO

Filter by Range
100-105

Marne Separator I, v

Usg '-' for Range Separator

Figure 5-22. Points to Export

To select codes, tap the Select button. Check mark the codes
associated with the points to be exported in the Code screen,
and tap the OK button. The Range of Points sets a range of
point names that should be exported. The symbols ,’, < or *;’

can be used to differentiate individual point names, whereas the
symbol ‘-’ is to be used for specifying a range.

o

Select Codes -~

PLAT

SUMTER41

SUMTER4Z

IRFEE19

TD
v F2
v FO
v F3
v FO

WPP v
< >

| uncheck || check || select |

Figure 5-23. Select Code
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7. If All or None is selected in the Points drop-down list of the
To<Job> screen, based on the other selections in this screen,
tapping the Next button on the subsequent pages will result in
appropriate screens being displayed.

8. In the Point List(s) to Export screen select the point lists to
export (Figure 5-24).

Finish lCanceI]

Pairt Lists |
PointListl
v|PointList2

Check Uncheck

Next ==

Figure 5-24. Select Point List(s) to Export

9. Tap Next (if available) to choose other data to export
(horizontal alignments, vertical alignments, roads or x-section
sets) that is similar to the point lists selection. Once the button
becomes grayed out, tap the Finish button to start the export
process.

10. When names of these exported objects coincide with existing
ones in the job, the Duplicate Objects screen issues a warning
that prevents the loss of points, roads, or point lists (Figure 5-25
on page 5-18).

11. Select either to overwrite, or to rename, or to save with prefix/
suffix. Then press Yes to accept the decision for one or for all
similar cases. Pressing Skip leave such objects not exported.
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EDuplicate Codes Close

Warning:  Code already exists!

Mame: TD
dh: MfA
dE: MfA
dH: A

o E
Start Mam
() Prefixe () suffixe
| |
’ Yes ] ’ Yes To All ]
| skip | [ skipal |

Figure 5-25. Duplicate <Objects>

Export to Device

1. Tap Export » To Device.

2. On the (Import/Export) Settings screen (Figure 5-26), select
the means of connection using the Com Port drop-down list,
then tap Next. The Select file screen displays (Figure 5-26).

ESettings Cancel
Com Port

Figure 5-26. Import/Export Settings

3. 1If Bluetooth is selected to perform the connection between the
controllers, choose the desired Bluetooth Device and tap Select.
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4. Choose the files to be exported.

o ool

Type: |Text Files {*.txt) -
\...\TPS\TopSURV\IEFiles}

omm.log. txt

MNarme ||:|:|mm.||:|g.txt

Figure 5-27. Select File to Export

Prepare the other controller device for the import process as
described above in the Import section.

Tap the OK button to start the export process of the selected file
and to return to the main screen if it is successful.

Export to File

1.

Tap Export » To File.

In the To File screen, select the type of data to be exported and
the type of file to export to (see Figure 5-28 on page 5-20). Tap
the Next button.

TopSURYV can export DWG files only in AutoCAD
2000 format.

For Points and Point Lists data types, if desired, check mark the
appropriate fields to choose the data being exported:

— Check and enable the Select Types of the Points box if not all
types of points should be exported. In this case the Point
Types to Export screen first displays.

— Check and enable the Use Filters box if filters (by code and
by range) should be used for exported points.
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ETD File Cancel
Data

To File |P0ints v
Farmat

Topcon FC-4 (*.fcd)

[]select Types Of The Points
[Juse Fiters

Figure 5-28. Export to File

3. On the To < name of Format> screen, set the destination file
using the Windows CE interface, and tap OK.

Points to Text File Formats

1. If data type is Points or Point Lists, select the point type to
export.

2. [If the Text file type is chosen, check and enable the ASCII File
Properties field boxes, if necessary (Figure 5-29). These

conditions use the same type for the attributes and quotes for
the text values.

Data

v
Format

ITopcon Text Custom (*.tut) v

[ ] select Types Of The Points
[ Juse Fiters

ASCII File Properties
Use Type for Attributes
Use Quotes for Text Values

Figure 5-29. To File
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3. Tapping the Next button opens the Point Type(s) to Export
(page 5-15) and the Point To Export (page 5-15) screens if the
respective fields have been checked.

4. When all data export conditions have been specified, a screen to
choose the file opens (Figure 5-30). Using the Windows CE

interface, browse for the file to export to or type the name of the
file, and tap OK.

(= e

Type: |Text Files {*.txt) -
\...\TPS\TopSURV\IEFiles}

EEEE

=] corm.log. txt

MNarme IE

Figure 5-30. Select the File

5. For Text file formats (the Text File Format screen,
Figure 5-31), specify data format parameters in the file:

Finish lCanceI]

Delimiter

() Space i
() Tabs () Other I |

[ Header in First Row
File Style

|Name,N(Lat),E(LDn),EIev,CDdes »

| pelete | | Edit... || Add... |

Figure 5-31. Text File Format
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7.

* Select the delimiting symbol (Delimiter) between the data in
the exported file; select either Space, Comma, Tabs, or Other
from the list.

* Check and enable the Header in First Row box, if a header is
provided in the first row of the file, check the appropriate
field.

* Select the File Style (the order of the fields), using the drop-
down list below, or create a new file format using the
procedure below.

Tap Next to select the coordinate system of the data in the
imported file.

Tap Finish to start the export process.

To customize the file format, enter the order of data using the
Custom Style screen (Figure 5-32 on page 5-23).

1.

Tap Add (Edit) Format on the Text File Format screen
(Figure 5-31 on page 5-21).

Select items from the Available list and tap the right arrow
button to move them to the Order list (Figure 5-32 on page 5-
23).

To arrange the options in sequence, use the up and down arrow
buttons. The order of items in the Order list should correspond
to that in the selected file.

Tap Save. The combination will display in the Select File
Format drop-down list on the Text File Format screen
(Figure 5-31 on page 5-21).
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oo

Lyailable |
Elev

MNotes

Codes&Strings
Codesgattributes

FullCodes

[s][=]
Crder
MiLat) m

E(Lon)
Ell ht
Codes E'

Figure 5-32. Custom Style
Points to AutoCAD DXF and AutoCAD Drawing

1. When exporting points to the AutoCAD DXF or AutoCAD
Drawing format, you can select an option not to export code
attributes on the To File screen (Figure 5-33).

ETD File Cancel
Data
|P0ints v

Farmat
fLutaCAD DXF (%, dxf)

[]select Types Of The Points
[Juse Fiters
|:| Do not export code attributes

Code Style...";ettings...l l Next >> l

Figure 5-33. AutoCAD DXF

2. Tap the Code Style button on the To File screen (Figure 5-33)
to set a format for point properties (codes, control codes,
strings, and notes) to export to the file. The Settings screen
displays (Figure 5-34 on page 5-24).
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3. Select point/line styles and check and enable the Use 3D

coordinates box to use 3D coordinates, then tap the Settings
button (Figure 5-34).

ESettings m Cancel
Point style:

TopSURY Point Blocks

Line style:

| TonSURY Line Blocks

Use 30 coordinates

Figure 5-34. Settings

Exporting Points to an ESRI Shape Format

When exporting points to the ESRI Shape format, check and enable
the Store Description as Attribute box on the To File screen
(Figure 5-35) to save point descriptions as attributes in the file.

ETD File Cancel
Data
|P0ints v

Farmat

=SRI Shape (.2

[]select Types Of The Points
[Juse Fiters

Do not export code attributes
|:| Store Description as Attribute

For each feature code, three shape
files will be generated within the

selected directory.

Figure 5-35. ESRI Shape
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Points to TDS Coordinates

When selected, the TDS Coordinate format demands points have only
numerical names. The In File screen (Figure 5-36) displays a number
at which TopSURYV will start renaming points with alphanumeric
names.

ETD File Cancel

Data

|P0ints v

[]select Types Of The Points
[Juse Fiters

Alphanumeric Points will be l—
5005

Renumbered Starting at:

Figure 5-36. To TDS Coordinates

Exporting Raw Data

TopSURYV supports export raw data to the formats:

LandXML (*.xml), Topcon FC-5 (*fc5), Topcon GTS-6 (*.gts6),
Topcon FC-6/GTS-7 (*.gts7), TDS Raw Data (*.RAW), MOSS Survey
(*.txt), Field Book (*fbk), KOF (*kof), Topcon Vector Format (*.tvf),
TVF with Code Style (*.tvf), Berlin GNSS-Messprotocoll (*.txt) or
Berlin GNSS- Mittelwerte (*.txt).

When choosing LandXML, TDS Raw Data, Field Book or KOF files,
select the type of raw data to export: either Export TS Raw Data and/
or Export GPS Raw Data. In addition, being exported to TDS Raw
Data file, raw data can be saved in a format compatible with the FBK
format. Selection of the FBK Compatible option is available if control
codes are saved as notes. When selected, the FBK Compatible option
demands points have only numerical names. The screen displays a
number at which TopSURYV will start renaming points with
alphanumeric names (Figure 5-37 on page 5-26).
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ETD File Cancel

Data
|Raw Data v

Farmat
|TDS Raw Data (* RAW) v

Expart TS Raw Data
Export GRS Raw Data
[w] Control Codes as MNotes

Alphanumeric Points will be l—
Renumbered Starting at: 5005

“ode Style...

Figure 5-37. Export Raw Data To TDS Raw Data

and TDS Raw Data formats is also available

@ Export of Localization data to the Pocket 3D GC3
through the Localization screen.

For details on the formats of the files to which
@ TopSURY can export data, refer to TopSURV
Reference Manual.

Exporting GPS Sessions to the
Receiver

1. This function is available in PP Static survey mode.
To export the GPS session to the receiver, establish a

connection between the controller and the applicable receiver,
then tap Export » Sessions (Figure 5-38 on page 5-27).
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(GPS Session

ESessiuns Close

Receivers V| Goto sleep mode

E-Hiper+

----- Site2

Active Sessions m

j(n} Type Start Day g
Site2 Static Tue 1
< >

Figure 5-38. Job Session

Exporting Data

2. On the the Sessions screen (Figure 5-38), select the sessions to

export in the left panel and tap the [#] button. The sessions to
be exported are displayed in the right panel.

3. Check and enable the Goto sleep mode box to put the receiver

into sleep mode.

4. 1If it is necessary to edit the sessions, select the Edit Session
option from the Help Icon menu in the upper-left corner of the

screen.

5. Tap the Export button. The session will be transmitted to the

receiver.
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Notes:

5-28 TopSURYV User’s Manual



Chapter 6

Storing Data

All the data used in the TopSURYV application is stored in a database.
The types of data stored include points, codes, layers, roads, linework,
raw data, and survey sessions for post-processing.

Editing Points

To edit the job points, tap Edit Job » Points. The Points screen
displays (Figure 6-1).

;.E}____I@’ (‘:37 Epuints Close
b7 | 1

s > | Paint Code =
Edit Job Paints 10001

ETape

@Tapeg_stk

41 Topo

ATy Topol code

AT 1line_offset code =

< >

| Find code | | Find Point |

[ Edt | [ add |

Figure 6-1. Points

1. To edit a point, either double-tap the point or select from the list
and tap the Edit button. Enter all necessary changes and tap
OK to save the changes.

= ~ To edit any object properties, double-click on the
object or select the object and tap the Edit button.
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2. On the Point Info tab, enter new information on the point: the
name, code, and note if preferred (Figure 6-2).

Paint Info | Laver/Style | Check pail | ¥

[@] Paint

£ Code Itb R
D
MNote |

WGS84(m)

Lat |55.3039745?4
Lon I3?.363960014
Ell ht |150.015

Figure 6-2. Enter New Point Information

3. To set the code and attributes available for the code chosen, tap
the Attributes List icon [g=] (Figure 6-2).

ESroint attribut [T ]
Code Attributes Photd < | *
Code Iln_gbr -
|| v
|2 v
%, pink
l Props " Repeat l Default
l Multiple Codes

Figure 6-3. Point Attributes

¢ On the Point Attributes screen, select the desired code from
the drop-down list.

¢ Set one or two control codes in the lower field from the
available ones for a Code Style of Line or Area.
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The Control Code is a special type of code that is
used by the graphic tool for the interpretation of
survey results.

The supported control codes (AS, AE, C, R) control line behavior
when creating arcs, closure of lines, and rectangles respectively. The
AS control code indicates the start of an arc, and the AE control code
indicates the end of the arc. Arc parameters are determined using
additional points in the line.

To use your own control codes, check and enable the Allow Custom
Control Code box on the Global screen (Figure 4-99 on page 4-78).
In this case, you can enter any string to mark it as a control code,
TopSURYV will not interpret these control codes.

The field, marked by the sign (Figure 6-3 on page 6-2), is

used for entering a string to generate a line for a Code Style
of Line or Area. Code Style is set when editing the code.

The lower field shows the available attributes. Tap on the
attribute to provide a field to enter its value.

Tap the Properties button to view the ranges for the
attributes. Attributes can only be added on the Feature-
Attributes screen when adding a code.

Tap the Repeat button to erase the entered values.
Tap the Default button to set default values.

Tap the Multiple Codes button to edit multiple codes and
strings. Multiple codes and strings associated with a point
make the point a part of numerous lines.

4. On the Layer/Style tab (see Figure 6-4 on page 6-4), select the
layer that the point will be stored to and the plotting properties
to represent the point on the selected layer. (If needed, tap the
List [ button to edit layers.)
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Layer/Style | check pai | »

Layer |<Ely Codes »

Point Style

Figure 6-4. Set Layer and Point Style

5. On the Photo Note tab (Figure 6-5), add a photo comment on
the point. Tap the Add button to open the Browse screen to
select the image. To erase the image, use the Delete button.

Figure 6-5. Add Photo Note

6. If the point is contained in multiple point objects, these points
will display in the Check Points tab on the Edit Point screen
(Figure 6-6 on page 6-5).
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EXedit point ok | cancel
check Paints | wa | Photo Nate LD
Marne | dn | dE
100 4,763 -0.001
100 12,275 0.000
< >

Figure 6-6. Check Points

7. When editing a point which has a station available for Weighted
averaging, the WA tab will display on the Edit Point screen. The
WA tab displays coordinate residuals of the check point. Tap the
Use In WA/Exclude from WA button to control either to use or
not to use the station as a weighted average (Figure 6-7).

Em OK ICanceI]

[ check Points | WA |Phato Mote | LI

Marmne | M Resid | E Resid
100 0,000 0,000

B0 4,763 -0,001

B0 12,275 0.000

< >

Figure 6-7. Weighted Average

8. To find a point by name, tap the Find by Point button on the
Points screen and insert the whole name or a part of the name
(in the latter case, select the Match partial name field). Tap
Search. The first point satisfying the search criterion is
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10.

11.

Data

highlighted in the list on the Points screen. Tap the Find Next
button to find another point with the same name.

To find a point by code, tap the Find by Code button on the
Points screen and select the code from the drop-down list (in
the latter case, select the Match partial name field). Tap Search.
The first point satisfying the search criterion is highlighted in
the list on the Points screen. Tap the Find Next button to find
another point with the same code.

To add a point manually, tap the Add button on the Points
screen. If it is necessary to use the point as the Control point,
check mark this box.

To enter a PTL point, turn on the PTL Mode using the Help
Icon menu in the top-left corner of the Points screen. When
adding or editing a PTL point, insert the starting and ending
reference points and the PTL offsets: offset from the starting
point along the reference line, horizontal offset from the
reference line, and the height offset with respect to the starting
point (Figure 6-8).

Paint Info | Layer/Style | PTL | Pho 4

Start Ref Pt ||

End Ref Pt 101

PTL Offsets(m)

Line IlD .0oo
Offset IlD .0oo

Ell ht IlS?.DDD

Figure 6-8. Edit PTL Point
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You can store points in the TopSURV database as stand-alone points,
linework, and open polylines or areas (closed polylines) by using an
appropriate Code Style for these points.

Stand-alone Points

Storing Points

Points which have no codes, or have codes of the Point type but no
strings associated with the codes, are simply stored as points

(Figure 6-9).

.

E Code m Cancel
Name pt_p
Desc Ipillar
Type [TET—
Layer |5t v [I]

Point

Style

IFiIIed Circle +

Color

| [] code bt N

Point |LayerfStyle Phutu Note |

[®] Point 102

Note [

GG:MOS [WGS84](m)

North |1nnn.nnn
East 1000.000
Eley |15u.u15

Figure 6-9. Code of Point Type

The map shows the points as stand-alone in the selected style

(Figure 6-10).
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Linework

To store the points that will be connected to form a linework, select
the same unique combination of codes and strings. Select the codes of
the Line type to use for such points (Figure 6-11).

1. All points with the same code-string combination are connected
in the order of measurement to form a line.

2. Points can also be associated with multiple codes and strings,
thus making the point a part of numerous lines.

Name in_gh]| Point |Layer,‘5tyle ]Phutu Note ]
Desc IqreenT [®] Point [LoD1]
Type lﬁ Code Iln_gb—v
Layer h E] Il e
Note |
Point | Line | Attribute GG:MOS [WGS84](m)

Style North W

) I{By Layer> w East IW

Elev X a—

[] control Point

Figure 6-11. Code of Line Type

The map shows the points connected into a line in the selected style
(Figure 6-12).

10000

1001

——20m

Figure 6-12. Map View for Line Points
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Linework Package

Additional manipulations of linework can be performed using control
codes for the points with the same code-string combination. Up to
two control codes can be specified for every code associated with a
point to store the points which will be connected to form open or
closed polylines. Select the codes of the Line type to use for such
points.

The supported control codes of AS, AE, C, and R control line
behavior by allowing creation of arcs, closure of lines and creation of
rectangles, respectively. The delimiter is set in the Global screen (see
Figure 4-99 on page 4-78).

ZETR o o]

e T a— Point [Layer/Style | Photo Note |
Desc Igreen brick rose [®] Point Iml
Type ILine v | —p Code IIn;AS b
Layer h@ ! =
Note |
Point | Line | Attribute MOS [WG584](m)
Style MNorth |1l:ll:llII.IIIlIIIII
|Filled Triang + East |1|J|J|J ooo
Elht  [i50.014

Figure 6-13. Code of Line Type with Control Code

1. The AS control code indicates the start of an arc; the AE
control code indicates the end of the arc. Arc parameters are
determined by the presence of additional points in the line.

* These points can create the line segment with the arc start/or
end point which will act as the tangent to the arc.

* If only one point is between the arc start and end points, the
arc is formed such that all the three points lie on the arc. If
there are two, or more than two points, between the points
with the AS and AE control codes, the points are all
connected by straight line segments.
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2. The R control code is applied to the third point of a three point
polyline, and results in the automatic creation of a fourth point
of a parallelogram whose diagonal is specified by the first and
the third point.

3. When the C control code is applied to a point, it connects it to
the starting point of the line, thus closing the line.

The map shows the points connected into a line in the selected style
(Figure 6-14).

10000

1001

100

——20m

Figure 6-14. Map View for Line Pints with Control Codes

TopSURYV will not use this linework package if the Allow Custom
Control Code box on the Global screen is check marked (see

Figure 4-99 on page 4-78). In this case, the user can enter any string
to mark it as a control code. TopSURYV will not interpret these control

codes.
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Area

Areas are simply closed lines formed by points with the codes of the
Area type and the same code-string combination (Figure 6-15).

ZET o [ o o]
Name Point |Layer/Style | Photo Note |
Desc Ieast [®] Point |EEE|

Type IArea v |— [¢] Code Ibd_farm v
Layer Ist v E] Il e

Note |

PDinTlLine Area | Attribute MOS [WGS84](m)
Style Morth 1000.000

Fill Style [Solid ~ East 1000.000
. l—
-Culur
- Ell ht 150.014

Transparency (20 o

Figure 6-15. Code of Area Type

The map shows the points connected into a line and the area that can
be filled with the selected style (Figure 6-16).

10000

1001

——20m

Figure 6-16. Map View for Area Points
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Editing Codes

To edit codes and attributes, tap Edit Job » Codes. Codes already in
use cannot be edited or deleted. The Code - Attributes screen displays
(Figure 6-17).

[

= il ECude - Attributes
o — 19

-~ Code | Descripti... |
Edit Job Codes ﬂbd_ﬁ-n farm
Z‘In_gb qgreen br...
* |pt

o
=]
Wi
@

% s Edit

Del
Attributes Del
12; tel

Figure 6-17. Code - Attributes

1. To add a code, tap the Add button on the right side of the
screen. The Code screen displays. Enter the code name and
description (if needed). Select the type of code (from Point,
Line, Area) and the layer that the code will be stored to. Set the
Code Style to represent points, lines and areas with this code on
the selected layer (Figure 6-18 on page 6-13). On the Attributes
tab, select a radio button for the prompt for code at the
beginning of a line or at every point along the line. Tap OK.

2. To define the attributes for the new code, select the code and tap
the Add button on the right side of the screen. Set the name,
type, and parameters of the attribute for the code on the
Attributes screen (Figure 6-18 on page 6-13). Attribute type
indicates whether attribute values can be set as boolean True or
False, or selected from a list of available values, or are
alphanumeric strings, integers or real numbers. Check and
enable the Required box to always use the default value of the
code. Tap OK.

6-12 TopSURYV User’s Manual



Editing Codes

ECude OK | Cancel EAttributes OK | Cancel
Mame I Attrib Mame Iheight
Desc Ieast
Type IInteger v
IArea v
Type Min al 1
Layer ISt v E] Maz Wal Iﬁ
Point | Line | Area | Attribute
Style
Fill Style |Solid +
Col
Default I
Transparency (20 o [ Required

Figure 6-18. Edit Codes / Attributes

3. To edit a code or attribute, double-tap the object or select it and
tap the corresponding Edit button (Figure 6-17 on page 6-12).
In the Code or Attribute screen, make changes and tap OK
(Figure 6-18).

4. To delete a code or attribute, highlight it in the list and tap the
corresponding Del button (Figure 6-17 on page 6-12). Codes
being used in points and their corresponding attributes cannot
be deleted.

5. To export the code library to the selected file format, select the
Export To File option (Figure 6-19 on page 6-14) from the Help
Icon menu in the upper-left corner of the Code - Attributes
screen (Figure 6-17 on page 6-12).
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ETD File Cancel

Data
|C0de Library
Farmat

Figure 6-19. Export to Code Library

Editing Point Lists

To work with Point Lists, tap Edit Job » Point Lists.

1. To add a point list, tap the Add button on the List of Pt Lists
screen (Figure 6-20).

e [ e —0
F ~ aa
I{‘\ " _f—_gg- F— Close
Edit Joh Layers Lis.t Df Paint Lists
PointList1

PointList2

Copy

IIA

Figure 6-20. List of Point Lists
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2. To edit a point list, select the point list and tap the Edit button
on the List of Pt Lists screen. In the Edit Point List screen
displays (Figure 6-21) and shows the Point List Name and
selects the points for the list.

EXedit point List [N [
Point List | Properties

Point List Mame:

[#][ st of Poin ~ ¥y

L
@[3

[#]]< > e=mom [

[Puint Inﬁ:l] Sel pts v|

Figure 6-21. Add Point List — Point List Tab

Adding a point to the Point List can be performed in two ways; either
through the map or through the Sel Pts button (Figure 6-21).

To add a point through the map, do the following:

1. Tap the plot on the right. A large Map screen opens.

2. Select the points by tapping them on the map - the two
consequently tapped points will be connected with a line.

3. Tap Close.
To add a point through the Sel Pts button, do the following:

1. Tap the Sel Pts button. A floating menu of six items display.
Select one of six ways of adding points.
* By Range — When specifying the range of points, the symbols
7, ¢ or “;” should be used to separate the names of the points
to be selected. The symbol ‘-’ can be used between two point
names when the two points, and all the points between them
are to be selected.

* By Code — All the points with the codes checked here will be
selected.
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* By CodeString — All the points with the highlighted code with
the Strings checked here will be selected.

* By Radius — By specifying the center point and the radius, all
the points that lie within the area are selected.

* From Map — The points can be selected from the Map screen
as described above.

» From List — Desired points can be selected from a list of
available points.

Repeat actions until all the points are added to the list.

3. Use the arrow buttons to modify the order of points in the list,
and the delete button to remove points from the list.

4. Tap OK.

Editing Layers

The “layers” in a TopSURYV job can be thought of as overlapping
sheets of paper containing different drawing elements. Each layer is
associated with a definite set of points, codes, lines, and alignments.
When creating a layer, it can be either shown or hidden (that is,
displayed or not displayed).

Each new job contains a special Zero (“0”) layer. By default, all job
objects will be stored to this layer. Layer O cannot be deleted or
renamed.

Tap Edit Job » Layers to display the Layers screen (Figure 6-22 on
page 6-17).
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=
. ] | Layer N... | Status |

Edit Job Layers

Default:Has Ohjects
Has Ohijects

] (o) ) [ e

Figure 6-22. Layers

1. To add a layer, tap the Add button on the Layers screen. The
Add Layer screen displays.

2. On the Add Layer screen, enter the layer’s parameters and tap
OK. The layer will be included in the list of layers.

3. To delete a layer, select it from the list of layers and tap Del.

Use the arrow buttons to modify the order of layers in the list,
and the Ins button to add a layer and insert it below the
currently selected layer.

5. To turn on/off the visibility of a layer or multiple layers at a
time, select the desired layers using the Ctrl or Shift buttons on
the controller’s keyboard and tap on the Layer Name column
header on the Layers screen.

6. To edit a layer, either double-tap the layer or select it on the
Layers screen and tap Edit. On the Edit Layer screen
(Figure 6-23 on page 6-18), change the layer’s parameters as
needed and tap OK.

* On the Layer tab, enter a new layer name, check and enable
the Visible box to show the layer on the map, and enter any
additional information in the Note field (Figure 6-23 on
page 6-18).
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Layer | Style | Chjects

Layer Mame I
Visible 72

MNote ’mints 1_100

Figure 6-23. Edit Layer

* On the Style tab (Figure 6-24), define the plotting style
properties for the points, lines, and areas of the layer.

ZENTT o o)

Layer | Style | Objects
Point Style

& IFiIIed Triangle »
Line Style
ISl:llid v

Width 1Pt A

Area Style

None v

Transparency EEI %

Figure 6-24. Edit Layer Style

7. To view objects on the existing layer, tap on the Objects tab
(Figure 6-25 on page 6-19).
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Figure 6-25. Layer Objects

Editing Linework

Linework is provided in the points which are connected to form open
or closed polylines. For details, see “Storing Points” on page 6-7. To
edit lineworks, select the Edit Job » Lineworks icons.

[ —

W

Edit Job

—>

A I
/4] ELinewurk Close

Editing Linework

Lirework

<

> I:IZSD m

Figure 6-26. Edit Linework

1. On the Linework screen, tap the Add button to create new

linework. The Edit Line screen displays (Figure 6-26 on
page 6-19).
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2. To delete the linework from the list, tap the Delete button
(Figure 6-26 on page 6-19).

3. To edit the properties of a linework, either double-tap or
highlight the linework in the list and tap the Edit button
(Figure 6-26 on page 6-19).

4. On the Points in Line tab of the Edit Line screen, change the
name of the linework if necessary (Figure 6-27).

* To change the order of the points, use the up and down
arrows.

* To view information on a point, select the point in the list and
tap Point Info.

* To add points to the selected/created linework, tap the down
arrows next to the Sel Pts button in the lower right-hand
corner. Select the appropriate parameter from the Sel Pts pop-
up menu.

Points in Line | Layer/Style

Linework Mame

[#][ st of Paints ¥y
20
oy 32

b
e

[#]< ¥ =2om  [w]

[Puint Inﬁ:l] Sel pts v|

Figure 6-27. Edit Line

5. On the Layer/Style tab of the Edit Line screen (Figure 6-28 on
page 6-21), set layer and plotting properties to use to display
the points and lines on the map and tap OK.
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EEdit Line [ OK Canl:el

Points in Line | LayerfStyle

<6y Code> Y]
Point Style

- |4By Code> M

Line Style
|4By Code> -+ | |Color
Width I{By Code> «

Figure 6-28. Edit Line/Point Style

Editing Areas

Area is bound with a closed line. Line nodes (points) have the same
code of area type to form an area boundary. To edit lineworks, tap
Edit Job » Area. The Area screen displays (Figure 6-29).

—
= x B e
{‘.\,--" List of Areas K
Edit Job ~~cRBArEa-1
worewbd_fm&2
~reseshd_fm8Are
~eoechd_fm8Are =]
HT#
1
e,
100
< > |:IIIIDDI'H

Figure 6-29. Select Area

1. On the Area screen, tap the Add button to create a new area.

2. To delete the area from the list, tap Delete (Figure 6-29).
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3. To edit the properties of an area, either double-tap or highlight
the area in the list and tap Edit. The Edif Area screen displays
(Figure 6-30).

4. On the Points in Area tab, change the name of the area if
necessary.

Points in Area |LayerfStyle
Area Name [~ ~Area-9]

E] List of Point: ’
112
111

@ & 110
& 109
47 100

(]2 > e=som M)

[Puint Inﬁ:l] Sel pts v|

Figure 6-30. Edit Area

5. To change the order of the points, use the up and down arrows.

6. To view information on a point, select the point in the list and
tap Point Info.

7. To add points to the selected/created area, tap the menu in the
lower right corner. Select the appropriate parameter from the
Select Points pop-up menu.

8. In the Layer/Style tab of the Edit Area screen, set layer and
plotting properties to use for display the points, line and area on
the map and tap OK.
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Operating Raw Data

Tap Edit Job » Raw Data. The Raw Data screen displays

(Figure 6-31) and reflects all the collected measurements. In GPS+
mode, this screen also displays the coordinates of the base and the
vector of the stored points from the rover to the base.

.—‘5_—_—_.. —
[ !’ [ ) |"“ Raw Data Recumputel Close

. V7 a

\ﬂ, / J Marne Type Codes -

Edit Jol Raw Data s Topo IRF6... 5S¢
16 Topo IRF6.. 5S¢
17 Topo IRF6.. 5S¢
M1 Topo  IRF6.. S¢

#1000 Auto... TD St
#1 1001 Auto... TD St

&7 4 Tem r e

< 4

[ First H Last ” Edit |

Find Code | (Find Point | Find Mext

Figure 6-31. Raw Data

1. To move the cursor to the first or last point, tap the First and
Last buttons.

2. To find a point, tap the Find Point button and fill out the fields
in the Find by Point screen. The point can be found by name or
a part of its name.

3. To find a point by code, tap the Find Code button and select the
code in the Find by Code screen.

4. To find the next point that satisfies the same conditions as the
previous found point, tap the Find Next button.

5. To edit the raw data point, tap the Edit button. The Edit Raw
Data screen displays.

6. On the Edit Raw Data screen (Figure 6-32 on page 6-24), enter
additional notes for a point by typing the note in the suggested
field. The appearance (parameters) of this screen varies based
on the type of raw data being edited. (Note that editing Ant Ht,
HR & HI values, azimuth, etc., will not immediately recompute
coordinates.)
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7. To recompute the point coordinates, tap the Recompute button
on the Raw Data screen.

8. To toggle between displaying GPS+ raw data and TS raw data,
select the Show Raw GPS+/TS option from the Help Icon menu
in the upper-left corner of the screen.

6-24

) ok |cancel|
Topo |Data
[®] point
v
B Code |—v
Ant HE om0 m Jvert v

Ant Type IHiPer Lite/Lite+ v

MNote

Figure 6-32. Edit Raw Data
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Editing GPS Sessions

To create or edit sessions (only in GPS+ mode) of automatic survey
for post-processing, tap Edit Job » Sessions.

;El————- ; ‘ R ESessiuns m Cancel
\ﬂ, —} Ny Sessions
Edit Job Sessions D Type | Start Da

Sitel Static Sun

Site2  Static  Tue Edit
< »
Receivers m
i

Figure 6-33. Session Edit

1. To create a new session, tap the Add button on the Sessions
panel (Figure 6-33). The Session Setup screen displays.

2. On the Session Setup screen (Figure 6-34), enter or select
session settings parameters.

ESessiun Setup 0K lCanl:eI

Site Name [Sitel

Type |Stati|: v
Start Time |00 v [+ <o =

End Time W Ig_gu_%
Interval IBIII— sec
Minsvs [+

Ant Type |CR-3 v
antHt [Lo00 m

Figure 6-34. Session Setup
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Enter the site name, the type of the survey, the time (in local time)
and date of the start and end of session, the interval between
measurements, minimum number of satellites needed for the
survey and the value and type of the antenna height. Then tap OK
to return to the Sessions screen (Figure 6-33 on page 6-25).

3. To add a receiver, tap the Add button on the right side of the
screen.

4. Enter the name of the receiver in the Receiver Name dialog
box. Then tap OK.

5. To hide/display the session plans of the receiver, tap on the “-/
+” sign located near the receiver name to collapse/expand the
tree node (Figure 6-33 on page 6-25).

6. To put a session to the session plan of the receiver, highlight the
desired session in the left panel and check the necessary

receiver on the right and tap the [#] button (Figure 6-33 on
page 6-25).

7. To edit the session, select it in the left panel and tap the Edit
button (Figure 6-33 on page 6-25).

8. To delete the session from the sessions list or the receiver, use
the [3¢] button (Figure 6-33 on page 6-25).

9. Tap OK to save the changes and close the screen.
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Editing Objects from the
Main Map

Editing objects in the job can be accessed either from the Edit Job
menu or from the Main Map.

To open the Main Map, tap the Map icon.

1. When in the Main Map (Figure 6-35), tap the desired object to
highlight it. Then hold the stylus on the selected object for a
while until a pop-up menu displays. The menu options depend
on the object selected.

1‘;,3_*

Map

Map Icon q

Stakeout

Point In Direction
Edit

Delete

Add To Layer

——=500 m

Figure 6-35. Editing from the Main Map

2. To select multiple objects, tap the % toolbar icon and extend
a square window from right to left to include the desired
objects. These objects can either be deleted or added to a Layer.
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Notes:
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Chapter 7

All the data used in the TopSURYV application is stored in a database.
The types of data stored include points, codes, layers, roads, linework,
raw data, and survey sessions for post-processing.

Designing a road is performed by establishing numerically known
station points along a center line of the proposed route (horizontal
alignment). To furnish data for estimating volumes of earthwork, a
profile is run along the center line (vertical alignment) and cross
profiles are taken along lines passing through each station and at right
angles to the center line (cross sections).

The horizontal alignment can be designed by sections described
through lines, spirals, arcs and intersection points. Intersection point
is defined as the intersection of the two lines tangential to the
'incoming' and 'exiting' spirals, or to the central curve at the PC and
PT points, if spirals are not specified.

The vertical alignment can be described through vertical grades and
parabolas, or long sections.

The cross section can be described using templates.

To design a road, select the Edit Roads icon in the main menu. Road
designing consists of designing a road as a whole and designing each
component of the road: horizontal alignments, vertical alignments,
cross section sets, and cross section templates.
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Editing Roads

To edit a road, tap Edit Roads » Roads. The Roads screen displays
(Figure 7-1).

1. On the Roads screen tap the Edit button. The Edit Road screen
displays (Figure 7-2).

Q'} @ F—|Roads | Close

Name

Edit Roacs Roads oad |

< >
U L
=z0m b=zom
[Delete] [ Edit ] [ Add ]

Figure 7-1. Roads

2. On the Edit Road screen, set the name and select the layer, the
alignments, and cross-section set of the road and tap OK.

EEdit Road m Cancel

Name Foad|

Layer IIII v E

Hz Alnt |1 v
Iv v

xsectset [ v

Start 5tn Il:l+l]l].l]l]l] m

Stn Interval |100.000 m

Figure 7-2. Edit Road
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Editing Roads

If needed, change the layer from the drop-down list to locate the
road. Select the layer from the Layer drop-down list, or use the

(.- | button to edit layers. (For details refer to “Editing Layers”
on page 6-16).
Select a pre-defined horizontal alignment from the Hz Alnt

drop-down list to use in designing the road. Use the List [ ... ]
button to edit horizontal alignments. (For details refer to “Editing
Horizontal Alignments” on page 7-4).

Select a pre-defined vertical alignment from the Vr Alnt

drop-down list to use in designing the road. Use the List [ ...']
button to edit vertical alignments. (For details refer to “Editing
Vertical Alignments” on page 7-12).

Select a pre-defined cross section set from the X-Sect Set

drop-down list to use in designing the road. Use the List [ ...
button to edit cross section sets. (For details refer to “Editing
Cross-Section Sets” on page 7-21).

Set the starting station with distance to it, or the starting chain
distance, depending on a selection made on the Display screen.

Set the interval between the station points where road related
computations are made.
To save the road file, tap OK and return to the Roads screen
(Figure 7-1 on page 7-2).

To add a new road, either double-tap the road or tap the Add
button.

To remove a selected road from the list, tap the Delete button.

After the road is edited, calculate the road points using the Calculate
Road Points option from the Help Icon menu in the upper-left corner
of the Roads screen (Figure 7-1 on page 7-2). The Calculate Road
Points screen displays (Figure 7-3 on page 7-4).

6.

Select the desired road point types on the Calculate Road
Points screen (Figure 7-3 on page 7-4). If needed, change the
station interval and tap Next to set the properties of the
generated points in corresponding screens. In the last screen,
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opened by the Next button, tap the Cale button to perform
calculations.

ECalculate GLEG T Cancel

Points to Generate

Points Right of Centerline
Points Left of CenterLine

Include Transition Points
PrefixfSuffix

INune v

Station Interval

Ill]l] 000 m

Figure 7-3. Calculate Road Points

Editing Horizontal Alignments

To edit a horizontal alignment, tap Edit Roads » Horizontal.

1. To edit the horizontal alignment, in the Hz Alnt screen
(Figure 7-4), either double-tap the horizontal alignment or
highlight it and tap the Edit button.

& [®

3 Name
Edit Roads Haorizontal 1

— m] [ Edit | [ Add |

[

Figure 7-4. Horizontal Alignment
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2. On the Start Pt tab of the Edit Hz Alnt screen (Figure 7-5),
enter the alignment name and Start Point, the Code, the North/
East coordinates, and the Start Station number (or the starting
chain distance).

AL ok |cancel]
Start Pt |Hz

Alnt Name |1—
HH start pt [EEEE @]
@ Code l—

North IEI 178516.34 m
East |4 15418.395 m
Start Sta Il]+l]l].l]l:ll] m

Figure 7-5. Edit Horizontal Alignment

The point name can be entered manually (if a new point name is
entered, the point will be created with the coordinates entered in
the North and East fields), selected from the map, or selected
from the list. If needed, enter a photo note for the point.

3. On the Hz tab of the Edit Hz Alnt screen (Figure 7-6), add
horizontal alignment elements.

A edd ok |cancel]
Start pt | Hz

Element -~

S Curve
#~Curve

™, Spiral

A I-Sect Po...
Misectpo... ¥
< > —20m

End Sta 0+05.000 [»]

| Ins v|| Add v|

| pelete || Eait |

Figure 7-6. Add Horizontal Alignment Elements
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* To add a horizontal alignment element (Figure 7-7), tap the
Add button and select an element from the floating menu:
either line, curve, spiral, or intersection point.

* In the corresponding screen displayed, enter parameters for
the element (length and azimuth for line, length, radius,
azimuth, turn for curve; length, radius, azimuth, turn,
direction, for spiral; point coordinates, curve radius,
incoming and exiting spiral lengths, for intersection point)
and tap OK. Add as many elements as needed to define the
road.

* Tap the Station information under the element list to display
start and end stations for the selected element.

T de ok |cancel|

Start Pt | Hz

Element -~

==Line

S Curve
#~Curve

™, Spiral

A I-Sect Po...

LicortDn ¥
Start Sta 0+15.000

End Sta 0+25.000 E

Delete Edit

Figure 7-7. Information on Element Start and End Stations

* Also, the information on the selected element can display
from the greater Map opened by double-tapping in the plot
area. Select the alignment element and double-tap it to
display detailed information (see Figure 7-8 on page 7-7).

4. Tap OK on the Edit Hz Alnt screen to save the horizontal
alignment and return to the Hz Alnt screen.
5. To add the horizontal alignment, tap the Add button.

To remove a selected horizontal alignment from the list, tap the
Delete button.
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EMap OK | Cancel EAlignment Element Infc alils:]

Start Sta 0+98.785
l% End Sta 1+29.275
Start North 6178567.07
Start East 415375.80:
End North 6178545.9:
End East 415362.72¢

——20m

Qe el &

Figure 7-8. Information on Horizontal Alignment Element

Adding a Line

1. To add a line, select the Line option from the Insert or Add
floating menu on the Horizontal tab of the Edit Horizontal
Alignment screen. The Line Screen displays.

2. On the Line screen, enter the length of the line element and the
azimuth only for the starting element of the road (Figure 7-9 on
page 7-8). By default, the azimuth is set tangent to the previous
element. To change the azimuth of all other elements, remove
the check mark from the Tangent to Previous Item box on the
Help Icon in the upper-left corner of the screen.

azimuth, since road elements are usually tangential

@ Caution should be exercised when setting the
to each other.

3. Tap OK to save the element to the road and to return to the Edit
Hz Alnt screen (Figure 7-7 on page 7-6).
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ELine OK | Cancel
Length [ENLE m

Azimuth [341.0229  dms

=50 m

Figure 7-9. Add Line

Adding a Curve

1.

To add a curve, select the Curve option from the Insert or Add
floating menu on the Horizontal tab of the Edit Hz Alnt screen.
The Curve screen displays.

On the Curve screen (Figure 7-10 on page 7-9), enter the
following parameters:

» The length of the curve element, or one of five parameters
unambiguously defining the curve length: chord, tangent,
middle ordinate (the distance from the midpoint of a chord to
the midpoint of the corresponding curve), external (the
distance from the midpoint of the curve to the tangent), or
delta (the angle between the radii corresponding to the
curve). Using the degree of chord (DCH) or degree of curve
(DCV) parameters, the radius can be calculated as follows:

B 50 r _ 100x180 1
- .(DCH ny 1 DCV
sSin 2 ><18

* The azimuth only for the starting element of the road. By
default, the azimuth is set tangent to the previous element. To
change the azimuth of all other elements, remove the check
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mark from the Tangent to Previous Item menu on the Help
Icon in the upper-left corner of the screen.

Caution should be exercised when setting the
@ azimuth, since road elements are usually tangential
to each other.

* For the direction of turn (Figure 7-10), select either the Right
value (clockwise direction or the Left value (counter-clockwise
direction.)

ECU[VE m Cancel

& |Radius |2uu.uuu m
@ [Length [N m

Azimuth  [341.0229  dms

Turn IRight v

=50

Figure 7-10. Add Curve

3. Tap OK to save the element to the road and to return to the Edit
Hz Alnt screen (Figure 7-7 on page 7-6).

Adding a Spiral

1. To add a spiral, select the Spiral option from the Insert or Add
floating menu on the Horizontal tab of the Edit Hoz Alnt screen
(Figure 7-7 on page 7-6). The Spiral screen displays.

2. On the Spiral screen (Figure 7-11 on page 7-10), enter the
following parameters:

* The radius of the curve, or one of two parameters
unambiguously defining the radius: the degree of chord, or
the degree of curve (for detail, see “Adding a Curve” on
page 7-8).
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* The Length of the spiral or Sp Const, the parameter that is the
square root of the product of the length and the radius of the
spiral, as defined above. Consequently, the spiral constant has
the units of length.

* The azimuth only for the starting element of the road.
By default, the azimuth is set tangent to the previous element.
To change the azimuth of all other elements, remove the
check mark from the Tangent to Previous Item menu on the
Help Icon in the upper-left corner of the screen.

azimuth, since road elements are usually tangential

% Caution should be exercised when setting the
to each other.

* For the direction of turn, select either the Right value
(clockwise direction or the Left value (counter-clockwise
direction.)

* For the direction of movement along the spiral, select either
TS to SC (entering the turn), or CS to ST (exiting the turn)l.

ESpiral m Cancel

&= |Radius Start |u.uuu m
& [Radius End [200.00 mq
# (Length 50.000 m

Azimuth  [341.0229  dms

Turn

IRight v
Dir

—s0m [Ts TosCv

Figure 7-11. Add Spiral

1. The traverse points on the turn have the following markers:
TS-traverse-spiral; SC-spiral-circle; CS-circle-spiral; and ST-spiral
traverse.
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3. Tap OK to save the element to the road and to return to the Edit

Horizontal Alignment screen.

Intersection Point

1. To add an intersection point, select the Intersection Point option
from the Insert or Add floating menu on the Horizontal tab of
the Edit Hz Alnt screen. The Intersect Pt screen displays.

2. On the Intersect Pt screen (Figure 7-12), enter the following

parameters:

* For the name of the intersection point, either enter the name
manually (with the coordinates specified in the North and
East fields and a height of zero), or select it from the map or

the list.

* The local coordinates of the intersection point cannot be

changed for an existing point.

¢ For the radius of the curve, or one

of two parameters

unambiguously defining the radius, either enter the degree of
chord, or the degree of curve (for detail, see “Adding a

Curve” on page 7-8).
* The length of the corresponding spiral

elements, or the spirals

constants are defined (see “Adding a Spiral” on page 7-9).

Elntersect Pt OK ICanl:eI

EH Ppoint ipa]
Morth M
East lm

o conom 1 Joma—

% |Length 2 |[30.000

m

m

m

m

m

Figure 7-12. Add Intersection Point
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3. Tap OK to save the element to the road and to return to the Edit
Hz Alnt screen.

Editing Vertical Alignments

To create a vertical alignment, tap Edit Roads » Vertical. The V¢
Alnt screen displays (Figure 7-13).

1. Tap the Add button to add a new vertical alignment. The Add
Vt Alnt screen displays (Figure 7-14 on page 7-13).

Q\b—b

Name
Edit Roads Wertical ¥

o

20 m

10

Figure 7-13. Add Vertical Alignment
2. Onthe Add Vt Alnt screen (Figure 7-14 on page 7-13), enter
the name of a new vertical alignment.

3. Inthe VAL Type field, select a new vertical alignment (VAL)
type from the drop-down list and tap OK.
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Name IvE

Long Section

Figure 7-14. Add Vertical Alignment

* Long Section — select to present a vertical alignment as a set
of sections between stations where the heights are known
(usually the extreme of the vertical alignment line). A vertical
curve length specifies the length of the interval near the
station, where the alignment has a parabolic shape.

» Elements — select to create the road, element by element,
finishing wherever desired and starting again.

4. On the Start Pt tab of the Edit Vt Alnt screen (Figure 7-15 on
page 7-14), enter the name of the vertical alignment and
parameters of the starting point and station. (For the Long
Section vertical alignment type, only the vertical alignment
name is needed).
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Start Pt |vert

Alnt Name I"’E—
FH start pt [EEEE] @]
e

Elev |149 .938 m

Start Sta |5+l]l].l]l]l] m

@ Code

Figure 7-15. Add Vertical Alignment — Start Pt Tab

* The start point name can be entered either manually, selected
from the map, or selected from the list (the point will be
created with the height entered in the height field for a new
point name). If needed, enter a photo note for the point.

* The point code can be entered manually or selected from the
drop-down list. The code of an existing point cannot be

edited.

5. On the Vert tab of the Edit Vt Alnt screen (Figure 7-16 on
page 7-15), add the vertical alignment elements, or long
sections (for the Long Section vertical alignment type).

7-14
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EXedit ve aint [ ]
Start pt | Vert

LongSection 5
0

Long Sec...
Long Sec...

oo

20

< 4 H:.lgm

End Sta 0+00.000 [»]

[ mnsert |[ add |

| pelete || Eait |

Figure 7-16. Add Vertical Alignment — Vert Tab

* When the vertical alignment type is Elements, tap the Add
button and select either vertical grade or parabola from the
floating menu. Enter the parameters of the element: either
length and grade for the vertical grade, or parameters for a
selected curve (either length, start and end grade for the
parabola, or the radius of the arc for the circular arc).

* When the vertical alignment type is Long Sections, tap the
Add button and enter the parameters of the Long Section:
either the length of the parabola at the station (with the
assumption that the station is located in the middle of the
interval), or the radius of the arc, depending on the type of the
curve type selected.

Add as many elements or long sections as needed to define
the road.

* Tap Station information under the list of elements or long
sections to view the start and end stations for the selected
item (Figure 7-17 on page 7-16).
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A ERdy ok |cancel|

Start Pt | Vert

/\Parabola k]
Vertil:al e 1
—

S ArC a3l
2|_|DD
Start Sta S+00.000 | -
End Sta 7+00.000 5]
| Ins v|| Add v|
[ Delete ” Edit ]

Figure 7-17. Information on Start and End Stations

* Double-tap in the plot area to open the greater Map for the
vertical alignment. The Map screen displays. For vertical
curves, the map displays the PVC point where the vertical
curve begins, the PVI point of intersection of two tangents,
and the PVT point where the curve ends (Figure 7-18).

Z o [
qT

pyc  PWI_PWT PV
oo Yols

100

100 m

RUSVEVEY

Figure 7-18. Vertical Alignment Map

* Tap OK on the Add Vt Alnt screen (Figure 7-17) to save the
vertical alignment created and return to the V¢ Alnt screen. The
new vertical alignment will be displayed in the list.
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6. To edit a vertical alignment, either double-tap the vertical

alignment or highlight the desired alignment and tap the Edit
button.

7. To remove a selected road from the list, tap the Delete button.

Adding Vertical Grade

1. To add a vertical grade, select the Vertical Grade option from
the Insert or Add floating menu on the Vert tab of the Edit Vi
Alnt screen (Figure 7-17 on page 7-16).

2. On the Vertical Grade screen (Figure 7-19), enter the length of
the vertical grade element and the grade percentage of the
element. If the grade is falling, the value should be set to
negative.

E\mrtical Grade [Nl lCanl:eI

[ Length [N m
[AGrade  [5.00000 %

—

]
[IZISD m

Figure 7-19. Add Vertical Grade

3. Tap OK to save the vertical alignment element created and
return to the Add Vertical Alignment screen.

Adding a Curve

1. To add a curve, select the Curve option from the Insert or Add
floating menu on the Vertical tab of the Edit Vt Alnt screen
(Figure 7-17 on page 7-16). The Curve screen displays.
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2. On the Curve screen (Figure 7-20), select the type of curve to

add, either Circular Arc or Parabola. The plot at the bottom of
the screen shows the element appearance.

ECU[VE m Cancel
Curve Type et

Length [200.000 m
Start Grade [15 o
End Grade |3 %

=50 m

Figure 7-20. Add Vertical Curve
Enter the radius of the arc or the length of the parabola element,
depending on the type of curve selected.

Enter the starting and ending grades percentage of the element.
If the grade is falling, use a negative value.

Tap OK to save the element to the road and to return to the Add
Vt Alnt screen (Figure 7-17 on page 7-16).

Adding Long Sections

1.

For Long Sections vertical alignment types, only enter the
vertical alignment name in the Start Pt tab of the Add Vt Alnt
screen (Figure 7-14 on page 7-13).

To add a long section, tap the Insert or Add floating menu on
the Vertical tab of the Edit Vt Ant screen (Figure 7-15 on
page 7-14). The Long Section screen displays.

* On the Long Section screen (Figure 7-21 on page 7-19),
select the type of the curve to add from the Curve Type drop-
down list, either Parabola or Circular Arc, and enter the
station distance from the beginning of the road, the elevation
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(height) of the station, and the length of the parabola at the
station (with the assumption that the station is located in the

middle of the interval), or the radius of the arc, depending on
the type of curve selected.

ELung Section OK | Cancel

Station I m
Elevation M m
Curve Type Im
Arc Radius IIII.IZIIIIIII m

—=20m

Figure 7-21. Add Long Section

3. Tap OK to save the element to the road and to return to the Add
Vt Alnt screen (Figure 7-15 on page 7-14).
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Editing X-Sect Templates

To work with Cross-Section Templates, tap Edit Roads » Templates.
The X-Sect Templates screen displays (Figure 7-22).

@ —[@®

A3 Name Num Segs | Cut Sloj
Edit Roads Templates 1 3 1.000
2 1 2.000

<
L
1
0.5

)

Figure 7-22. X-sect Templates
1. To create a cross-section, tap the Add button on the X-Sect
Templates screen (Figure 7-22).

2. On the X-Sect Templates screen, enter the parameters of the
template: the name of the template, the Cut/Fill slope
parameters, and the segments comprising the template
(Figure 7-23).

EX—Sect Temp m Cancel

Name I

Slope

Cut Il.l]l]l]

Fill Il.l]l]l]

Code |Hz |Vert | -~
1.000 0.000
0.500 0.500 bt

0.5

[Delete || Edit || insert || add |

Figure 7-23. X-sect Templates
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3. To add a segment to the template, tap the Add button. The
Segment screen displays.

4. On the Segment screen (Figure 7-24) enter the parameters of
the segment (code and offset).

5. Tap OK.
The added segment will be attached after the last segment in the
list.

¥ code I 1 v

Offset

Horizontal

Il.l]l:ll] m

.
ID.SDD m

Figure 7-24. Segment

6. Repeat adding segments until the template is ready for work.
7. Tap OK. The template will appear in the list of templates.

Editing Cross-Section Sets

To create a set of cross-sections, tap Edit Roads » X-Sections. The
X-Sect Set screen displays (Figure 7-25 on page 7-22).

1. On the X-Sect Set screen, tap the Add button to add a new
cross-section set. The Edit X-Sect Set screen displays
(Figure 7-26 on page 7-22).
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Edit Roads

2] —

T -
@ Name
¥-Sections X
< >
—20m 2
Delete] [ Edit ] [ Add ]

Figure 7-25. Cross Section Set

2. On the Edit X-Sect Set screen (Figure 7-26), enter the name of

the cross-section set and tap the Add button,

] ok |cancel

Name Ix

Station Left X-Sect... | Ri
0+00.000 1 1
0+25.000 2 1
0+60.000 2 2
< >
cL
T=im
[Delete || Edit || Add |

Figure 7-26. Add Cross Section Set

3. Inthe X-Sect Set screen, define the station, where the cross-
section will be applied, or the distance to this station, and
specify the cross-section templates for the left and/or the right
parts of the road cross-section. These can be chosen only from
the existing cross-section templates. Tap OK.

7-22

TopSURYV User’s Manual



Editing Cross-Section Sets

] ok |cancel
Name Ix
Station Left X-Sect... Ri
0+00.000 1 1
0+25.000 2 1
0+60.000 2 2
< >

L

T=im
[ Delete “ Edit ” Add ]

Figure 7-27. Cross Section

4. To add a station, tap the Add button in the Add X-Sect Set
screen (Figure 7-27). Add as many templates as necessary to
define the road. If two or more cross sections are defined in one
set, the intermediate cross sections are calculated using
interpolation.

5. Tap OK to save the cross section set created and return to the
X-Sect Set screen. The new cross section set will be displayed
in the list.

6. To edit a selected cross section set, either double-tap the cross
section set or highlight it and tap the Edit button.

7. To remove a selected cross-section set from the list use the
Delete button.
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Editing Roads from the Main
Map

Editing roads in the job can be accessed either from the Edit Roads
menu or from the Main Map.

To open the Main Map, tap the Map icon.

1. When in the Main Map, tap the desired road to highlight it.
Then hold the stylus on the selected road for a while until a
pop-up menu displays (Figure 7-28).

1‘;,?_'

Map

Map Icon q

Road Stakeout
Real-time Road Stakeout
5.1 Slope Stakeout

Edit
Delete

Add To Layer

———500m

Figure 7-28. Editing from the Main Map

2. To select multiple objects, tap the %' toolbar button and

extend a square window from right to left to include the desired
objects. These objects can be deleted or added to a Layer.
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Chapter 8

surveying with
TopSURV

Performing GPS+ Surveys

After creating a job with the desired configuration in TopSURV and
completing the preliminary work (the antenna is plumbed and the
receiver and controller are connected), the survey can begin.

¢ To use RTK measurements, two receivers are needed: a Base
Station receiver, with an antenna plumbed above a point with
known coordinates, and a Rover receiver, with an antenna
plumbed above the points being surveyed.

If a local system is used, perform Localization first
to determine coordinate transformation parameters
from Geodetic coordinates to local coordinates.

and Auto Topo. Topo surveys collect data one at a
time at several locations, whereas Auto Topo
surveys continuously collect data (usually for
trajectory survey work).

; Survey work can be performed in two modes: Topo
~,

* To use Network RTK and Network DGPS positioning, a Rover
receiver is needed, with an antenna plumbed above the points
being surveyed, and correction data received by the Rover from
reference station networks.

* To use the Real Time DGPS survey mode, a Rover receiver is
needed, with an antenna plumbed above the points being
surveyed, and correction data received by the Rover from
differential services.
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¢ To use the PP modes, two receivers are needed: one located on an
occupation with known coordinates, and the other is either
located on static occupations (PP Static mode), moves along a
trajectory (PP Kinematic mode), or moves to position points of
interest (PP enabled RTK, Network RTK, Network DGPS and PP
DGPS). Data collected in PP (post-processing) modes can be
processed later in the office for estimation of baseline vectors.
The Topo and Auto Topo surveys for PP Kinematic and PP DGPS
modes are performed similarly to real-time surveys.

Job configuration settings will be applied to the Base receiver only
after starting the Base and to the Rover receiver only after selecting
the Topo/Auto Topo option.

Localization

Localization parameters can be defined either before beginning the
job or after the completing the job.

Localization parameters provide transforming coordinates between a
local system and the WGS84 system. To calculate these parameters,
the localization (control) points with pairs of coordinates in both
systems are used. The local coordinates and the WGS84 coordinates
are those of the same point on the surface of the earth, in the local and
WGS84 systems, respectively. The names of the Local and WGS84
points must be different.

For localization to work properly, enter or import the local
coordinates with Projection set to <none> in the Coord System screen
and Coord Type set to Ground in the Display screen. The quality of
coordinates of localization points directly affects localization
accuracy.

Localization points should be located more or less evenly around the
jobsite. They are not to be together or to be all at one section of the
site.

1. Tap Setup GPS » Localization. The Localization screen
displays (Figure 8-1 on page 8-3).

2. On the Localization screen, tap Add (Figure 8-1). The Add
Point screen displays (Figure 8-2 on page 8-3),
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/' \ @ Ti | ocalization [ settings |

F > iy éﬁ Name H Resid |V Resid

Setup GPS Localization C_ 0.084 0.000
I_1 0.128 -0.000
M_1 0.143 -0.000
< >

[ ]Keep scale 1.000

Figure 8-1. Localization Screen

3. On the Add Point screen, set the following parameters, then tap
OK (Figure 8-2):

o Fied H v g
1003 2201 3200 10+3
Local Point
Point |Ln1_1
Use Horiz Use Vert

WG584 Point
Point

IA v

Epoch Cnt: 0 Start Meas

Figure 8-2. Add Localization Points

* In the Local Point panel, enter a point with the local coordinates
in the Point field. Check and enable the Use Horizontal and Use
Vertical boxes to use this point for horizontal and/or vertical
localization.

* In the WGS84 Point panel, specify a point with global coordinates
in the Point field and select a code for this point.
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Tap the Start Meas button to use the current position or manually
add the point to the job points.

4. Repeat steps 1 and 2 to enter additional localization points.

8-4

Note the following information about localization points.

When only one localization point is available, the offsets are
computed and the system is oriented to North, and the scale is
set at height.

When two localization points are available, the offsets,
azimuth, and scale are computed. With three localization
points, Vertical deflection is also computed. When additional
localization points are specified, the parameters resulting in
the least errors will be computed.

The localization is updated (recomputed) every time a new
point (local and WGS84 coordinates) is added to the list of
localization points.

The value of the residuals specify the level of reliability for
each localization point. The residuals are along horizontal or
vertical axes. The control columns display the status of the
point, either used or not used. Select the line and tap H
Control or V Control to change the status.

To view the parameters of the localization, tap the Details
button on the Localization screen (Figure 8-1 on page 8-3).

The Localization details screen displays (Figure 8-3 on
page 8-5).

The new coordinate system will be saved under the name
“Localization” and is automatically selected when the Close
button is tapped (Figure 8-3 on page 8-5), if one or more
localization points are specified. On the Map, the localization
points will be marked by blue triangles.
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ELucalizatiun details Close ]
Results | Map
Projection Name
None
Geodetic Origin ~
Lat N 55.51181
Lon E 37.30577.
Ht 191.656 1
Local Origin
MNorth 24391.26
East 7610.194
Ht 129.351 1
Scale 1.000103¢ ..
£ b3

Figure 8-3. Localization Details
7. To configure the modem, select the Config Radio option from
the Help Icon menu in the upper-left corner of the screen.

8. To edit the job points, select the Edit Points option from the
bitmap menu in the upper-left corner of the screen.

If a localization point is edited, a Warning! screen
displays. TopSURYV gives you the option to
recompute now or later.

oo |

Localization parameters changed.
Recompute now?
(press no to recompute later)

Figure 8-4. Recompute the Localization?
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0.

To export the localization data to available data formats (Pocket
3D GC3 and TDS Raw Data), select the Export To File option
from the bitmap menu in the upper left corner of the screen.

The name of localization in the GC3 format will be set to the
current job name. After importing such a file into a new job, the
coordinate system will be saved under the name of the job
where the GC3 file was created.

Starting the Base

Connect the controller to the Base Receiver. Switch on the
devices.

Select the Setup GPS » Start Base icons. On the Start Base
screen, set the following information, then tap Start Base to
transmit coordinates to the receiver (Figure 8-5):

N — s (&

o HE H v g

2201 3200 {0+

Setup GPS Start Base Point a1
BE(IEN

Code I v

AntHt [1.200 m  [Slant v

Local{m}

North |—141lZI4.IZIB7
East |12113.u12
Ele¥ |33.711

Start Base

Figure 8-5. Start Base

* Enter the coordinates of base location manually, select a point
with the known coordinates, using the map or list of available
points. To enter a photo note for the point, use the [@] button
near the point name.

 Enter the code of the Base manually or select the code from
the list.
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* The current location can also be measured by tapping the
AutoPos button (the coordinates of the current point will
appear), and can be used to set the Base.

* Measure and insert the Antenna height in the corresponding
field. If the antenna has not been set up yet for the job,
specify the antenna parameters.

3. To set/change the radio parameters selected in the job
configuration, tap on the Config Radio menu item in the upper-
left corner of the screen (see “Config Radio” on page 8-8).

4. To start multiple bases, tap on the Multi Base menu item in the
upper left corner of the screen (“Multi Base” on page 8-10).

5. To get faster access to the Grid to Ground system (in the
defined system) for the Origin Point option, select the Grid to
Ground option from the Help Icon menu in the upper-left
corner of the screen. Check and enable the Apply GG Origin
Point box in the Grid to Ground Params screen to use the
calculated value of the Scale Factor at the origin point in the
job (Figure 8-6).

EGrid to Ground m Cancel
[] Apply GG Origin Point
Direction IGrid to Ground
Combined SF lm
Az Rotation W dms [Z]
l—

Orig Pt 1P1

4
Ground Pt {m)

North IlSl:llll]l]l]
East IlSl:llll]l]l]

Figure 8-6. Apply Grid to Ground Parameters

6. Tap OK. Then the Grid to Ground option in the Coordinate
System screen will be automatically selected.
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Starting Base with Autonomous Position

1. If the Base starts in autonomous mode, and an observed Topo
point has known coordinates stored in the job and has the same
name as the base, you can correct the base position.

¢ In the Duplicate Points screen, check and enable the Correct
Base box (Figure 8-7). The existing coordinates of the
observed point are not replaced by the coordinates of the
observed point. Instead, the known coordinates of this point
are used to correct the Base coordinates. For Correct Base to
work properly, the coordinate type selected in Display (see
“Display” on page 4-76) must be the same as for the known
coordinates of the observed Topo point.

After either closing the Topo screen or moving to another tab,
recomputations are performed and the coordinates of all
points are updated using the new Base coordinates.

Z o

105 Already Exists!
Offsets{m)
dN -12.024
dE 0.001
dH -0.001

Overwrite?

() store As Check Point?
Use in Weighted Average

[ ] Correct Base

Figure 8-7. Correct Base

Config Radio

Use the Config Radio menu item in the upper left corner of the Start
Base screen to set up the radio modem (The same item is accessible
from the Status, Topo, and Auto Topo screens.) Also, if necessary,
you can change the radio parameters selected in the job configuration,
and then set them to the radio modem.
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Figure 8-8 shows an example for Internal GR-3 Digital UHF radio
modem.

OK ICanl:eI
Type Internal GR-3 Digital UHF
Connected to Im
Radio Port IC—
Channel I—v
Power |1 W -
Protocol ISiranex—v
Modulation W

l Get Freq ” Set Radio l

Figure 8-8. Config GR-3 Digital UHF Radio

1. Tap the Get Freq(uency) button to set the frequency that the
radio will broadcast and / or listen to.

Channels.ccx) must be loaded (using the Modem
TPS software) before any frequencies will display
in TopSURV. Please do this BEFORE configuring
the radio.

@ A Script file with Frequency list (Pac Crest

2. For the base radio, set the signal strength that the Base will
transmit.

3. Tap the Set Radio button to set the parameters to the radio.

Configure RE-S1 Repeater

To setup the RE-S1 as a stand-alone repeater during the survey
configuration, first enable the usage of the RE-S1 radio modem as a
repeater. Then the Config RE-S1 Repeater option appears in the pop-
up menu of the Status, Start Base and Topo screens. This option
opens the Config Radio screen to set the RE-S1 as a repeater
(Figure 8-9 on page 8-10).
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ECunﬁg Radio OK | Cancel

Radio Connected to

IRepeater

Type RE-51 Repeater

Radio Port [N
Location INurth America

Protocol IFH915 Ext
Channel I 1 v

lDiscunnect ” Connect l

Figure 8-9. RE-S1 Repeater Configuration

Select the radio port that connects with the receiver or
controller, the territory (North America, Australia or New
Zealand) where the RE-S1 is used, and the operating frequency
channel.

Tap the Connect button to open a daisy chain and send
commands to setup the RE-S1 radio as a repeater.

Tap the Disconnect button to turn the RE-S1 modem off.

Multi Base

The Multi Base function in TopSURYV is implemented using the Time
Division Multiple Access (TDMA) mode of transmission. This means
that one Base can transmit at the beginning of the second and another
Base can transmit a half second later on the same frequency. The
Rover can recognize the two separate data streams.

1.

To create a job, configure the RTK survey and set all necessary

settings.

To set up Base 1, connect the controller to the receiver at Base

1. Tap Survey » Start Base. The Multi Base screen displays

(Figure 8-10 on page 8-11).

* Select Multi Base from the menu in the upper-left corner of
the Start Base screen. Then select the Base Station ID and
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Transmit Delay. For example, select 11 as the Base Station ID
and select 30 msec for the Transmit Delay (Figure 8-10).

Base Station ID |m v
Transmit Delay IBIII ¥ | msec

Use Multi Base

Figure 8-10. Multi Base

With transmission delays, the bases are allowed to broadcast
multiple RTK data on the same frequency.

 Tap the Start Base button. Base 1 will transmit as ID 11 at 30
milliseconds after the second. It will output RTK data at a
transmission rate of 1 second. Disconnect from Base 1.

3. Setup Base 2: connect the controller to the receiver at Base 2.

» Setup of Base 2 is the same process as for Base 1 but a
different ID and transmission time must be selected for Base
2, for example 12. Recommended time delay for Base 2 is
530 msec.

* Tap the Start Base button. Base 2 will transmit as ID 12 at
530 milliseconds after the second or 1/2 second after Base 1.
Base 2 will also output RTK data at transmission rate of 1
second. Disconnect from Base 2.

4. Note that both transmitters need to be set to transmit at the
same frequency and they must transmit in a CMR+ format.

5. At the Rover, connect the controller to the Rover receiver. If the
rover receives CMR+ corrections from more than one base,
there will be an additional tab in the Survey/Status menu
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called Mult-Base, which is a table with information about the
Base Stations the Rover receiver is listening to (Figure 8-11).

£ R v | o |
Pos | 5ys | Mult-8
Use | 1D | Base | Age | L
1] Basel01 1

< 4

Figure 8-11. Multi Base tab

* Check which base to use. Currently, TopSURV only supports
processing RTK baselines from one base at a time.

» After the Topo screen is opened, the receiver connected to the
controller will be configured as the Rover.

6. For a newly created job, the bases remain active for another job.
It is not necessary to reconnect to the bases and restart them. On
the Rover side only, open the Status screen and select the base
with which to work.

mmGPS+ Options

To set the mmGPS+ options in mmGPS+ aided RTK survey, select
the mmGPS+ Options item from the Help Icon menu in the upper-left
corner of the Status, Start Base, and Topo screens.

On the mmGPS+ Opts screen, do the following (Figure 8-12 on

page 8-13):

* mmGPS+ is DISABLED - select “Turn mmGPS+ ON” from the
drop-down list to enable mmGPS+ height computation.

» Use weighted and height computations — check and enable to
combine mmGPS elevations and GPS elevations. When selected,
this option forces the receiver/sensor to always consider the angle

8-12
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and distance when determining the elevation, then combines the
two elevations accordingly. This option works well at large
distances (300m) and steep angles.

» Height Difference Limit — Set the threshold for the difference
between GPS and mmGPS+ height measurements.

EmmGPS+ Opts PNelY lCanl:eI

mmGP5+ is DISABLED

|Tum mmGP5+ ON v

Use weighted height!

romputations

Height Difference Limit

ID.BDD m

Figure 8-12. mmGPS+ Options

Initializing mmGPS+

Before beginning the setup for a mmGPS+ system, configure the
mmGPS+ aided survey (see “Creating a GPS+ Configuration” on
page 4-3).

The setup process of a mmGPS+ system includes calibration of the
laser transmitter and initialization of the sensor.

Transmitter Calibration

The laser transmitter is the vertical grade control reference for the
jobsite. The following procedure will calibrate the transmitter with
the correct channel and communication port, as well as set up the
transmitter’s height and locate it at the jobsite.

1. Connect the controller and transmitter.

2. Tap Survey » Init mmGPS+. The Init mmGPS+ screen
displays (Figure 8-13 on page 8-14).
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3. On the (Trans) Data tab, select the ID that corresponds to the
channel of the transmitter, then tap Add (Figure 8-13). The
Transmitter screen displays.

Pt s I ]
Data | pos |Sensur
Name 1D Data
2
3
4
[ Add ] [ Edit ] [Delete]

Figure 8-13. Initialize mmGPS — (Trans) Data Tab

4. On the Transmitter screen (Figure 8-14), enter a Name for the
transmitter (usually the serial number), select the Com Port for
the transmitter (usually COM1), then tap the Get Data button
(Figure 8-14).

ETransmitter m Cancel
Name E|

Com Port |COM1 -
D NfA
Calibration Data NfA

Firmware Version NfA

Clear Data l l Get Data

Figure 8-14. Enter and Get Transmitter Data

5. Once TopSURYV retrieves the transmitter’s data, close the setup
successful screen. Then tap OK.
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6. On the (Trans) Pos tab, select the desired transmitter. Tap Edit
to enter the transmitter’s position (Figure 8-15).

Elnit mmGPS+ m Cancel |

Data | Pos | Sensor

Figure 8-15. init mmGPS -Trans Tab

7. On the Init mmGPS+ screen, enter the following information
and tap OK (Figure 8-16 on page 8-16):

» Using the map, select the point the transmitter is installed
OVer.

 Enter the height of the transmitter using one of the following:

— Enter the Ht measurement from the ground to the mark on
the transmitter’s side and the m method as slant.

— Check and enable the 2m Fixed Tripod box if using a 2
meter fixed tripod.
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A Il ok |cancel|

Point [TR

Transmitter

Name 21

D 1

Ht 1303 m  [slant v

[]2m Fixed Tripod

Figure 8-16. Enter Transmitter’s Position

8. Unplug the controller from the transmitter. Continue with the
following section to initialize the sensor.

Sensor Initialization

The initialization process will upload transmitter calibration
information to the sensor connected with the receiver, as well as set
up the sensor for receiving the transmitter’s laser beam.

Connect the controller and GPS receiver.

2. Select the Sensor tab and enter the following information
(Figure 8-17 on page 8-17):

¢ Select the Receiver Port that connects the receiver and sensor,
usually port D.

* Select the Transmitter ID, usually ANY. The ANY selection
will allow the sensor to independently select the transmitter
with the smallest error rate.

* Select Auto for the Sensor Gain to automatically control the
mmGPS receiver’s detection level of the transmitter’s signal.

8-16
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* Check and enable the Init Time Improvement box to improve
the RTK fix time for the receiver.

Elnit mmGPS+ m Cancel
Data|P|:|s Sensor

Receiver Port

i

Transmitter ID

IANY v

Sensor Gain

IAutl:l v

Figure 8-17. Init mmGPS — Sensor Tab

3. Tap the Init Sensor button to start the initialization process.

4. When the initialization completes, tap Close on the setup
successful confirmation screen.

In the event that a point has been lost, the resection operation can
measure an unknown point. The self-levelling mechanism may also
need to be measured and the transmitter calibrated to ensure correct
grade. For details on these mmGPS operations, see Appendix A.

When using mmGPS+, include the height of the
@ PZS-1 sensor with a 5/8 inch plug into the rover
antenna height.

P/N 7010-0493 817



Surveying with TopSURV

Performing a Topo Survey

1.

Tap Survey » Topo. On the Topo screen (Figure 8-18), enter
the Point name, enter a photo note using the button if
necessary, select a Code and enter the Ant Ht and select a height
type from the drop-down list.

» aNry - e
ST | b | [# Topo |pata| Man | offsets)

Survey Taopo

=1 @ill]
o il Eixed H

0% 2201 3200 10+ 3
[@] Point [T “— | SE
E¥ code |A )

Photo note

v
= button
Ant Ht |2.IZIIIIIZI m
I\."ertil:al v

Epoch Count 1]

Figure 8-18. Topo

Use the Config Radio menu item in the upper left corner of the
screen to set and/or change the parameters to the radio modem.
(For details, refer to “Config Radio” on page 8-8.)

When in DGPS survey mode using OmniSTAR differential
corrections, select the Config OmniSTAR item from the bitmap
menu in the upper-left corner of the screen to start the
OmniSTAR service (“OmniSTAR Status” on page 8-21).

When in DGPS survey mode using Beacon differential
corrections, select the Config Beacon item from the bitmap
menu in the upper-left corner of the screen to start the Beacon
service (“Beacon Status” on page 8-22). If using the differential
corrections receiver BR-1, select the Config BR-1 item from the
bitmap menu in the upper-left corner to configure the Beacon
receiver (“Config BR-1" on page 8-23).

Tap the Settings button to change the survey parameters
settings to desired values.
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6. If the location of the point to be observed is unreachable, set
offset parameters using a simple offset or offsets from a line.
Tap the Offsets tab (Figure 8-19).

* For simple offset use, tap the Az Dis Ht button, enter the
name and Code of the offset point, and insert the angle
parameter (Azimuth or Bearing), the height parameter (zenith
distance, elevation angle or vertical distance) and the
horizontal distance. Toggling between angle or height
parameters is performed by tapping the corresponding button.
tap Store to save the offset point.

* For line offset use, tap the Line button, enter the names of
two points comprising the reference line, specify the direction
of the line and enter the parameters of the offset point: Name,
Code, the distance along the line of sight between the second
point and the projection of the offset point on the reference
line, the distance from the reference line to the offset point
along the projection, and the height of the point. tap Store to
save the point; several offset points can be saved using one
line.

* For laser offset use, tap the Laser button, which is available
when a laser distance meter has been added in the Config
Survey.

[WIW Offsets l_

]
b Cacosn

Figure 8-19. Topo — Offsets
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7. Tap Start on the Topo tab to start the survey (Figure 8-18 on
page 8-18). When using a mmGPS system, the Topo tab
displays a mmGPS icon | %] . This icon also displays when the
receiver calculates mmGPS heights.

8. In the survey for post processing, begin logging files to the
receiver: tap the Start Log button. To stop logging, tap the
same button (during the logging process, this button says Stop

Log, and the symbol located in the icon bar on the place of

Status icon in the RTK mode becomes: @ ).

9. View the Data tab for details on the last point stored.

10. Use the Map tab to view a plot of the point with respect to other
stored objects. If necessary, select the Grid Setup option from
the pop-up menu on the top left corner of the screen to setup a
grid to be displayed with the Map.

11. If a topo point is observed a second time and named with the
identical name, a prompt will ask to Override, Rename, or Store
as Weighted Average point. Multiple WA points can be stored
and the results can be viewed in the Edit Points screen. The Use
in WA button makes weighted averages of topo points.
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OmniSTAR Status

To view the status of the OmniSTAR service for DGPS survey type,
select the Config OmniSTAR item from the Help Icon menu in the
upper-left corner of the Topo screen. The same item is accessible
from the Status and Auto Topo screens.

1. Select the OmniSTAR satellite from which to receive
differential correction data (Figure 8-20).

o o

Satellite
[EA_SAT Lon 25E v

OmniSTAR SN 200153
Subscription 11/29{2007

Figure 8-20. Config OmniSTAR

2. Tap Status to view the status of the link to the OmniSTAR
satellite selected (Figure 8-21).

X omnisTar [ Close

Satellite
[EA_SAT Lon 25E v

OmniSTAR SN 200969
Subscription  11f29/2007

Version HP 4.10
Frequency 1535.2 MHz

SV Lock Locked i,
Eak LU N 47 N~

< >

Set Satellite

Figure 8-21. OmniSTAR HP Status
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Beacon Status

To view the status of the Beacon service for DGPS survey type, select
the Config Beacon item from the Help Icon menu in the upper-left
corner of the Topo screen. The same item is accessible from the
Status and Auto Topo screens. The Beacon screen displays (Figure 8-
22).

1. Select the country where the radio-beacon differential service is
located and the station that broadcasts differential corrections
for the Rover receiver.

EBeacun m Cancel

Country v
Station |ACUSHNET, MA v

Status

Figure 8-22. Configure Beacon Status

2. Tap Status to view the status of the link to the radio-beacon. On
the Beacon Status screen, the following information is shown,
if applicable: the name of station, the Beacon board version, the
broadcasting frequency, and signal-to-noise ratio (Figure 8-23
on page 8-23).
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EBeacun Status Close

Station ACUSHNET, MA

Version NfA
Frequency NfA
Signal Quality  NfA

Figure 8-23. Beacon Status

Config BR-1

When using the Beacon receiver BR-1 in DGPS survey configuration,
select the Config BR-1 item from the Help Icon menu in the upper left
corner of the Topo screen to configure the BR-1. The same item is
accessible from the Status and Auto Topo screens.

1. Tap the Config button to send the appropriate configuration
command for BR-1 radio channels (Figure 8-24 on page 8-24):

¢ When Automatic Scan mode is on, all four channels of the
BR-1 will automatically scan frequencies until one of the
channels find the available Beacon Signal. After the signal is
found, the channel will keep this frequency.

* When Automatic Scan mode is off, the frequency and data
transfer rate of the known Station selected will only be set to
channel ‘a’ of the BR-1 receiver. The other channels will not
work.
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EBeacun OK | Cancel

Country |USA

Station [ACUSHNET, MA

Automatic Scan Mode

Figure 8-24. BR-1 Configuration

Performing an Auto Topo Survey

1. Tap Survey » Auto Topo. On the Auto Topo screen, enter the

point name, select the Code if necessary and insert the Antenna
height and height type (Figure 8-25).

> 3 A7 TR settinas | cios |
| —> | O
Survey Auto Topo -

-II Fied H v gg
2201 3200 10+3

[@] Point |5112 -
@Cude IG
o
Ant Ht |2-UUU m
I\."ertil:al v

Figure 8-25. Auto Topo

2. Use the Config Radio menu item in the upper-left corner of the

screen to set and/or change the parameters to the radio modem.
(For details, refer to “Config Radio” on page 8-8.)

8-24 TopSURYV User’s Manual



Performing GPS+ Surveys

3. When in DGPS survey mode using OmniSTAR differential
corrections, select the Config OmniSTAR item from the bitmap
menu in the upper-left corner of the screen to start the
OmniSTAR service (“OmniSTAR Status” on page 8-21).

4. When in DGPS survey mode using Beacon differential
corrections, select the Config Beacon item from the bitmap
menu in the upper-left corner of the screen to start the Beacon
service (“Beacon Status” on page 8-22). If using the differential
corrections receiver BR-1, select the Config BR-1 item from the
bitmap menu in the upper left corner to configure the Beacon
receiver (“Config BR-1" on page 8-23).

5. Tap the Settings button, select the parameters for data logging,
and tap OK: the solution type solution for automatic data
logging while moving and the interval between measurements
(meters or seconds). To return to default values, tap Defaults.

6. Tap Start on the Auto Topo tab and begin moving. When using
a mmGPS system, the Auto Topo tab displays a mmGPS icon

[5]. This icon displays when the receiver calculates mmGPS
heights.

To interrupt the process of survey, tap the Pause button.

8. To override the interval Survey parameter temporarily and log
the current location, tap Log Now button.

9. In PP Kinematic and PP DGPS surveys, begin logging files to
the receiver: tap the Start Log button. To stop logging, tap the
same button (during logging, the button changes to “Stop Log”,

and the symbol located in the icon bar changes to @).

10. Open the Data tab to view details of the last point stored.

11. Open the Map tab to see a plot of the point with respect to other
stored objects.

12. If necessary, set up a grid displayed with the map using the
Grid Setup option from the Help Icon menu in the upper left
corner of the screen.

13. If the receiver switches base stations when recording real time
data, a warning message displays.
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Known Point Initialization

The “Known Point Initialization”method of initialization is
performed when the rover occupies a known point as a faster step in a
kinematic survey to initialize the fixed solutions. To start working, tap
Setup GPS » Known Point Init.

1. Inthe Known Point Init screen (Figure 8-26), select the known
point and set the antenna parameters of the station.

EKnuwn Point Init . Close

Point  [101

Setup GPS Knowen PE Init

E4'Be
WGS584(m)

Lat I55.3206376 15
Lon I37.36396l]l] 14
Ell ht 150.015

AntHt [2.000 m  [Vertic v

Figure 8-26. Known Point Initialization Screen

2. To start initialization, tap the Initialize button (Figure 8-26).
The KPI Position screen displays the status information on
Rover initialization (Figure 8-27).

EXdke1 position [ Close

& 134 13 UTC 13:31:16
Fixed
Residuals{m)

North -847.258

East 0.002

Elev  0.000

<% ppop 1.8

H 2201 Vv 3.200 m

KPR Status Initialized

Figure 8-27. KPI Position Screen

8-26 TopSURYV User’s Manual



Performing GPS+ Surveys

Cross-Section

A cross-section survey is performed to obtain the coordinates of
points that lie on a plane perpendicular to a center line. It is typically
performed by moving from one side of the road to the other in the
cross-sectional plane, and then crossing back in the opposite direction
at a different location along the road. This process is repeated at
different stations along the centerline, until all the desired cross-
sectional points have been observed.

1. To start working, tap Survey » X-Section.

2. On the Cross Section screen, set the parameters of the station
where the cross-section survey is to be performed: the road
name, the code and attributes of the center line, the station
where the cross section is surveyed and the increment of
distance towards the next station (Figure 8-28). Tap OK.

The Station and Interval fields appear only if the
road is selected.

»

y . 1

7_. [

Survey ¥-Section g T
E¥ Code Iz—v

Station Il]+l]l].l]l] USft
Interval |32B.l333 usft

Figure 8-28. Cross Section

3. On the X-Sect screen (Figure 8-29 on page 8-28) perform the
usual observation work relative to the cross-section, as
described in “Performing a Topo Survey” on page 8-18.
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Cross-sectional points at the same station should have different
codes, with at least one of them having the centerline code. For
example, codes for cross-sectional points could be A, B, C, cl, D,
E, F in the order of survey.

Tap the Close button to automatically change the station number.
Also, the application automatically uses the same codes but in the
opposite order for the next station (F, E, D, cl, C, B, A). The
station and the codes can be changed.

X x-sect [ settings | close |
#7 X-Sect |pata | Map

o HE H

v gtgh
7222 10500 10+ 3

[®] point [i01

¥ code |
Ant Ht |6.562 USft
I\."ertil:al

Epoch Count 1]

Along CL
Offset 47300.«

Cancel

Figure 8-29. Cross-Section Accept

Find Station/Chainage

The Find Station task is used for the identification of the station by
computing the distance from the beginning of the road to the
projection of the station to the road, and the offset of the station from
the center line of the road.

1. To start working, select the Survey » Find Station icons
(Figure 8-30 on page 8-29).

2. Enter the road, the name, and the code of the point and the
antenna height and type (Figure 8-30 on page 8-29).

3. To compute the result with an existing point, tap the Pt Sta
button (Figure 8-30 on page 8-29).
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4. To compute the result with the coordinates of the current
location without making an observation, tap the Curr Sta
button (Figure 8-30).

5. To make an observation of the current location and store the
coordinates to a point, and to compute the result with this point,
tap the Start button (Figure 8-30).

B [ na staton EXTS R
o Find Station m
¢ HEE H

v gt
7222 10500 10+ 3

T T—

[E]
[®] Point  [101

E¥ code I[p v
Ant Ht |6.562 usft I\-"ertic& -

Epoch Count O

Survey Find Station

Figure 8-30. Find Station.

Tape Dimension

Using the Tape Dimension task, calculate the periphery of structures,
such as buildings that have features perpendicular to each other. This
is done using tape measurements, relative to the two known points
that belong to one side of the structure (wall of the building), forming
the so called reference line.

1. To start working, tap Survey » Tape Dimension (Figure 8-31
on page 8-30).

2. On the Ref Line tab, enter the information about the two points
that comprise the reference line: the names and codes. If the
reference line points are to be observed, tap the Meas button in
the corresponding fields (Figure 8-31 on page 8-30).
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> —

Suryey

‘B ETape Dimension ..
o~ Ref Line | Tape Dim | Data | Map

Tape Dim, Start Pt

@ Code

End Pt

End Point

@ Code

Start Point [100

R NED
=2

A

101

A

Figure 8-31. Tape Dimension — Ref Line Tab

3. On the Tape Dim tab, set the parameters for performing the
survey: the name and code of the surveyed point, and the
direction (left or right of the previous line) and the distance of

the movement from the previous point (Figure 8-32).

ETape Dimension

[@] Point [TiE
@ Code A v

q 103

=

104
=100 m

| | Dist Left
[0-000

(e [

Figure 8-32. Tape Dimension — Tape Dim Tab

4. To apply the taped distance to the perimeter line, tap the Accept

button.

5. Close the Tape Dimension work in either of two ways:
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* To connect the first and the last point with a line, tap Finish
and select the Close Polygon item from the drop-down menu
(Figure 8-32 on page 8-30).

* To calculate the difference between the last and the first point,
tap Finish, then select the Calc Closure item from the menu
(Figure 8-32 on page 8-30).

Performing a Static Survey

1. To open the Static Occupation screen (Figure 8-33), choose the
PP Static configuration in the Survey Config screen (use the
Configure icon) and tap Setup GPS » Static Occupation
(Figure 8-33).

)
T s} 2.5'01 3.300 §+‘§
Static Occup. Point IF
Code |5'3 et

AntHt [1.000 m  [Slant v

Duration 0:00:00

Start Occ

Figure 8-33. Static Occupation Screen

2. Enter the parameters of the occupation point: name, code and
antenna height and height type.

3. Tap Start Occ. The survey will start, and the Duration field
displays the time passed, since the beginning of survey.

4. To stop the survey, tap the same button (when taped, it changes
(toggles) to Stop Occ).
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Performing Total Station
Surveys

After completing preliminary work (that is, the instrument is plumbed
above the reference point and the controller is connected to a modem
(for Robotic Surveys) or to the total station), the survey can begin.

First, set one or more backsight points to be used for the survey. Then
choose a task to perform: sideshot (single or multiple) survey, cross-
section survey, finding station, tape dimension measurement, or
missing line determination. In the case of Robotic Survey, the auto
topo task is also available. The remote control function should be set
before performing a Robotic survey.

In the case of Contractor Mode, it is possible to perform only
Sideshot-Direct measurements with conventional and reflectorless
total stations.

Backsight Setup
1. Tap Setup » Backsight (Figure 8-34 on page 8-33). The BS
Survey screen displays.
2. Onthe BS Survey screen, set the following backsight
parameters (Figure 8-34 on page 8-33):
* Choose the Occ Point (occupation point) using one of these
methods:
— enter the name manually
— select the point from the map

— select the point from the list of fixed or job points, or

— calculate the occupation point coordinates using the
coordinates of known points with the side shot method.
The elevation can be computed using the known
elevations of the other points.

* Set the height of the instrument (HI) and the height of the
reflector (HR), choose the backsight point/backsight azimuth (or
enter multiple backsight points using the floating menu on the
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bitmap in the corresponding field) and check if the distance to the
backsight should be measured and if the height of the backsight
point rod is fixed (Figure 8-34).

/F\ _> . BS 5 . i .
Setup Backsight oce Point IOCC—
OB
([l HI [1-200 m
[ we LSO
> T
%9 Bs Circle |u.uuuu =i
[]Measure dist to BS
[[]Turn To BS
[ ]Fixed HR at BS
Check BS HC Set

Figure 8-34. Backsight Survey

3. To measure the angle position of the backsight point, tap the
Meas BS button.

4. To check the quality of the chosen backsight point, tap the
Check BS button. The screen displays the residuals of the
current backsight point (Figure 8-35). Tap Close.

Close ]

BS Setup | Data |Map

[M1, HI 1.000m
|101, Az 95.0000dms

HD Error

VD Error

HA Error 0.0000 dms

BS Azimuth  95.0000 dms

HA 60.0000 dms

VA 90.0000 dms

5D

HR 0.000 m

< >

Figure 8-35. Check Backsight
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5. To adjust the horizontal circle of the total station, tap the HC
Set button (Figure 8-34). Using the Backsight HC screen, set
the horizontal circle reading that corresponds to the backsight
point direction. Enter the value manually or choose the value of
the horizontal circle using the menu on the bitmap in the BS
Circle field.

6. Tap OK to store settings.

Note that when moving to the next occupation, the previous
occupation point becomes a backsight point by default.

Sideshot Setup

Once the backsight point is set, make a single sideshot.

1. Tap Survey » Topo (Figure 8-36). Select the Sideshot Dir
measurement method and set the order and the type of the
measurements in a set.

2. On the Sideshot-Dir screen, enter the point name, code, and the
height of the target.

7 T e [ o |

y 4
’ —> | # Meas |Data | Map | Offsets

S

urvey e [®] point W
@ Code Ipm w g@ g
[ vR  [2.000 m

HA 230.0005,VA 90.1003,5D
800.005 {dms,m)

Measure Foresight Direct
[] Traverse Point

Figure 8-36. Sideshot-Direct

3. Set the backsight point, if that has not been done before. Tap the
BS Setup button and follow the instructions in “Backsight

Setup” on page 8-32.
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4. Check and enable the Traverse Point box to tag the point as
Traverse. The Traverse Points for the Measurement are stored
in the Traverse Point List.

5. To select next occupation point, select the Adv entry from the
menu on the bitmap in the upper-left corner. Once the next
occupation point is selected from the traverse point list, the
controller automatically sets the current occupation point as the
backsight and the selected traverse point as the next occupation
point. If only one point is tagged as a traverse point, then this
point is automatically chosen as the next occupation point and
the current point is selected as the backsight (when the Adv
(advance) menu is selected).

6. To perform the sideshot, tap the Meas button (Figure 8-36 on
page 8-34).

7. 1If a point location is unreachable, set offset parameters using
the Offsets tab. For details on these settings, refer to the
TopSURYV Reference Manual.

* Hz Angle — defines a point using the horizontal angle from
one point and the distance to another.

* Hz-Vt Angle — defines a point using the horizontal and
vertical angles.

* Dist. Offset — defines a point giving from which to add or
subtract distances horizontally and vertically.

* Hidden Point — defines a point on the ground surface, with a
slanted rod touching the ground point. The rod has two
targets.

* 2 Line ISection — determines a point by the intersection of the
two lines. Each line is defined by two points or two
measurements.

* Line & Corner — determines a point on the corner using one
line defined by two points.

* Line & Offset — determines a point distant from a line defined
by two points.
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* Plane & Corner — determines a point (Corner) by a plane
defined by three points and an angle measurement.

Measuring Sideshot Sets

If the measurement method is Sideshot-Direct/Reverse (performed
using the (SS-Dir/Rev) Sideshot-Direct/Reverse screen,

(Figure 8-37), a set of sideshots can be measured once the backsight
has been setup.

The measurement to a single point is taken using the Direct Position
and the Reverse Position of the Total Station (that is, Plunge (flip).
Rotate the Total station by 180 degrees to get the reverse
measurement.

For instance, if the Total Station Measurements in Direct Position are
HA =70, VA =60, SD =143.23m, then the reverse measurements,
without any errors would be HA 250(=70+180), VA 300(=360-60),
SD=143.23m. One set consists of one direct and one reverse
measurement. These measurements are used to eliminate the Vertical
circle centering errors.

ESS—D"IREV Settings I Close .
[ #* Meas ] Data | Map | Set l
point  |R[R..|R.] HR]|
5 occpt2 2.... 1
5 occpt2 2.... 230
< >
I Remove ] I Re-Meas ” Accept ]

Figure 8-37. Sideshot-Direct/Reverse

1. If necessary, change the measurement mode. Tap the Settings
button, and select the mode in Meas Method.

2. Perform the sideshot survey as described in “Sideshot Setup”
on page 8-34, taking any measurements necessary.
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3. Move to the next point and repeat these steps. The last recorded
measurement is displayed on the Data tab.

4. If a point location is unreachable, set offset parameters as
described above.

Angle/Distance Sets

If the measurement mode is Ang/Dist Sets-Dir/Rev (performed using
the Ang/Dist Sets-Dir/Rev screen, (Figure 8-38)), the instrument uses
the specified Angle sequence to perform repeated measurements. A
sequence of four measurements constitutes one set. One example
sequence is:

¢ (1) the measurement of the sideshot in direct face
* (2) then the measurement of the backsight in direct face
* (3) then the measurement of the backsight in reverse face

* (4) finally the measurement of the sideshot in reverse face

Settingsl Close ]
# Meas |Data | Map | Set

(@] Point [101

£ Code [a v 108s
KR - 000] m

Measure Backsight Direct
[] Traverse Point

Figure 8-38. Ang/Dist Sets-Dir/Rev

1. To change the measurement mode, tap Settings »
Meas Method and pick the desired mode.

2. Perform the sideshot survey as described in “Sideshot Setup”
on page 8-34, taking any measurements necessary.

3. The last recorded measurement is displayed on the Data tab.
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4. If a point location is unreachable, set offset parameters as
described above.

Resection

The coordinates of the unknown point at which the total station is set
can be calculated by resection when the number of points of a known
position are observed.

The location by resection can be performed when a minimum of two
points of known coordinates are observed.

1. Add the points of known coordinates to the Point List.

2. Tap Setup » Resection (Figure 8-39). This function is also
available from the Backsight Survey screen. Tap
Setup » Backsight, then tap the menu icon next to the Map
icon in the Occ. Point field and select the Resection item
(Figure 8-34 on page 8-33).

3. Set the name of the occupation point, the heights of the
instrument and the target. Tap Next.

N [fF]

- X ' Occ Point |5 occpt
Setup Resectiaon — -
[ H [t000 m
[f] He 2.oooji)

Next >

Figure 8-39. Occupation Point
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4. On the Resection 3D screen (Figure 8-40), select the point of
known coordinates from the map or from the list.

Settingsl Close ]
@ point [t

1©8S
@ Code l—

[fl e [2-000 m

HA 0.0000,¥A 90.3000,5D
500.000 {dms,m}

Measure Foresight Direct

Figure 8-40. Resection

5. Select the Options item from the Help Icon menu in the upper-
left corner of the Resection 3D screen. In the Resection
Options screen (Figure 8-41), choose whether to calculate the
height (3-D) or just the horizontal coordinates (2-D). The 2D/
3D option is retained between sessions to do a new resection

with the previously used setting.

Resectiun Options 0K lCanl:eI

o

Resection Type

Figure 8-41. Resection Options
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0.

Aim the instrument at the point and enter the reflector height.
Then tap the Meas button to take the sideshot to the point.

Repeat the procedure for the remaining known points.

Open the Meas tab. On the Resection 3D screen, tap the Accept
button (Figure 8-42). The coordinates of unknown points will
be calculated.

|

EResectiun ki Settings | Close

[ #* Meas ] Data | Map | Set l
Point | ResHA| Reswvall
1 0.0001 0.0000
2 -0.0000 -0.0000
3 -0.0000  0.0000

<
sdN  0.0007
sdE  0.0009
SdH  0.0044 Re-Meas

Ground to Grid scale Remove
0.9999985

Accept

Use Ctrl

IIII v

Figure 8-42. Set Tab

In the screen that displays, enter the name of the calculated
point and tap OK. The point will be added to the Point List.

Remote Benchmarks

The elevation or height of the point at which the instrument is set can
be calculated when two or more points of known coordinates are

observed.

1. Add the points of known coordinates to the Point List.

2. Tap Setup » Remote BM. This function is also available from
the Backsight Survey screen. Select the Setup » Backsight
icons, then tap the icon menu next to the Map icon in the Occ.
Point field and select the Elevation item (Figure 8-34 on
page 8-33).

3. On the Known Elev screen (Figure 8-43 on page 8-41), select

the point of known coordinates from the map or from the list.
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/i\ —

]
£1

Remote BM

v cov TR KN

# Meas |Data | Map | Set

@[ fa

1o8s
@ Code I

[fl e [2-000 m

HA 230.0005,VA 90.1003,5D
800.005 {dms,m)

Measure Foresight Direct

Figure 8-43. Unknown Elevation Screen

4. Aim the instrument at the point and enter the height of the rod
(target). Tap the Meas button to take the sideshot to the point.

5. Repeat the procedure for the remaining known points.

6. Open the Meas tab. In the Known Eley screen (Figure 8-44),
tap the Accept button. The vertical coordinate of unknown

points will be calculated.

EKnuwn Elev Settingsl Close ]
#* Meas | Data | Map | Set l

Point

| Res va | Res Ht |

2
4

<

0.0001 0.002
-0.0000 -0.001
-0.0001 -0.003

>

[ Remove | | Re-Meas || accept |

Figure 8-44. Calculate Vertical Coordinates for Unknown Points

7. 1In the Store Point screen that displays, enter the name of the
point and tap OK.
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Remote Control

If the survey process is performed by one person with a robotic
instrument, the remote control is used for the transmission of the
commands from the controller to the total station. The radio modems
need to be set and connected to the controller and the instrument.

1. Tap Setup » Remote Control (Figure 8-45).

2. On the Remote Cntrl screen, you can make the instrument
search for the target (with the Search button), lock on the target
(with the Lock button), stop rotating (with the Stop button) and
rotate to a pre-defined angle (with the Turn button)

(Figure 8-45).

n ‘E' & ERemute Cntrl
Setup Remaote Ctrl ﬂ © g

HA:33.2511,VA:91.0543,5D:19.070
|

Qlock [search||Lock |[Turn |[stop |

Figure 8-45. Remote Control

3. Tap the Turn button. The Rotate screen displays.
Enter the following rotation angles on the Rotate screen
(Figure 8-46 on page 8-43).

* Tap the Turn button on the Rotation Angles panel to rotate
the instrument. The instrument can also be made to rotate to a
point.

* On the Rotate to Point panel, enter a point name, or choose
one from the map or a list, and tap the Turn button.

* To Plunge the instrument (rotate the telescope and the body
by 180 degrees), tap the Plunge TS button.
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All the observations can be done in the remote mode as well, if
the instrument chosen is robotic.

ERutate Close

Rotation Angles
Hz 245.1622 dms [ =]/

vert [91.0657 dms | =)/

Turn

Rotate to Point

@] roint [E

M wr  [2000 m

C@._) Plunge TS

Figure 8-46. Rotate

Cross-Section

A cross-section survey is performed to obtain the coordinates of
points that lie on a plane perpendicular to a center line. This type of
survey is typically performed by moving from one side of a road to
the other in the cross-sectional plane, and then crossing back in the
opposite direction at a different location along the road. This process
is repeated at different stations along the centerline, until all the
desired cross-sectional points have been observed.

1. To start working, tap Survey » X-Section (Figure 8-47 on
page 8-44).

2. On the Cross Section screen (Figure 8-47 on page 8-44), select
or enter the following parameters for the station where the
survey will be performed, then tap OK: the road name, the code
and attributes of the center line, the station where the cross
section is surveyed, and the interval distance to the next station.
If the road has not been created, define the plane.
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1’\ @ ECmss section [ Q) [l

Survey X-Section i g Imad
@ Code Iﬂ—v

Station IIII+IIIIZI.IIIIZI m
Interval Ill:ll:l.l:ll:ll:l m

Figure 8-47. Cross Section

The Station and Interval fields appear only if the
road is selected.

3. Inthe XSect-Dir screen (Figure 8-48 on page 8-45) perform the
usual observation work, relative to the cross-section, as
described in “Measuring Sideshot Sets” on page 8-36. The only
difference lies in the presence of the Cur Stn button, which
makes the measurement, but unlike the Meas button does not
store the point (Figure 8-48 on page 8-45).

4. Cross-sectional points at the same station should have different
codes, with at least one of them having the centerline code. For
example codes for cross-sectional points could be A, B, C, ¢,
D, E, F, in the order of survey. After the Close button is tapped,
the station number automatically changes. Also, the application
automatically uses the same codes, but in the opposite order for
the next station (£, E, D, cl, C, B, A). The station and the codes
can be changed.
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EXSect—Dir Settingsl Close ]
## Meas |Data | Map

[®] point [TH
EY Code | v 1EBE

[f] vr  [2.000 m

i

Measure Foresight Direct
[] Traverse Point

Figure 8-48. XSect-Direct

Find Station

The Find Station task is used for the identification of the station by
computing the distance from the beginning of the road to the
projection of the station to the road, and the offset of the station from
the center line of the road.

1. To start working, tap Survey » Find Station (Figure 8-49).

2. If needed, set the backsight point. Tap the BS Setup button and
follow the instructions in “Backsight Setup” on page 8-32.

> > 7 TR s [ cioe
e ' . # Meas |Results | Map
Survey Find Station % |Road |Jroad

[®] point [TE
@ Code I »
flwre fRoom JOES

Measure Foresight Direct

BS P5tn

C5tn

Figure 8-49. Find Station — Measurement Tab
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3. Enter the road, the name and the code of the point and the
height of the rod (target) (Figure 8-49 on page 8-45).

4. To compute the result with an existing point, tap the Pt Stn
button.

5. To compute the result with the coordinates of the current
location, without storing the point, tap the Curr Stn button.

6. To take a sideshot and store the coordinates to a point, and
compute the result with this point, tap the Meas button.

Tape Dimension

Use the Tape Dimension task to calculate the periphery of structures
such as buildings that have features perpendicular to each other. This
is done using tape measurements, relative to the two known points
that belong to one side of the structure (wall of the building), forming
the so called reference line.

1. To start working, tap Survey » Tape Dimension (Figure 8-50).

2. On the Ref Line tab, enter the information about the two points
that comprise the reference line: the names and codes
(Figure 8-50). To observe the reference line points, tap the
Meas button in the corresponding fields.

TN
o & Ref Line | Tape Dim | Data | Map

Tape Dim. Start Pt

Start Point [100

@ Code IA

End Pt

End Point  [101
Ed &
@ Code IA

Suryey

Figure 8-50. Tape Dimension — Ref Line Tab
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3. On the Tape Dimension tab, set the parameters for performing
the survey: the name and code of the surveyed point, and the
direction (left or right of the previous line) and the distance of
the movement from the previous point (Figure 8-51).

4. To apply the taped distance to the perimeter line, tap the Accept
button.

ETape Dimension Close ]

[@] Point [TiE

@ Code A v

q 103

=

104
=100 m

| | Dist Left
[0-000

Accept Finish -

Figure 8-51. Tape Dimension — Tape Dim Tab

5. You can close the Tape Dimension work in one of two ways:

* To connect the first and the last point with a line, tap Finish
and select Close Polygon from the menu.

* To calculate the difference between the first and last point, tap
Finish and select Calc Closure from the menu.

Missing Line
The Missing Line task emulates the total station measurement from
one point to another and stores the result to the Raw Data database.

1. To start working, tap Survey » Missing Line (Figure 8-52 on
page 8-48).
2. Enter the Start and End points names and codes (Figure 8-53 on

page 8-49). To measure the point, tap the Meas button in the
corresponding field.
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\ _

Survey Mizsing Line BT (2
Start Paint [105
@ Code I
End Pt
End Point [106
@ Code I

Figure 8-52. Missing Line — Ref Line Tab

3. The Data tab displays the results of the measurements (the
measurement is performed when the Data tab is chosen). The
same result is reflected in the Raw Data screen, with the type
MIM.

Auto Topo

This function is activated only with Robotic instruments, and collects
points by Time and Distance.

1. To open the Auto Topo screen, tap Survey » Auto Topo in the
Robotic mode.

2. Enter the point name, code and the height of the rod
(Figure 8-53 on page 8-49).

3. To set the Auto Topo method and interval, tap the Settings
button and enter the desired values in the corresponding fields
in the second Mode screen.

4. Tap Finish to save the changes and return to the Auto Topo
screen.
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> o 7 TR vt [ cioe |
¥ — ) 18 Meas |pata | Man |
Survey i —
Auto Topo ﬂ@g
@ pone FEEEE |
@ Code Ipm »
[fJ vk [o-000 m

Log Now | Start

Qlock [search||Lock |[Turn |[stop |

Figure 8-53. Auto Topo
5. Tap the Start button (after tapping, the button changes to
“Stop”’) and begin moving.
6. To store the current position, tap the Log Now button.

7. To make the instrument search for the prism, tap the Search
button.

8. To lock onto the prism or “track” it, tap the Lock button.
To send the “Quicklock” or “Turn Around” command, which

will cause the Total Station to search for the RC—21, tap the
Qlock button.

10. To turn the Total Station, tap the Turn button and enter the
desired horizontal and vertical angles, or the direction point on
the Rotate screen. Tap Turn in the corresponding field to
perform the rotation (Figure 8-54 on page 8-50).

Tap Close to return to the Auto Topo screen.

11. To stop tracking the prism and take the “Standby” mode, tap
Stop.

1. RC-2 is the Remote Control System 2 for optical communications. For
instructions of how to operate the RC-2 device, consult the instruction
manual for RC-2.
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ERutate Close

Rotation Angles

Hz 245.1622 dms

vert [91.0657 dms | =)/

Turn

Rotate to Point
@] roint [E
M wr  [2000 m

C@._) Plunge TS

Figure 8-54. Rotate

Scanning

This function is activated only with Robotic and Motorized
reflectorless total stations, and can collect points with or without
using images.

1. To open the Scanning screen, tap Survey » Scanning in the
Robotic mode (Figure 8-55).

2. On the Scanning screen, select a desired scan type, either Scan
with Image or Scan w/o Image, and tap Next (Figure 8-55).

P — =

Suryey Scanning

[5can with Image -

Figure 8-55. Select Scanning Type
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the image must be captured with a calibrated, fixed

@ In order to import an image into TopSURYV to scan,
focal length camera.

Scanning with Images

On the Select Scan screen (Figure 8-56), enter the following scan
session parameters.

1. Select a name for the session from the Session drop-down list.

2. Select a previous Image from the Image drop-down list or
browse for a new one (images are stored as JPEG with file
extension *.jpg).

3. If the image exists in the Job, then the Camera information will
be automatically selected. Otherwise, select a previous Camera
from the Camera drop-down list or browse for a new one
(Cameras are stored as a text file with the extension *.cmr).

4. Once all fields are filled, click Next.

ESelect Scan Cancel

Session

| First_sesslon »

Image
| image_for_scan.JPG "

Camera

| min_focal.cmr "

Figure 8-56. Enter Scan Session Information

* Click the View button to open the Orient screen (Figure 8-57 on
page 8-52). This screen displays the image, along with orientation
and scanned points for completed scan sessions.
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ajajafem

Tap on Orientation Pt

Meas v' << Back || Next >>

Figure 8-57. View Completed Scan Session

5. Perform image orientation. On the Orientation screen
(Figure 8-58), associate a position on the image (X,y) with a
known coordinate (N,E,Z).

REENG

Tap on Orientation Pt

Meas Next ==

Figure 8-58. Perform Orientation
* The Pan button enables drag control of the image. When
disabled @ , tap on the image in the general area of where

the orientation point is located. The image will zoom to this
point and show a crosshair (Figure 8-59 on page 8-53).

8-52 TopSURYV User’s Manual



Select or meas Orient Pt

Performing Total Station Surveys

e

%l%l [Tele ~

[ Meas ]v[ << Back ] Next »»
S|

Figure 8-59. Select Orientation Point

* To view the image, select one of the two options from the
drop-down list in the bottom left corner of the screen:

— Tele (telescope) is the default zoomed-in view of the

crosshair (Figure 8-59)

— Wide View zooms out and shows the area of the image
which contains the orientation point (Figure 8-60).
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* Adjust the position of the crosshair.

— When the Arrow button is enabled |§| , use the arrow

keys on the keypad to move the crosshair up, down, left,
or right.

— Use the IE' button to move the crosshair to the center of

a circular object on the image. First tap somewhere inside
the circular object. The object should be a well-defined
circle with high contrast between the inside and outside
of the circle.

* Use the bitmap menu options (Meas, From Map, From
List) to take a measurement or to select an existing point from
a map or list.

* To delete the selected orientation points, select the points and

tap the Delete button on the Orientation Res screen
(Figure 8-61).

Eonent Res Cancel

Name ||:I)([pi... ||:IY[p... |
oriod4  -2.5 -0.5 GOOL
orio3 2.5 0.4 BAD

voriol -2.4 -0.3 GOOL
orin2 2.4 0.4 BAD

< >

MAX dX:2.5 dY:0.5 GOOD
RMS dX:2.5 dY:0.4 BAD

[ Delete I << Back ][ Next >3 ]

Figure 8-61. Delete Orientation Points

* When four or more orientation points have been established,
tap the Next button on the Orient screen (Figure 8-62 on
page 8-55) to display the orientation results.
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Meas v' << Back || Next >>

Figure 8-62. Calculate Image Orientation

6. View the image orientation results on the Orient Res screen
(Figure 8-63). The results for each Orientation Point is
displayed as dX and dY in image pixels.

EOrient Res Cancel

Name ||:I)([pi... ||:IY[p...

orind  -2.5 -0.5
oriod 2.5 0.4
oriol  -2.4 -0.3
orig2 2.4 0.4

<
MAX dX:2.5 dY:0.5 GOOD
RMS dX:2.5 dY:0.4 BAD

GOOL
BAD
GOOL
BAD

[ Delete I << Back ][ Next >3 ]

Figure 8-63. Orientation Results

» Tap Back to continue to the Scan screen to select areas for

scanning.

* To adjust the orientation calculation, select a point and tap

Delete. If four points still remain,

the new results are

displayed. If there are less than four orientation points, then
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the results screen will automatically close to continue the
orientation procedure.

7. Select one or more areas to scan, using one of the following two
methods and then begin the scan.

* Scanning method A: Draw a rectangle by tapping the stylus
on the screen for the start point and dragging to the end point.
When the stylus is lifted, the area is set.

* Scanning method B: Draw a polygon by tapping the stylus
down at each vertex. Lines will be drawn connecting each
vertex to the previous one. Tap the stylus near the first vertex
to close the area.

Scan . cel

RVR\EN)

Draw Scan Area, then press Next

[ Clear I << Back ][ Next >3 ]

Figure 8-64. Select Rectangular Scan Area

* Tap the Settings button to set the instrument to “Non-Prism”
mode, which is required for scanning and also to change the
measurement mode (Fine or Coarse).

* When the areas are set, tap Next to begin the scan. The
Interval screen displays to set the scanning settings
(Figure 8-65 on page 8-57).

* Tap Clear to erase all areas previously drawn.

8. Select a scanning interval. Enter the starting point name and the
horizontal and vertical intervals. The intervals can either be
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entered as angles (Figure 8-65) or number of points. Tap Next.
The Estimate Time screen displays (Figure 8-66).

Elnterval [ cancel

Start Pt ptl

Scan Mode IFine v
Meas Mode |Nl:|rma| NP v

interval [T~

HA 0.3000 dms
VA IIII.BIIIEIIII dms

Figure 8-65. Select Scanning Interval

View the time estimate. Before scanning begins, the scanning
information is displayed including the total number of points
to be scanned and an estimate of the time it will take to
complete the scan.

EEstimate Time Cancel

Start Pt ptl

Scan Mode Fine

Meas Mode Mormal NP

H Interval 0.2537 dms
¥ Interval 0.0209 dms
Areas 1

Points 570

Time 01:08:57

Figure 8-66. Estimate Time

9. If the estimated time is too long, click Cancel and enter larger
intervals. Finally, click Finish to begin scanning points.

10. View the scanning in progress. As the total station measures
points within the pre-defined area, each point will display on
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the image (Figure 8-67). If necessary, click Stop to stop the
scan.

Settings | Cancel

RVR\EV)

Scanning...

Figure 8-67. Scanning with Images

Scanning Without Images

1. Set the type of scan orientation and tap Next to select the scan
area on the Area screen (Figure 8-68).

Cancel

|S|:an wjio Image »

Orientation

Horizontal v
Next >

Figure 8-68. Select Orientation Type

2. Select the Scanning Area on the Area screen (Figure 8-69 on
page 8-59). The starting and ending points for the scanning area
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can be selected from the Point List or Map, or measured
(Figure 8-69). When finished, click Next.

Emea Cancel

'

=
Ptz APt3
7 ®

Select or meas Point 1

[ Meas ]v
S|

::;] Next >

Figure 8-69. Select Area

3. The same Interval and Time Estimate screens will be displayed
(Figure 8-65 on page 8-57 and Figure 8-66 on page 8-57).

4. View the scanning in progress. As the total station measures
points within the pre-defined area, each point will display on
the screen (Figure 8-70).

Scanning...

Figure 8-70. Scanning without Images

* Tap Clear to remove measured points from the screen and
return to the Area screen.
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 Tap Stop to immediately stop the scan and return to the Area
screen.
5. After scanning is completed, the screen returns to the Area
screen to set a new area for scanning. The [ icon denotes the
scanned points in the list of points.

To show scan points in the list of job points, make

@ sure the Show Scan Points item is check marked in
the pop-up menu in the upper-left corner of the
Points screen.

Monitor

The Monitor function measures one or more prisms repeatedly and
uses the measurements to detect changes in the position of the prisms.
The measurements are recorded into the raw data file.

1. Set the format and destination for the output file in the Monitor
Options screen which is accessed from the context menu in the
upper-left corner of the Configure Instrument dialog box
(Figure 8-71).

EMunitur Optior e 4 Cancel F—JdMonitor Optiurm

Log To W Log To j[COM1 v

Type [RawData v Type [Raw Data &
Format IFC—E.,‘GTT Format IFC—E,‘GTT
File Name lm

=

Comm Settings

Baud I 115200 «

Parity |NOne v
Data |8 hd
Stop |1 v

Figure 8-71. Monitor Options
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Optionally, the raw measurements or the computed points can be
output to a file or communication port in either FC-6 or
GTS-7 formats.

file or a COM port is selected. In the case of file
output, one can browse for the destination of the file
using the List [...] button.

@ The available options vary, depending on whether a

2. Add the points to be measured to a point list. The list is then
used in monitoring the survey.

3. Tap Survey » Monitor (Figure 8-72). The Monitor Pointlist
screen opens to load the desired point list (Figure 8-72).

@ — s
[&] Ppoint List [PointList1

Survey Manit =
onitor m

List of Points ~ '% .

1
42 :
gi A 8 occptl

< > =200 m
[ [»]
HR |2.uuu m

Figure 8-72. Monitor Point List

4. After the point list is selected, tap the Next button. Another
Monitor screen displays (Figure 8-73 on page 8-62).

5. Tap the Start button to initiate the sequence of measurements
which repeats at the desired interval listed as the Cycle Time.
If a prism cannot be found after a period of 15 seconds, the total
station will rotate to the next point in the sequence. If “ON” is
selected from the Auto field drop-down list, the total station
automatically rotates to the next point in the sequence and
records a measurement. If it is set to “OFF”, the total station
rotates to the point, but allows you to verify or correct the

P/N 7010-0493 8-61



Surveying with TopSURV

centering to the prism prior to taking a measurement. The
monitor function will always complete the entire sequence,
even if the measurements take longer than the cycle time.

oo TS KO0
# Remote |pata | Map
1©8s
[® point
Cycle Time Iﬁl:ll:l secs

Auto on -

HA 359.5951,VA 90.5407,5D
4.258 {dms,m)

© ® press Start when ready
L=y

Start

Qlock [search||Lock |[Turn |[stop |

Figure 8-73. Monitor

6. View the data displayed in the Data tab. The values listed are
the differences between the coordinates of the reference point
and the measured point.

Performing Level Surveys

After completing preliminary work (that is, the instrument is leveled
in a desired location above the reference point and the controller is
connected to the instrument with the cable), the survey can begin.

First, if needed, perform the Two Peg Test to check if the line of sight
of the level telescope is horizontal when the instrument is leveled.
Then perform Level Run in appropriate sideshot survey mode (single
or multiple). Refer to “Config: Survey Parameters — Level” in the
TopSURYV Reference Manual for details.

Two Peg Test

To execute the Two Peg Test, tap Survey » Two Peg Test
(Figure 8-74 on page 8-63).
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The Two Peg Test screen guides you through a series of
measurements to help determine any errors.

1. First, take shots to the first point assuming the level is fairly
centered between the two points.

1’\ |] "a' "" Two Peg Test Close
T I
Survey Mwo-Peg Test

Measure to Pegl(pl)

Locate Peg2

Figure 8-74. Take Peg 1 Reading

2. Then move the instrument to one of the pegs and take the shots
again to Pegs 1 and 2 (Figure 8-75).

ETWD Peg Test Close

dpl 4ol

p1: VD:1.200, HD:5.000

Measure to Peg2(p2)

Locate Peg2l [ Meas ‘

Figure 8-75. Take Peg 2 Reading

 Tap the Locate Peg2 button to measure the horizontal
distance to Peg2 and compare it with the already taken
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measurement to Pegl. This measurement is not used in the
error computations.

» Tap the Meas button to take measurements for the displayed
prompted Peg (Figure 8-75 on page 8-63). The Two Peg Test
Results screen displays.

The Two Peg Test Results screen (Figure 8-76) displays the results of
the test after all measurements are taken. The computed error means
inclination of the actual line of sight from true horizontal. This error
is proportional to the distance from the level to the rod.

"" Two Peg Test Results . Close
Shot Data
pl vD 1.200
pl HD 5.000
p2 vD 1.201
p2 HD 6.000
pl° vD 1.201
pl" HD 5.001
p2°' vD 1.202
p2°" HD 5.995

Error = 0.045

mmjm

Figure 8-76. Two Peg Test Results

Level Run

To set up a Level Run, tap Survey » Level Run (Figure 8-77 on
page 8-65). The Level Run screen displays.
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1. Type in a name for the level run and any additional information
on this level, if needed. Tap Next.

¥ _. o
Level Run Name Iml e

Note bm A road

Suryey

Figure 8-77. New Level Run

Tap on the DL tab to display all leveling data in progress
(Figure 8-78).

ELEVEI Run(Al)

pL | Data
I I
Point
Elev 150.652
BS 1.1289
HI 152,183
BS Dist 43,310

Sum BS Dist 150,370
SumBS-5umFS 5,190
MNotes

F5 1.5316
F5 Dist 35.970
Sum FS Dist 145,180
Accurnulated.., 0,001

Figure 8-78. Leveling

2. Select the point for a rod reading in the [@] field. Select it from
the map or from the list of points.

3. Set the code for the measured point in the [ field. Use the
bitmap menu next to the field to set a new code.
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4. Use an appropriate tool to make leveling measurements:

* BS — usually sighting back along the leveling line, the Level
takes a rod reading on a point of known elevation.

* SS — the Level takes a sideshot to the point.

* FS — the Level takes a rod reading on a point of unknown

elevation.

Tap on the Data tab to view information related to the current
measurement (Figure 8-79).

pL | Data

ELEVEI Run(Al)

Close

Point

Elev

ES

HI

ES Dist

Surmn BS Dist
SumBS-5SumFS
MNotes

F5

F5 Dist

Surmn FS Dist:
Accurnulated...

150.652
1.1289
152,183
43.210
150,370
5.190

1.5316
35.970
145.180
0.001

Figure 8-79. Data Level Run

5. Use the Vertical Offset option from the bitmap in the upper-left
corner of the screen to set the vertical offset to apply at the

point.

6. To select the columns and the order of the columns to display in
the fieldbook, use the Display Settings option from the bitmap
in the upper-left corner of the screen

(Figure 8-80 on page 8-67).
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Column to Display

v Code

v | BS

v |HI

v|F5

v Elev

v |B5 Dist

+|F5 Dist
v|5um BS Dist
v|5um FS Dist
v|SumBS-5umFS

<

~

v

Performing Level Surveys

Figure 8-80. Change Display Columns

7. To display the SumBS-SumF'S measurement, select the Show
SumBS-SumFS option from the bitmap in the upper-left corner

of the screen.

8. Use the Inverse option to perform the Two-Point Inverse cogo

computation.

9. Select a stakeout option from the bitmap in the upper-left
corner of the screen for DL survey mode to stake a Point, Point
List or Elevation. Staked points are not added to the level run,
they are independent.
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Notes:
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Chapter 9

Staking Out

The Stakeout process involves finding points near a desired location.
The preliminary work for GPS, Total Station, and Digital Level
stakeout is similar to that for the Survey work.

The stakeout function can be accessed from the Stakeout menu or
from the Main Map.

When in the Main Map, tap the desired object to highlight it. Then
hold the stylus on the selected object until a pop-up menu displays
(Figure 9-1). The menu options depend on the object selected. Select
the appropriate item from the pop-up menu.

Stakeout

Point In Direction
Edit

Delete

Add To Layer

——=500 m

Figure 9-1. Stakeout from Main View

measurement and shows the directions to the design
point; whereas the Meas button takes a
measurement and computes the coordinates of the
stakeout point.

@ In TS Mode, the Cur Pos button takes a
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Stakeout a Point

1. Tap Stake » Points (Figure 9-2). The Stakeout Pt screen
displays.

2. On the Stakeout Pt screen, tap the Settings button (Figure 9-2).

B
—_ ol B
% IIUgLFIIed 2-;‘01 3.¥UU §+3
stake Bl 4+ Design Point [100
4
@ Code
Note —
Ant Ht 20000 m
[Vertical v

Figure 9-2. Stakeout Point
3. To stake out a point for GPS+ do the following:

* On the Stk Parms screen, specify the following stakeout
parameters: enter the horizontal distance tolerance (Hz Dist
Tolerance), select the Reference Direction, and select the
Solution Type value. To return to default values, tap the
Defaults button. Then tap OK (Figure 9-3 on page 9-3).
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Stakeout a Point

Finish lCanceI]

Hz Dist Tolerance IM| m

Reference Direction
|M0ving Directian v

Solution Type
|Fix Only »

Auto Accept

Murn Meas to svg |3

[ ]Precision {m}

Hz  J00150 | vert J0.0300

Figure 9-3. Stakeout Parameters - GPS+ mode

4. To display the icon for the staked point on the map, select the
Display option from the bitmap menu in the upper-left corner of
the Stk Parms screen (Figure 9-4). In the Staked Point Icon
screen, set appropriate parameters for the icon.

5. To stake out a point for the TS: set the horizontal distance
tolerance and reference direction. Also, select the manner in
which the Total Station should be turned towards the design
point and tap the Defaults button to return to default values.
Then tap OK.

e ror:  EEIETD

Store Staked Point As

Point IDESign Pt Suffix

stk

Note IDesign Point v

Figure 9-4. Stakeout Parameters — TS mode
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6. Select the design point from the list or a map, or insert the name
manually. Specify the antenna parameters: the height value and
type or the height of the rod, based on whether you are in GPS+
mode or TS mode. Check if the PTL Point Stakeout is
performed. Tap the Stakeout button on the Stakeout Point
screen (Figure 9-2 on page 9-2).

7. For GPS+: use the information on the Stakeout screen for
finding the target point (Figure 9-5).

Tap Store after the location is close enough to the design point.
Tap the Next Pt button to change the design point (increment to
the next point in the data set) of the stakeout.

Estake Close
o Figed H v gt
100%. 2201 3200 10+
Point 100 E
Hz Dist
12.500 m
Next Pt
Left 0.252 m
Back 12.497 m
Cut 0.001 m
Ellipsoidal ht 150.016 m
Azimuth 181.0916 dms

Figure 9-5. GPS Stakeout

8. For TS: sight the prism. On the Stakeout screen (Figure 9-6 on
page 9-5), use the Cur Pos button to take a measurement and
then show the current position relative to the design point. Use
the EDM button to select distance measurement mode, either
Coarse, Fine or Coarse Tracking. The Meas button should be
tapped once the current location is close enough to the desired
point. Tapping the Meas button causes a measurement to be
taken, and the computed coordinates to be stored to a point. Tap
the Next Pt button to stakeout the next point in the data set.

9-4 TopSURYV User’s Manual



Stakeout a Point

Estake Close

j©BS®
Point 2 EDM |E|
Hz Dist
5.424 m

P
Dsan HA
80.3227 dms{&]

Left 2.390 m
Towards TS 4.869 m
Cut 7.854 m
Turn Left 0.0933 dms

Figure 9-6. TS Stakeout

9. To open the map of the layout of the target and the current
position, use the arrow button in the lower-left corner of the
screen (Figure 9-7).

Estake . Close

o Figed H v gt
100%: 2201 2.200 +
Point 101 E

&

: Next Pt
i
=20 m-éé—

Left 2.539 m
Back 127.206 m
Cut 0.000 m
Ellipsoidal ht 150.015 m
Azimuth 181.0837 dms

Figure 9-7. Stakeout Map

10. To display coordinates instead of stakeout directions, use the
Display Coords option from the pop-up menu on the top-left
corner of the screen. For a Robotic survey, selecting this option
displays coordinates instead of angle/distance data.

P/N 7010-0493 9-5



Staking Out

11. To change the rod height during stakeout in TS mode, select the
Rod Height option from the pop-up menu on the top left corner
of the screen.

12. To automatically open the Stakeout screen for the next point
after storing a staked point, select the Auto Advance Pt option
from the pop-up menu on the top-left corner of the screen.

13. To store the staked point on a layer, select the Design Pt/Layer
option from the menu popped up after tapping the bitmap in the
upper-left corner of the Stakeout screen. In the Store Design
Point screen (Figure 9-8), select the layer from the drop down

list or tap the List [ ... ] button to edit layers.

Esture Des Pt m Cancel

Layer

g 5 =)

Figure 9-8. Select Layer for Staked Point

The Display Store Pt Info box is check marked by default to
display information on the staked point before storing it. The
Store Pt Info screen displays the stakeout results before the point
is stored (Figure 9-9 on page 9-7).
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|# Store Pt Info Ok lCanl:eI

I
Name 2_stk
Code
Note 2
Cut 7.854
Local
MNorth 1000.111
East 1699.930
Elev 05.637
dN -0.111
dE -0.037
dH -7.854

Figure 9-9. Store Point

Stakeout a Point

14. To change the elevation of the staked point, select the Design
Offsets option from the Help Icon menu in the upper-left corner
of the Stakeout screen. Check and enable the Design Elev box
in the Design Elevation screen to manually edit the elevation
value (Figure 9-10).

P/N 7010-0493

EDesign Elev 0K lCanl:eI

Design Elev

D IB?.?BB m
Road Offset
I m

DTM Offset

o

Figure 9-10. Design Elevation
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Staking Out

Stakeout a Point in Direction

Perform a Stakeout Point in Direction task when the location of the
design point is unknown, but can be computed with distance and
angle offsets from a known point.

1.

To perform a Point and Direction stakeout, tap Stake » Point in
Direction (Figure 9-11).

In the Stakeout Point & Direction screen, enter the starting
point name (known point), the azimuth set by value or as the
direction to another known point, the angle offset from the
azimuth line, the distance offset along the angle offset line, the
height offset, and the parameters of antenna (GPS mode) or the
height of the rod (target) (T'S mode).

Enter the name of the stakeout point in the Store Pt field. Tap
the Stakeout button (Figure 9-11 on page 9-8).

Tap the Settings button and specify the Stakeout parameters as
described in “Stakeout a Point” on page 9-2.

T.' @ "" Point in Dir Settings I Close
’ [ |
¥ From Point |100
Stake Pt in Direction S
& |AztopPt | [103
Ed B

Angle Offset [5.0000  dms [ =)

Hz Dist |15l].l]l]l] m

Vert Dist 3.000 m

Store Pt |1III4
Ant Ht I2.l:ll:ll:l m

I\."ertil: v
Stakeout

Figure 9-11. Stakeout Point & Direction
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4. For GPS+: use the information on the Stakeout screen to find
the target. Tap Store once the position is close enough to the
desired one (Figure 9-12).

[FEE -
o Figed H v gt
100%. 2201 3200 10+
Point 105 E
Hz Dist
161.209 m
Left 16.286 m
Back 160.384 m
Fill 3.000 m
Ellipsoidal ht 150.015 m
Azimuth 185.4753 dms

Figure 9-12. Stakeout Point & Direction — Stakeout

5. For TS: sight the prism. In the Stakeout screen tap the Cur Pos
button to check the position. Use the EDM button to select
distance measurement mode: Coarse, Fine or Coarse Tracking.
Once the position is close enough to the desired one, tap Meas
to store it (Figure 9-13).

Estake . Close
S
OBs
Point 105 EDM |E|
Hz Dist
5.270m
osan vl o
72.3227 dms{{g
Left 1.639 m
Towards TS 5.009 m
Fill 5.000 m
Turn Left 0.3733 dms

Figure 9-13. Stakeout Point & Direction — Stakeout
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6. To display coordinates instead of stakeout directions, use the

Display Coords option from the pop-up menu on the top left
corner of the screen. For a Robotic survey, selecting the Display
Coords option displays coordinates instead of angle/distance
data.

To change the rod height during stakeout in TS mode, select the
Rod Height option from the pop-up menu on the top left corner
of the screen.

To store the staked point on a layer, select the Design Pt/Layer
option from the menu popped up after tapping the bitmap in the
upper left corner of the Stakeout screen (see Figure 9-8 on
page 9-6 and Figure 9-9 on page 9-7).

The Help Icon in the upper-left corner displays the pop-up menu that
contains the same options as in the Offsets stakeout.

Stakeout a Point List

1.

To stake out points in a point list, tap Stake » Point List
(Figure 9-14 on page 9-11).

In the Stakeout Point List screen, select a pre-existing points
list, set the antenna parameters (GPS mode): height of the
antenna reference point (ARP) above the mark and the type, or
the height of the rod (target) (TS mode). To perform a stakeout,
starting from the end of the Point List, check and enable the
Reverse Order box. Use the arrow buttons to modify stakeout
order. Then tap the Stakeout button (Figure 9-14 on

page 9-11).
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Stakeout a Line

i [settings | close
4| [N Point List [PointList1
Foirt List g
Stake oint Lis EI

List of Points ~ '%

4ra

43 2
%2 .

41 &

< > =200 m
m Reverse Order E
HR |2.l:ll:ll:l m

Stakeout

Figure 9-14. Stakeout Point List

3. Tap the Settings button and specify the Stakeout parameters as
described in “Stakeout a Point” on page 9-2.

4. For GPS+: use the information on the Stakeout screen for
finding the target. Tap Store after the position is close enough
to the designed point. To move to the next point, tap the Next
Pt button.

5. For TS: sight the prism. On the Stakeout screen tap the Cur
Pos button to check the position. Once the position is close
enough to the desired one, tap Meas to store it. To move to the
next point, tap the Next Pt button.

6. To stakeout another Point List, tap Close, return to the Stakeout
Point List screen and select another point list.

Stakeout a Line

1. To stake out points along a line, tap Stake » Lines (Figure 9-15
on page 9-12).

2. On the Stakeout Line screen (Figure 9-15 on page 9-12),
specify the reference line by choosing the start point and either
the end point or the azimuth. Currently, the stakeout points have
the same height as the starting point. Also, specify the antenna

P/N 7010-0493 9-11



Staking Out

parameters (GPS+ mode), or the height of the rod (TS mode).

Tap the Stakeout button (Figure 9-15).

A7

Stake Lines

ELine Settings | Close

o Fied H o v gt
10056 2201 3200 10+3

Start Point [1
1% e VI Fit of Start PR2
Ant Ht [ooo m
I\."ertil: v

Stakeout

Figure 9-15. Stakeout Line

3. On the Stakeout Line screen, tap the Settings button and

specify the Stakeout parameters as described in “Stakeout a

Point” on page 9-2.

4. For GPS+: use the information on the Stakeout Line screen for
finding the target line. Tap Store after the point is close enough
to the line and at the desired distance from the starting point

(Figure 9-16).

Estake Point . Close

Azimuth

o Fied H o v gt
1003 2201 3200 19+
Point E
Left of Line 938.676 m
Length of Line 200.000 m
Dist Along Line 289.581 m
Fill 0.001 m

181.0842 dms

Figure 9-16. Stakeout Line
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Stakeout a Curve

5. For TS: sight the prism. On the Stake Point screen, tap the Cur

Pos button to check the position (Figure 9-17). Tap the EDM
button to select distance measurement mode, either Coarse,
Fine or Coarse Tracking. Once the position is close enough to
the line and at the desired distance from the starting point, tap
Meas to store it.

om0
j©BS®
EDM |E|

Left of Line 1.916 m

Away From TS 1.993 m
Dist Along Line 0.573 m
Fill 0.000 m
Turn Right 73.2100 dms

Figure 9-17. Stakeout Line

Tap the Close button to return to the first Stakeout Line screen.
Enter parameters for the next reference line.

To store the staked point on a layer, select the Design Pt/Layer
option from the pop-up menu after tapping the bitmap in the
upper-left corner of the Stakeout screen (see Figure 9-8 on
page 9-6 and Figure 9-9 on page 9-7).

Stakeout a Curve

1.

To stake out points along a horizontal curve, tap
Stake » Curves (Figure 9-18 on page 9-14).

On the Curve screen (Figure 9-18 on page 9-14), specify the
reference curve by choosing the starting point (Point of
Curvature), the ending point (Point of Tangency) and the radius
parameter of the curve at the end point. The stakeout points
have the same height as the starting point. Also, specify
whether the curve turns right or left and whether to use a small
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or large part of the circle. Enter the antenna parameters (GPS+
mode), or the height of the rod (TS mode). Tap the Stakeout

button.
J - 7 T o | e
’ e PCPoint fio0
Stake

PT Point  [100_stk
& o ool
Turn IRight +| HR

Curve |Small v |2.IZIIIIIII

Figure 9-18. Curve

3. On the Stakeout Curve screen, tap the Settings button and
specify the Stakeout parameters as described in “Stakeout a
Point” on page 9-2.

4. For GPS+: use the information on the Stakeout Curve screen to
find the target curve (Figure 9-19).

Tap Store after the point is close enough to the curve and at the
desired distance from the starting point.

Estake Point . Close

- Fiked H

v g
100%. 2201 3200 10+
Point E

)

Right of Curve 1.916 m
Length of Curve 1.993 m
Dist Along Curve 0.573 m
Fill 0.000 m
Azimuth 73.2100 dms

Figure 9-19. Stakeout Curve
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5.

Stakeout Line & Offset

For TS: sight the prism. On the Stake Point screen, tap the Cur
Pos button to check the position (Figure 9-20). Tap the EDM
button to select distance measurement mode, either Coarse,
Fine or Coarse Tracking. Once the position is close enough to
the curve and at the desired distance from the starting point, tap
Meas to store it.

oo
j©BS®
Point EDM |E|

Right of Curve 1.916 m
Away From TS 1.993 m
Dist Along Curve 0.573 m
Fill 0.000 m
Turn Right 73.2100 dms

Figure 9-20. Stakeout Curve

For details on the Help Icon in the upper-left corner of the screen, see
“Stakeout a Point” on page 9-2.

Stakeout Line & Offset

When the desired points lie at regular intervals on a line that is
parallel to a known line, and is at a known horizontal and vertical
distance from it, the Stakeout Line & Offset task should be
performed.

1.
2.

Tap Stake » Offsets » Line (Figure 9-21 on page 9-16).

In the Line& Ofst (Stakeout Line & Offset) screen, set the
direction of the line, the type of height computations for the
stakeout point (currently the stakeout point will have the same
height as the starting point of the line), the number of
subdivisions of the line (if an end point is specified) and the
starting station (chainage) of the line. Tap Next (Figure 9-21 on
page 9-16).
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J / . ELine&Ofst Settings | Close
> Y, | 1
s

ot Start Point [1
" ats —r=
Stake

Il ¢ fooo0

;, Ht Comp I v

-

e [ ] Num Subs Il:l

Line

S5 m

®/O [o+00.000
-

Figure 9-21. Stakeout Line & Offset Parameters

3. Inthe Sta&Ofst (Station & Offsets) screen, set the station along
the line being staked, the station staking interval, the right or
left offset of the stakeout point with respect to the line, the Up
or Down Height offset, the height and the type of the antenna
height (GPS mode), or the height of the rod (target) (TS mode).
If the number of subdivisions has been selected, the station

interval is automatically computed and cannot be changed
(Figure 9-22).

£ Settings | close

E=|==k)

Sta Interval [10.0000 m
# [Right Offset|[2.000 m

& Up Jjosoo m
HR AL m

Figure 9-22. Station & Offsets
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Stakeout Line & Offset

4. Tap the Settings button and specify the Stakeout parameters as
described in “Stakeout a Point” on page 9-2.

5. For GPS+: use the information on the Stakeout screen for
finding the target. Tap Store after the position is close enough
to the desired point. Tap the / (left or right offset)
buttons to retreat/advance the station by the specified Station
Interval, for staking out the previous/next station, respectively.

Stations before the beginning and past the end of the alignment
can also be staked.

Estake Close

o Fied H o v gt
1003 2201 3200 19+
0+10.000... E
Hz Dist
1083.821'm
= e
Left 11.513 m
Back 1083.760 m
Fill 0.499 m
Ellipsoidal ht 150.015 m
Azimuth 180.3631 dms

Figure 9-23. Stakeout

6. For TS: sight the prism. On the Stake screen tap the Cur Pos
button to measure the target. Tap the EDM button to select
distance measurement mode, either Coarse, Fine or Coarse
Tracking. Once the position is close enough to the desired
point, tap Meas to store it (Figure 9-24 on page 9-18).
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[
i8S
0+10.000... EDM |E|
Hz Dist
0.052 m
Dsanta
27.1836 dms &}
Left 0.001 m
Towards TS 0.052 m
Fill 2.500 m
Turn Left 0.0024 dms

Figure 9-24. Stakeout

Tap the == / (left or right offset) buttons to retreat/
advance the station by the specified Station Interval, for staking
out the previous/next station, respectively (Figure 9-24).

7.

10.

9-18

To display coordinates instead of stakeout directions, use the
Display Coords option from the pop-up menu on the top-left
corner of the screen. For a Robotic survey, select the Display
Coords option to display coordinates instead of angle/distance
data.

To change the rod height during stakeout in TS mode, select the
Rod Height option from the pop-up menu on the top left corner
of the screen.

To change the design point elevation, select the Design Offsets
option from the pop-up menu on the top-left corner of the
screen.

To store a staked point on a layer, select the Design Pt/Layer
option from the drop-down menu in the upper-left corner of the
Stakeout screen (see Figure 9-8 on page 9-6).
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Stakeout Line & Offset

11. Tap the Close button to return to the Sta& Ofst screen. Enter
new offsets or station.

%

Tap in the current station string to enable the
floating information screen that displays the point
name, the note, design elevation (if enabled), the
station number, and the offset value of the current
point (Figure 9-25).

Estake . Close

j©BS®
4+00.000... EDM |T:|
Hz Dis| Point 106

0.053 note 105

Diesign Eley 100.000 m
Station 4+00.000 m
Offset 5.000 m Right T

Dsan =

27.1836 dms &} [ cur Pos |
Left 0.001 m
Towards TS 0.052 m
Fill 2.500 m
Turn Left 0.0024 dms

Figure 9-25. General Stakeout Information

* The Help Icon at the upper-left corner of the screen displays the
pop-up menu of options. For details, see “Stakeout a Point” on
page 9-2.
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Stakeout Three Point Curve &
Offsets

When the desired points lie at regular intervals on a curve that is
parallel to a curve with three known points, and is at a known
horizontal and vertical distance from it, the Stakeout Three Pt Curve
& Offsets task can be performed.

1.

To stake out Three Pt Curve & Offsets, tap
Stake » Offsets » 3Pt Curve. The 3 Pt Curve screen displays.

On the 3 Pt Curve screen (Figure 9-26), enter or select from the

list or map the following sets of three known points, to create a
curve and tap Next:

* The starting PC Point (Point of Curvature) and ending PT
Point (Point of Tangency) on the circle, and a third point on
the curve, and the starting station (chainage) of the line.

F_<
i —> sze/t: pC Point  [102
l PT Point
!{: & |curve Pt | [103
3Pt Cu:e (] Num Subs ID_

S5 m
Q o:.00 000 S
i

Figure 9-26. Three Point Curve

* The starting PC Point (Point of Curvature) and ending PT
Point (Point of Tangency) on the circle, and the center point
(also called a Radius Point). For this set of points, the
distance between RP Point and PC point should be equal to
the distance between RP Point and PT point. The radius and
the PC and PT points define two curves, one with delta less
than or equal to 180 degrees (Small curve), and the other with
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delta greater than or equal to 180 degrees (Large curve).
Select either Small or Large from the Curve drop-down box
(Figure 9-27) to indicate which of these two curves will be
used for staking and the starting station (chainage) of the line.

Settingsl Close
PC Point  [10006
PT Point  [10007
& |RP Point | [103
[ ] Num Subs Il:l_
Curve ISmaII v
55 m

a [o+00.000
L

Figure 9-27. Three Points Small Curve

3. In the Sta&Ofst screen, set the station along the curve being
staked, the station staking interval, the right or left offset of the
stakeout point with respect to the curve, the Up or Down Height
offset, the height and the type of the antenna height (GPS
mode), or the height of the rod (target) (TS mode).

£ Settings | close

i g [o+10.000
=] B |

Sta Interval [10.0000 m
# [Right Offset|[2.000 m

& Up Jjosoo m
HR AL m

Figure 9-28. Station & Offsets
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Tap the Settings button and specify the Stakeout parameters as
described in “Stakeout a Point” on page 9-2.

Tap the Stakeout button and perform the stakeout as described
in “Stakeout Line & Offset” on page 9-15.

Stakeout Intersection &
Offsets

When the design point is the intersection of two lines that are parallel
to two other lines and at known horizontal distances from these, the
Stakeout Intersection & Offsets task should be performed.

1.

To stake out Intersection & Offsets, tap Stake » Offsets »
Intersection. The Stakeout 2Line& Ofst screen displays
(Figure 9-29).

On the Stakeout 2Line& Ofst screen, define the starting point
and azimuth for the first known point; specify the horizontal
offset to the first parallel line. Tap Next (Figure 9-29).

/ P e il Settings | Close
’/ Line 1
Stake Offsets From Point [100
l & [aztopt  Jroo01
& [Right Offsetlm| m
e <
Intersection

Figure 9-29. Intersection & Offsets — Line 1

The second Stakeout 2Line& Ofst screen defines another line
(Line 2) using a point and an azimuth, and another definition of
the horizontal offset to the second parallel line (Figure 9-30 on
page 9-23). The height and name of the intersection point of
these two parallel lines (stakeout point) should be specified,
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along with the height and type of the antenna (GPS+ mode), or
the height of the rod (target) (TS mode).

S Rl Settings | close

Line 2

. From Point Ill:ll:l s --
¢ o Jor A8

Intersect Ht I15l].l]14 m

Store Point  |102

Ant Ht |2.IIIIIII] m
I\."ertil:al v

Figure 9-30. Intersection & Offsets — Line 2
4. Tap the Settings button and specify the Stakeout parameters as
described in “Stakeout a Point” on page 9-2.
5. To start the stakeout, tap the Stakeout button.

For GPS+: use the information on the Stakeout screen for
finding the target. Tap Store after the target is close enough to
the design point (Figure 9-31).

Estake Close
o Fied H o v gt
1003 2201 3200 19+
0+10.000... E
Hz Dist
57.875m
Right 1.032 m
Back 57.865 m
Fill 0.498 m
Ellipsoidal ht 150.016 m
Azimuth 178.5842 dms

Figure 9-31. Stakeout
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10.

11.

12.

For TS: sight the prism. In the Stakeout screen, tap the Cur Pos
button to check the position. Use the EDM button to select
distance measurement mode: Coarse, Fine or Coarse Tracking.
Once the position is close enough to the design point, tap Meas
to store it (Figure 9-31).

Estake . Close
S
OBs
Point 104 EDM |E|
Hz Dist
100.145 m
osanvs o
16.2209 dms{{g
Left 0.191 m
Away From TS 100.144 m
Fill 2.000 m
Turn Left 0.0051 dms

Figure 9-32. Stakeout.

To display coordinates instead of stakeout directions, use the
Display Coords option from the pop-up menu on the top left
corner of the screen. For a Robotic survey, selecting the Display
Coords option displays coordinates instead of angle/distance
data.

To change the rod height during stakeout in TS mode, select the
Rod Height option from the pop-up menu on the top left corner
of the screen.

To change the design point elevation, select the Design Offsets
option from the pop-up menu on the top left corner of the
screen.

To store the staked point on a layer, select the Design Pt/Layer
option from the drop-down menu in the upper left corner of the
Stakeout screen (see Figure 9-8 on page 9-6 and Figure 9-9 on
page 9-7)

Tap the Close button to return to the first Stakeout Line screen.
Enter parameters for the next reference line.
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Stakeout Curve & Offsets

When the desired points lie at regular intervals on a curve that is
parallel to a known curve, and is at a known horizontal and vertical
distance from it, the Stakeout Curve & Offset task should be

performed.

1. To stake Curve & Offsets, Stake » Offsets » Curve. The
Curv&Ofst screen displays.

2. On the Stakeout Curv&Ofst screen, set the parameters of the
known curve: the PC Point (Point of Curve), the starting point
of the curve, the azimuth of the tangent of the curve at the PC
point, the radius parameters of the curve, the length parameter
of the curve, the turn value of the curve, and the starting station
(chainage) of the line. Tap Next.

! / ) ECurv&Ofst Close
. ':7/ PC Point  [10006
Stake Offsets
l PT Point
(/: | J150.000 m
Curve. []Num Subs IIII
Turn IRight -
S5 m
{i] Il]+l]l].l]l]l]
Lo
Figure 9-33. Stakeout Curve & Offset
3. In the Stakeout Sta& Ofst screen (Figure 9-34 on page 9-26),

set the station along the curve being staked, the station staking
interval, the left or right offset of the stakeout point with respect
to the curve, the Up/Down Height offset, the height and the
type of the antenna height (GPS mode), or the height of the rod
(target) (TS mode).
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£ Settings | close

i g [o+10.000
=] B |

Sta Interval [10.0000 m
# [Right Offset|[2.000 m

& Up Jjosoo m
HR AL m

Figure 9-34. Station & Offsets

Tap the Settings button and specify the Stakeout parameters as
described in “Stakeout a Point” on page 9-2.

Tap the Stakeout button and perform the stakeout as described
in “Stakeout Line & Offset” on page 9-15.

Stakeout Spiral & Offsets

When the desired points lie at regular intervals on a curve that is
parallel to a known curve, and is at a known horizontal and vertical
distance from it, the Stakeout Curve & Offset task should be
performed.

1.

To stake Spiral & Offset, tap Stake » Offsets » Spiral. The
Stakeout

In the Stakeout Spiral&Ofst screen, set the parameters of the
spiral to be staked out: the starting point of the spiral, the
azimuth of the Tangent of the curve at the PC point, the radius
parameter of the spiral, the length parameter of the spiral, the
direction of turn, direction of movement of the spiral and the
starting station (chainage) of the line

(Figure 9-35 on page 9-27). The direction values are: 75 -> SC
(Tangent Spiral -> Spiral Circle), which is the incoming spiral
to the internal circle, and CS -> ST (Circle Spiral -> Spiral
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Tangent), which is the exiting spiral from the circle to the
Tangent. Tap Next. The Stakeout Sta& Ofst screen displays.

J — A T ottings | closo
= | . |
fo/ TS Point |1
Stake Offsets T
l Tangent Azi [50.0000 dms
& [Radius | [200.000 m
e & m [tength | SN m
'E. =ss [o+00.000
Turn

Spiral
nght
TS To 5C «
=50m Next >>

Figure 9-35. Stakeout Spiral & Offset

3. In the Stakeout Sta& Ofst screen (Figure 9-36), set the station
along the spiral being staked, the station staking interval, the
left or right offset of the stakeout point with respect to the
spiral, the Up or Down Height offset, the height and the type of
the antenna height (GPS mode), or the height of the rod (target)

(TS mode).
| Il Settings | Close
i g [o+10.000
B =)

Sta Interval [10.0000 m
# [Right Offset|[2.000 m

& Up Jjosoo m
HR AL m

Figure 9-36. Station and Offset

4. Tap the Settings button and specify the Stakeout parameters as
described in “Stakeout a Point” on page 9-2.
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5. Tap the Stakeout button and perform the stakeout as described

in “Stakeout Line & Offset” on page 9-15).

Stakeout Roads

1.

To stake out points on a road, and on either sides of it, tap
Stake » Road. The Stk Road screen displays.

On the Stk Road screen (Figure 9-37), set the road, horizontal,
and horizontal and vertical alignments to be staked out and the
starting station, the height and the type of the antenna height
(GPS mode), or the height of the rod (target) (TS mode). If
staking the transition points (points where horizontal elements
of the road change), check the appropriate field (Figure 9-37).
Tap Next. A second Stk Road screen displays (Figure 9-38 on
page 9-29).

@ Estk Road Close
I & |Road lﬁ

Stake Road
ss  [o+o0.000 m

N

=200 m

i
Lo m

[]Include Trans Point
Ant Ht 2.000 m

Vertica +

Figure 9-37. Stakeout Road

In the next Stakeout Road screen, set the properties of the
cross-section on the stakeout station:

* The station where the stakeout is performed.
* The interval of the station increment.

* The point code of the current segment (cross-section is
comprised of various segments).
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* The horizontal offset from the current segment point, the
vertical offset from the current segment point, and select the
reference line for offsets by selecting the Centerline/Surface/
Segment type of template offsets (for details, refer to the
TopSURYV Reference Manual).

Settingsl Close
sta [2+00.000 [ o]

Sta Interval [100.0 m
Segment Pt ICL E il
& o et 500 m

| Up Offset I m
ISurfal:e v

] I
>\ i li 1 ﬂ/<
i e 111 T
Stakeout

Figure 9-38. Stakeout Road (second screen)

4. Tap the Settings button and specify the Stakeout parameters as
described in “Stakeout a Point” on page 9-2.

5. Tap Stakeout, then on the Initial Point Name screen set the
starting name for the points and tap OK.

For GPS+: use the information on the Stakeout screen for finding
the target. Tap Store after the position is close enough to the
desired target (Figure 9-39 on page 9-30).

Tap the =] / [ button to retreat/advance the station by the
specified Station Interval, for staking out the previous/next
station, respectively. Stations before the beginning and past the
end of the alignment can also be staked out.
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Estake . Close

o Fied H o v gt
10056, 2201 3200 1p+
2+400.000... E

Hz Dist™ 44
6181615.429 m

==]==|

Left 16.286 m
Back 160.384 m

Fill 3.000 m
Ellipsoidal ht 150.014 m
Azimuth 183.4900 dms

Figure 9-39. Stakeout

6. For TS: sight the prism. On the Stake screen, tap the Cur Pos
button to measure the target. Tap the EDM button to select
distance measurement mode: Coarse, Fine or Coarse Tracking.
Once the position is close enough to the desired one, tap Meas

to store it. Tap the [&=]/ button to retreat/advance the
station by the specified Station Interval, for staking out at the
previous/next station, respectively (Figure 9-40).

Estake . Close

18

2+00.000... EDM |E|
——
T

( © ==

Dsan HA

6.5506 dms_4{E]

Left 0.563 m
Towards TS 2.441 m

Fill 10.200 m
Turn Left 0.0954 dms

Figure 9-40. TS Stakeout Road

7. To display coordinates instead of stakeout directions, use the
Display Coords option from the pop-up menu on the top-left
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10.

11.

Stakeout Slope

corner of the screen. For a Robotic survey, select the Display
Coords option to display coordinates, instead of angle/distance
data.

To change the rod height during stakeout in TS mode, select the
Rod Height option from the Help Icon pop-up menu on the top-
left corner of the screen.

To change the design point elevation, select the Design Offsets
option from the pop-up menu.

To store the staked point on a layer, select the Store Design Pt/
Layer option from the drop-down menu in the upper-left corner
of the Stakeout screen (see Figure 9-8 on page 9-6).

Tap the Close button to return to the Stakeout Road screen.
Enter a new offset or station.

Stakeout Slope

1.

To stake out the slope of a road, tap Stake » Slope. The Stk
Slope screen displays.

On the Stk Slope screen, select a road/ horizontal / horizontal
and vertical alignments, the starting point of the stakeout, the
height and the type of the antenna height (GPS mode) or the
height of the rod (target) (TS mode). Tap Next.

& — =
Stake Slope & [Road | [w1

ss  [o+o0.000 m

e

=200 m |:IZIIDD m
[]Include Trans Point

HR Il].l]l]l] m

Figure 9-41. Stakeout Slope
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3. On the Stk Slope screen, set the properties of the cross-section
at the stakeout station and the interval of the station increment,
the hinge point (point of rotation for the Cut/Fill Slope lines)
and the values of the Cut/Fill Slope parameters, and the offset
from the catch point (the point where the slope crosses the
surface of the terrain) (Figure 9-42).

Estk Slope Close
sta [2+00.000 [ o]
Sta Interval [100.0 m
Hinge Point ICL—E il
Offset from cP [18.00 m
R Slope []Cut W

....... | W
[i] 1
S il JA/ e
T=—llm

Figure 9-42. Stakeout Slope

4. Tap the Settings button and specify the Stakeout parameters as
described in “Stakeout a Point” on page 9-2. Tap Stakeout.

5. For GPS+: use the information on the Stake screen for finding
the target. Cut/Fill are computed from Cut/Fill Slope, other
offsets are computed using the Catch Point.

Tap Store after the position is close enough to the desired point.
Tap the =]/ =5 button to retreat advance the station by the

specified Station Interval, for staking out at the previous/next
station, respectively (Figure 9-43 on page 9-33).
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¢ EEE
0+00.000...

2038 347 g+ 4

Left 164.907 m
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Ell ht 161.707 m
C HP 9.057 m

Figure 9-43. GPS Stakeout Slope

6. For TS: sight the prism. On the Stake screen, tap the Cur Pos
button to measure the target. Cut/Fill values are computed from
the Cut/Fill Slope, other offsets are computed using the Catch
Point. Tap the EDM button to select distance measurement
mode: Coarse, Fine or Coarse Tracking. Once the position is
close enough to the desired point, tap Meas to store it.

Tap the / 5= button to retreat/advance the station by the
specified Station Interval, for staking out at the previous/next
station, respectively (Figure 9-44).

Estake Cluse
a
eES
2+00.000..
Cur Pos
ﬂ: :ﬂ
il
1.
Turn L 61 4644 dms
To TS 114.463 m
F CP 0.000 m
To CL 106.324 m
Along CL -177.802 m
Eley 95.637 m
F HP 10.000 m

Figure 9-44. TS Stakeout Slope
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7.

10.

11.

To display coordinates instead of stakeout directions, use the
Display Coords option from the pop-up menu on the top-left
corner of the screen. For a Robotic survey, selecting the Display
Coords option displays coordinates instead of angle/distance
data.

To change the rod height during stakeout in TS mode, select the
Rod Height option from the pop-up menu on the top-left corner
of the screen.

To change the design point elevation, select the Design Offsets
option from the pop-up menu on the top-left corner of the
screen.

To store the staked point on a layer, select the Store Design Pt/
Layer option from the pop-up menu after tapping the bitmap in
the upper-left corner of the Stakeout screen (see Figure 9-8 on
page 9-6 and Figure 9-9 on page 9-7).

Tap the Close button to return to the Stakeout Slope screen.
Enter new offsets, hinge point, or station.

Stakeout Real Time Road

1.

To stake out points on a road, and on either sides of it, tap
Stake » Real Time Road. The screen displays.

J @ Estk Road Close
_> ; & |Road lﬁ

o
Stake Real Tirme Rd

ss  [o+o0.000 m

@’\O PR
Lyon m

=200 m

HR Il].l]l]l] m

Figure 9-45. Stakeout Road
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2. On the Stk Road screen (Figure 9-46), set the road to be staked
out and the starting station, the height and the type of the
antenna (GPS mode), or the height of the rod (target) (TS
mode). If staking the transition points (points where horizontal
elements of the road change), check the appropriate field. Tap
Next.

3. On the Stk Road screen set the offsets from CL for the stakeout
points and tap Next.

Estk Road . Settings I Close

Cut Slope ILUUU
Fill Slope Im

Figure 9-46. Stakeout Road

4. Tap Stakeout. In the Initial Point Name screen, set the starting
name for the points and tap OK.

5. For GPS+: use the information on the Stakeout screen
(Figure 9-47 on page 9-36) for finding the target. Tap Store
after the position is close enough to the desired point
(Figure 9-47 on page 9-36).

6. To display coordinates instead of stakeout directions, use the
Display Coords option from the pop-up menu on the top left
corner of the screen. For a Robotic survey, selecting the Display
Coords option displays coordinates instead of angle/distance
data.

7. To store the staked point on a layer, select the Store Design Pt/
Layer option from the pop-up menu after tapping the bitmap in
the upper-left corner of the Stakeout screen (Figure 9-8 on
page 9-6 and Figure 9-9 on page 9-7)
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Estakeuut Close

o Fied H o v g
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Figure 9-47. Stakeout

8. For TS: sight the prism. In the Stakeout screen, tap the Cur Pos
button to measure the target. Tap the EDM button to select
distance measurement mode: Coarse, Fine or Coarse Tracking.
Once the position is close enough to the desired point, tap Store

to store it.

9-36

Estakeuut . Close

1O8s
Point 107 EDM
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Figure 9-48. Stakeout
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Stakeout DTM

1. To stake out points inside of a digital terrain model, tap
Stake » DTM.

2. Onthe DTM Stk screen (Figure 9-49), tap the List button to
select a TN3 file containing the desired DTM.

J % EDTM Stk Close
= . 1
=d Z DTM  [der
Stake DTM

B

[]use Alignment

[]create TIN ICut,‘FiII W
HR |2.l:ll:ll:l m

Stakeout

Figure 9-49. Select DTM

Set the height and the type of the antenna height (GPS mode), or
the height of the rod (target) (TS mode) and tap Stakeout.

3. Onthe DTM Stk screen (Figure 9-49), check and enable the
Use Alignment box to use station and offset information while
staking the DTM, check and enable the Create TIN box to
generate a new TIN (TN3) Cut/Sheet model of the points
staked.

Tap Stakeout. The Initial Point Name screen displays.

5. On the Initial Point Name screen, set the starting name for the
points, and tap OK.

6. For GPS+: use the information on the Stakeout screen for
finding the target. Tap Store after the position is close enough
to the desired point (Figure 9-50 on page 9-38).
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Estake Close
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Figure 9-50. GPS Stakeout

7. For TS: sight the prism. On the Stakeout screen, tap the Cur
Pos button to measure the target. Use the EDM button to select
distance measurement mode: Coarse, Fine or Coarse Tracking.
Once the position is close enough to the desired one, tap Store

to store it.

Estake . Close

j©BS®
[com [a]

Point 104

i

-

MNorth
East
Elevation
Cut

Figure 9-51. TS Stakeout

8. To display coordinates, instead of stakeout directions, use the
Display Coords option from the pop-up menu on the top-left
corner of the screen.
For a Robotic survey, select the Display Coords option to
display coordinates, instead of angle/distance data.
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0.

10.

11.

Stakeout Linework

To change the rod height during stakeout in TS mode, select the
Rod Height option from the pop-up menu on the top-left corner
of the screen.

To change the design point elevation, select the Design Offsets
option from the pop-up menu on the top-left corner of the
screen.

To store the staked point on a layer, select the Store Design Pt/
Layer option from the pop-up menu after tapping the bitmap in
the upper-left corner of the Stakeout screen (see Figure 9-8 on
page 9-6 and Figure 9-9 on page 9-7).

Stakeout Linework

1.

2.

To stake out points with code strings, tap Stake » Linework.

¥
J /47 ELinewurk Settings | Close

—>
Stake Linework
@ Code mn A
Strings |
v 1
HR |2.IZIIZIIII m

Stakeout

Figure 9-52. Linework

On the Linework screen (Figure 9-52), tap the Settings button
and specify the Stakeout parameters as described in “Stakeout a
Point” on page 9-2.

On the Linework screen, select a code from the drop-down list,
and check necessary strings (Figure 9-52).

To view the strings, tap the Strings item in the bitmap menu.
Specify the antenna parameters: the height value and type, or
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the height of the rod, based on whether in GPS+ mode or TS
mode. Tap Stakeout.

For GPS+: use the information on the Stakeout screen

(Figure 9-5 on page 9-4) for finding the target point.

Tap Store after the location is close enough to the design point.
Tap the Next Pt button to move to the next point in the data set.

For TS: sight the prism. On the Stakeout screen (Figure 9-6 on
page 9-5), use the Cur Pos button to take a measurement and
then show the current position relative to the design point.

The Meas button should be tapped when the current location is
close enough to the desired point. A measurement will be taken
and the computed coordinates will be stored to a point. Tap the
Next Pt button to stakeout the next point in the data set.

6. Tap Close to return to the Code Strings screen.

Level Stakeout

The Level Stakeout process involves finding elevations of points close
to a desired elevation.

Digital Level Stakeout of design points, and elevations can be
accessed from the main menu for a Level survey type or from the top
left menu in the Level Run screen.

DL Staking a Point

1.

To stake out elevations of design points, tap Stake » Points.
The Stake screen displays.

On the Stake screen (Figure 9-53 on page 9-41), enter or select
from the map or list the backsight point for the stake
measurement and a design point to stake.

Tap the BS button to take the BS measurement before staking if
it is not already measured. Tap the Stakeout button.
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Stake ﬁ BS Point |3—
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<+ Design Point |4—
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Stakeout

Figure 9-53. DL Stake Point

4. On the level Stakeout screen, tap the Meas button to measure
the elevation and compute a cut/fill value. Tap Store to set a
code for the point, the name, and a photo note; set the layer
name and plotting parameters, to view the point information
and save the staked point (Figure 9-54).

Staked points are not added to the Level Run; they are
independent. Staked out points are listed as observed points on
the Points screen.

3
4+ 4
.
HI  93.69
Elev  92.146
Fill  5.527

Figure 9-54. DL Stakeout
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DL Staking Point List

1.

To stake out elevations at design points in a point list, tap
Stake » Point List. The Stake Point List screen displays
(Figure 9-55).

On the Stake Point List screen, select a pre-existing points list,
enter either manually or select from the map or the list the
backsight point for the stake measurement.

B
1| Stake Point List Close
x| —| 3 -

(2L BS Point |3
Foint List —
Stake aint Lis
Point List I
m [&

List of Points | ( '%

< > | | 1100000 m

m []Reverse Order E

Figure 9-55. DL Stake Point List

To perform a stakeout starting from the end of the Point List,
check and enable the Stakeout in Reverse Order box. Use the
arrow buttons to modify the order of stakeout. Tap the BS button
to take the BS measurement before staking if it is not already
measured. Then tap Stakeout.

DL Staking Elevation

1.

To stake out elevations, tap Stake » Elevation. The Stakeout
Eley screen displays (Figure 9-56 on page 9-43).

On the Stakeout Eley screen, enter or select from the map or
list, the backsight point for the stake measurement and enter an
elevation value to stake at points.

Tap the BS button to take the BS measurement before staking if
it is not already measured. Then tap Stakeout.
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P |
Elavati BS Point |1
ki evation — =
-

Ele¥ation [150] m

Stakeout

Figure 9-56. DL Stakeout Elevation

3. On the level Stakeout screen (Figure 9-57) tap the Meas button
to measure the elevation and compute a cut/fill value. Tap Store
to set a code for the point, the name, a photo note and the layer
name and plotting parameters. You can also view the elevation
information and save the staked point.

3
4+ 4
.
HI  93.69
Elev  92.146
Fill  5.527

Figure 9-57. Level Stakeout
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Notes:
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Chapter 10

COGO

The COGO functionality in TopSURYV is a comprehensive set of
COGO tools to calculate the coordinate geometry to solve the
geometry problems encountered in professional surveying and civil
engineering applications. For example, use COGO tools, including
Inverse, Intersection, Traverse, Curve Solutions to design the precise
points of boundaries, buildings, or other elements included in a
project. A built-in calculator will help to edit input values in the entry
fields of all dialog boxes.

Tap the COGO ’7, icon to access the COGO menu.

Inverse

Three inverse tasks available in the Inverse menu are based on
computing the azimuth and distance between two points, given their
coordinates.

Two-Point Inverse

The Point-to-Point Inverse task computes the inverse (azimuth and
distance) between two known points.

1. Select the points for the task from map or from the list
(Figure 10-1 on page 10-2).

2. Tap the Calc button. The result of the calculation will be
displayed on the Results tab. The Map tab shows the results
graphically.

3. The icon in the upper-left corner of every COGO screen
displays graphically the task being performed. Tap this bitmap
to open the greater map. Tap the screen area to hide it.

P/N 7010-0493 10-1



COGO

ETWD—PDint Inverse ..
Al : ’
', D Inverse m
Pt To Pt
From Point |3

ToPoint |4
Ed &

‘/J

Inverse

Figure 10-1. Two-Point Inverse

Inverse Point to Points List

The Inverse Pt to Pt List task calculates the inverse for all the points
in the Points list with respect to a known point.

1. On the Inverse Pt to Pt List screen (Figure 10-2), select a point
and a point list (Figure 10-2).

= - -
s Einverse pt to pr st [l

e > -
« e )
Tverse STl I‘ Inverse Pt to Pt List RES‘:E
Point |5
B

Point List IPuintListl

List of Poil '% '

44 ,

43

$—2 v 4

< > =200 m |E|

Figure 10-2. Inverse Point to Point List
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2. Tap the Calc button. The result of the calculation will display
on the Results tab. The Map tab shows the results graphically.

3. The icon in the upper-left corner of every COGO screen
displays graphically the task being performed. Tap this bitmap
to open the greater map. Tap the screen area to hide it.

Inverse Point to Line

The Inverse Point to Line task calculates the horizontal offset of a
point with respect to a known line. The station along the line, where
the perpendicular passes though the point, and the height at this
station are also computed.
1. On Inverse Point to Line screen (Figure 10-3), select the point
name, and set the line by its start point, azimuth, and starting
station (Figure 10-3).

7 / Elnverse Point to Line ..
v » \'. Inverse Pt to Line RESUIDI
Inverse

Pt To Line
[®] Point 100

Start Point[lo1

B

& [Azimuth |[120.0000 dms

Start Stn  [0.+00.000
Calc

Figure 10-3. Inverse Point to Line.

2. Tap the Calc button. The result of the calculation wil display on
the Results tab. The Map tab shows the results graphically.

3. The icon in the upper-left corner of every COGO screen
displays graphically the task being performed. Tap this bitmap
to open the greater map. Tap the screen area to hide it.
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Point in Direction

The Point in Direction task calculates the coordinates of a point,
using a known point, and angle and distance offsets from it.

1. On the Point in Direction screen (Figure 10-4) enter the From
point name (known point), the azimuth set by value or as the
direction to another known point, the angle offset from the
azimuth line, the distance offset along the angle offset line and
the height offset. Also select a name and a code for the resulting
point (in the direction specified by azimuth and angle offset).

Epuint in Direction

7
;i@ i
n —> Point in Direction ResultDI

Pt in Direction Erom

& [ Azimuth |125.IIIIIIIIIU dms

Angle 2.0000 dms |[Ef

[100.000 m
vert Dist [5.000 m
OGO |10009 @]li” v
¥ Code l—"

Calc

Figure 10-4. Point in Direction

entry fields to add/subtract angle and linear values,
directly or use the Calculator. Start the calculator
from this field by pressing the F1 button on the
controller keyboard, or by tapping the Calculator
button on the pop-up keyboard for controllers with
soft input panels.

; To edit angles, azimuths, and distances etc., use the
~,

2. Tap the Calc button. The result of the calculation will display
on the Results tab. The Save button in the Results page should
be tapped to save the checked point. The Map tab shows the
results graphically.
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3. The icon in the upper-left corner of every COGO screen
displays graphically the task being performed. Tap this bitmap
to open the greater map. Tap the screen area to hide it.

Intersection

The Intersection task computes the intersection point or points when
given two known points and either the direction or distance from the
known points.

1. On the Intersection screen (Figure 10-5), select the points for
the task from map or from the list.

/' Elntersectiun
.j\ I Intersection m

Intersection

Point 1 B]

4
&% |Azimuth |[80.0000 dms
Point 2 |3

4
& |Azimuth |[50.0000 dms

COGO Point Ill]l]l]g

Figure 10-5. Intersection

2. By tapping the Distance/Azimuth/Az to Pt button in the
corresponding fields, select the parameter for to use and input
its value.

3. Enter the name and code of the first resulting intersection point.
Tap the Calc button. The result of the calculation will display
on the Results tab. The Save button in the Results page should
be tapped to save the checked points. The Map tab shows the
results graphically.

5. The icon in the upper-left corner of every COGO screen
displays graphically the task being performed. Tap this bitmap
to open the greater map. Tap the screen area to hide it.
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Calculator

A built-in calculator in TopSURYV performs calculations and
conversions. To access the calculator, tap the Calculator icon
(Figure 10-6).

818
Q0
Vo=

Calculator

+

=]
| =
w

= =

Figure 10-6. Calculator

To enter a calculated value to any entry field in
% . TopSURY, either press the F1 button on the
controller keyboard to start the calculator from this

field or tap the Calculator g icon on the pop-up
keyboard for controllers with soft input panels.

1. Enter the entire equation in the Input field, then press the
equals [=] button to calculate the result.

2. The Result field shows calculation results. This field is also
used as the ‘y’ or ‘theta’ values for rectangular / polar
conversions.

3. Once equals is pressed, the previous result is moved up to the
Previous Result field. This field is also used as the ‘x’ or ‘1’
values for rectangular/polar conversions.

4. To perform calculations, use the following buttons:

* MC — tap to clear the memory.
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Curve Solutions

MR - tap to recall the memory value, indicated by M in the
Input field.

MS - tap to save the already computed result into memory.

M+ — tap to add the already computed result to the value in
memory.

C —tap to clear all fields.
backspace (<-) — to remove the last entry.

copy — tap to close the calculator, in case it was started from
the COGO menu or to copy calculation results to that field if
the calculator was started from a field in TopSURV.

sci — tap to display/use the scientific calculator (Figure 10-7).

ECalculatur

DEQ g
n
S

Rad
2

log| ﬂ II
L JEE
s -o-<{ 80 5 160
o == I I | ~ ™
= - |-

Figure 10-7. Scientific Calculator

Curve Solutions

A curve is a part of a circle and thus can be described through the
center point (also called a Radius Point), the radius value and the

starting and ending points on the circle, also called a PC (Point of
Curvature) and a PT (Point of Tangency).

Using these values can help you find other curve parameters. For
detailed explanations on the different curve parameters, refer to the
TopSURYV Reference Manual.

P/N 7010-0493 10-7



COGO

The icon in the upper-left corner of every COGO screen graphically
displays the task being performed. Tap this bitmap to open the greater
map. Tap the screen area to hide it.

Curve

The Curve COGO task calculates the full set of parameters for any
curve, given one each, of the length and curvature parameters.

1. On the Curve Solution screen, select the curvature parameters
of the curve (Radius, Deg Chord, or Deg Curve) and the length
parameter of the curve (Length, Chord, Tangent, Mid Ord,
External or Delta), and the turn direction (Figure 10-8).

ECU[VE Solution Close ]
I:l Curve Solution |Results | Map

& [Radius 20,000 m
& CongthJENT

Curves Curye

H:lSm

Figure 10-8. Curve Solution.

2. Tap the Calc button. The result of the calculation will display
on the Results tab.

The Map tab shows the results graphically.

Pl & Tangents

The PI & Tangents task computes the PC point, the PT point, and the
center (Radius Point) of a curve, given the Point of Intersection (PI),
the radius, and the azimuths from the PI point to the PC and PT points
respectively. On the PI & Tangents screen, do the following

(Figure 10-9 on page 10-9):
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1. Select the initial data for the task and the names and codes for
the result points (Figure 10-9).

2. Tap the Calc button. The result of the calculation will display
on the Results tab.

=S

CUryes PI & Tangents

EPI & Tangents

@ PI & Tangents m
PIPoint |2 EAB]

Az PI To PC [01.000 dms
Az PIToPT [45.00 dms

¢ o

[@ pc point [ro014

[®] PT Paint |10015

i B -
RP Point [10016
=Tl 5

Calc

Figure 10-9. Pl & Tangents
3. Tap the Save button in the Results page to save the checked
points.
The Map tab shows the results graphically.

Three Pt Curve

The Three Pt Curve task defines the curve using three points: the PC
and PT points, and either the RP point, or any point on the curve. If
the curve point is defined, then the RP Point will be computed, and
can be saved.

1. On the Three Pt Curve screen, select the initial data for the
task. The screen changes its appearance, depending upon the
first point chosen
(Figure 10-10 on page 10-10).

Select the name and code for the RP point, if applicable.

3. Tap the Calc button. The result of the calculation will display

on the Results tab.
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4. Tap the Save button in the Results page to save the checked

point.
The Map tab shows the results graphically.
EThree Pt Curve
7| —p 3
: ffo Three Points Curve |Res
) »
Curves 3Pt Curve @ lD:
0
PC Point |2
PT Point |5

Curve ISmaII v

Figure 10-10. Three Pt Curve

Radius & Points

The Radius & Points task defines a curve using the PC and PT points
and a radius parameter, and computes the RP point coordinates.

1. Onthe Radius and Points screen (Figure 10-11 on page 10-11),
select the initial data for the task: the curve points, the radius
parameter, the direction of turn and whether the smaller (less
than 180 degrees) or the larger curve (more than 180 degrees)
between the curve points is to be considered. Also, enter the
resulting RP point name and code.

2. Tap the Calc button. The result of the calculation will display
on the Results tab.

3. Tap the Save button in the Results tab to save the checked point.
The Map tab shows the results graphically.
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Area

Radlius & Pts

Area

ERadius & Points ..

Radius Point m

PC Point |2

PTPoint [+
& rodvs ) [0 m

Turn IRight v

Curve ISmaII v
RP Point [10017 B

Figure 10-11. Radius & Points

The Area task calculates the area of a polygon formed by any points
(By Points task), or the coordinates of a point (Hinge task)/points
(Line task) that, after being added to Point List, form a polygon of the

desired area.

By Points

The By Points task calculates the area of a polygon.

1. Onthe Comp Area screen (Figure 10-12 on page 10-12), select
a point list that contains the points constituting the vertices of
the polygon. Use the arrow buttons to change the order of the
points (and thus the shape of the polygon).

2. Tap the Calc button. The result of the calculation will display
on the Results tab.

The Map tab shows the results graphically.

3. The icon in the upper-left corner of every COGO screen
displays graphically the task being performed. Tap this bitmap
to open the greater map. Tap the screen area to hide it.
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Hinge
On the Known Area — Hinge screen (Figure 10-13), the Hinge

method calculates the coordinates of a point that meets the following

conditions:

* The point is located on a known azimuth taken from the first point

of Point List.

* When the point is added to the Point List between the first and the

IE‘ Area |Results | Map

Point List  [PointList1

4ra

43 2
-$—2 4

41 &

> =200 m

Figure 10-12. By Points

last points, a polygon of known area is formed.

10-12

—

2|

Hinge:

EKnown Area - Hinge ..
Area |Results | Map

Total [ra63237

Reqd. Area lmﬁ
Rotation lg—v
Direction  [CounterCic v |

ORI e
@ Code I [
[ <« Back ” Calc ]

Figure 10-13. Known Area - Hinge — Area Tab 1
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Area

1. Select the point list, use the arrow buttons to change the order,
as desired and tap the Next button (Figure 10-13 on
page 10-12).

2. In the second screen under Area tab, select the known rotation
point from the list, the direction of rotation, the known
requested area, and the name and code of the resulting point
(Figure 10-14).

Goe |
Area Map

Point List PointList1|

]

4| List of Poir ~ '%

4ra

43 2
-$—2 4

41 &

< > =200 m

Figure 10-14. Known Area - Hinge — Area Tab 2

3. Tap the Calc button. The result of the calculation will display
on the Results tab.

4. Tap the Save button on the Results tab to save the checked
point.
The Map tab shows the results graphically.

To edit angles, azimuths, and distances etc., use the

% . entry fields to add/subtract angle and linear values,
directly or use the Calculator. Either press the F1
button on the controller keyboard to start the
calculator from this field or tap the Calculator icon
on the pop-up keyboard for controllers with soft
panels.
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Line

On the Known Area — Line screen (Figure 10-15), the Line method
computes the coordinates of two points that satisfy the following
conditions:

* The points are located on known azimuths, taken from the two
known points.

* The azimuth of the line formed by the points is known.

* Along with two other known points, the points form a
quadrilateral of the known area.

' A_2‘1 .|_-T EKnuwn Area - Line
L,T 4 b L = Area |Results | Map
rea ine
Total Im
Reqd.Area |4l:|942 i
Pt1 of |2 v
Pt2 of g v
@®lpta  [i0000
e >
@ Pt2 10001
E2 | v
I << Back " Calc ]

Figure 10-15. Known Area - Line — Area Tab

1. Select the initial data for the task: the start and the end points,
the azimuths from the points, the reference azimuth and the
known area value, and the names and codes of the resulting
points (Figure 10-15).

2. Tap the Calc button. The result of the calculation will display
on the Results tab. The Save button in the Results page should
be tapped to save the checked points.

The Map tab shows the results graphically.
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Corner Angle

The Corner Angle task calculates the angle formed by the directions
of two points from a middle point (Figure 10-16).

# ECD"‘IE[ Angle
— > Angle |Results | Map
Corner Angle

Start Point |1—
Mid Point |3—

End P
B ER

Figure 10-16. Corner Angle

1. Define the angle sides by selecting the start, middle and end
points.

2. Tap Calc to compute the angle. The result of the calculation
will display on the Results tab.

The Map tab shows the results graphically.

Line Offset

The Line Offset task calculates the coordinates of points along a line.
The line can be divided either by the number of subdivisions or by the
interval starting from the station specified.

1. Define the line by selecting the start and end point/azimuth of
the line. Select whether to assign the height of the starting point
to all the calculated points, or whether to compute the height
values using through linear height interpolation along the line.
If needed, select the starting station (chainage) and the number
of subdivisions to divide the line.

2. Tap Next (Figure 10-17 on page 10-16).
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10-16
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> "" Line & Offset Close
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Figure 10-17. Line & Offset
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Figure 10-18. Station & Offsets

On the Sta& Ofst screen (Figure 10-18), if needed, set the
starting station, station interval, offsets with respect to the line
at the station, and the starting name for the points calculated.

Tap Calc to compute and save the calculated ponts.
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Curve Offset

On the Curv & Offset screen, the Curve Offsets task calculates the
coordinates of points along a curve. The curve can be divided either
by the number of subdivisions or by the starting interval from the

station specified.

1.

Define the curve by selecting the starting PC point of the arc,
the radius parameters of the curve, the point of tangency and
the direction of turn, relative to the PC Point. If needed, select
the starting station (chainage) and the number of subdivisions
to divide the curve (Figure 10-19). Tap Next.

(s

L
Curye Offset

Tap Calc to compute and save the calculated points.
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Figure 10-19. Curve & Offset

On the Sta& Ofst screen (Figure 10-18 on page 10-16), if
needed, set the starting station, station interval, offsets with
respect to the curve at the station, and the starting name for the
points calculated.
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Road Offset

On the Road Offset screen (Figure 10-20), the Road Offset task
calculates the coordinates of points along a road. The road can be
divided by the interval starting from the station specified.

1. Select the road/ horizontal / horizontal and vertical alignments
to calculate the offset points. If needed, select the starting
station (chainage).

2. Tap Next.

oo
_’ & |Road lﬁ

Road Offset
ss  [o+o0.000 m

N

=200 m

i
Lo m

Figure 10-20. Road Offset

3. On the Sta&Ofst screen (Figure 10-18 on page 10-16), if
needed, set the starting station, station interval, offsets with
respect to the road at the station, and the starting name for the
points calculated.

4. Tap Calc to compute and save the calculated points.
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Adjust Points

The Adjust function performs transformation of points and includes
four tasks: Rotate, Translate, Scale, 2D Transform and Traverse

Adjustment.

Rotate

The Rotate task rotates the selected points around one specific point.

1. On the Rotate screen, do the following:

* Select the points for the task. In the Select Points field, tap the
By Range button and enter (set) the range of the point names,
or select points for the scaling task on the map or from the list
(Figure 10-21).

|

Adjust

—

©

Rotate

ERutate Close

Select Points

2 points selected

Rotation Point  [4
Rotation Method Im
Rotation Angle IE dms

Figure 10-21. Rotate

Enter the Rotation Point (the point at the center of rotation).

3. Specify whether the rotation angle will be input directly to the
Rotation Angle field, or as a difference between the new and old
azimuths (to the Old Bearing/Azimuth and New Bearing/
Azimuth fields).

4. Tap the Calc button to rotate the selected points.
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Translate

The Translate task moves a group of points together. On the
Translate screen (Figure 10-22), do the following:

1. Select the points for the task. In the Select Points field tap the
By Range button and set the range of points names, or select
points for scaling task on the map or from the list.

'
—

Select Points

Adjust Translate IZ

2 points selected

Translate By IAz,Dist,Ht -

Azimuth 45.0000 dms

Hz Dist I2UU-UUU m

vert Dist 1.000] m

Figure 10-22. Translate

2. Set the method of translation using the Translate By field, to
either Coords/Pts or Az, Dist,Ht.

¢ When the Coords/Pts method is selected, it means that all the
selected points will be moved in the same direction and
distance as between the points (locations), set by the next two
fields: From Pt (From Crd) and To Pt (To Crd). In the first
case, define only the point name. In the second case, the local
coordinates and the height of the location is needed.

* In the Az, Dist,Ht method, all the selected points move in a
specified direction by a specified distance. These parameters
are set through the Bearing (Azimuth), Horiz Dist, and Vert
Dist fields.

* Tap the Calc button to achieve the result.
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@ The limit for translation of points is 20,000 meters.

Scale

The Scale task scales the distances of a range of points relative to a
Base Point. On the Scale screen (Figure 10-23), do the following:

1. Select the points for the task. In the Select Points field, tap the
By Range button and set the range of the points names, or
select points for the scaling task on the map or from the list
(Figure 10-23).

TN

Select Points

2 points selected
Base Point I4—

Adjust Scale

Scale Factor 1.05

[] Scale Heights

Figure 10-23. Scale
Enter the Base Point name.
3. Enter the Scale Factor.

Check and enable the Scale Heights box if the height values
should be scaled also.

5. Tap the Calc button to achieve the result.
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2D Transform

The 2D Transform task recomputes the plane coordinates of a set of
points using the transformation parameters defined by pairs of points
known in two systems. On the 2D Transform screen (Figure 10-24),
do the following:

1. Press the Add button to enter pairs of points / plane positions.
for obtaining transformation parameters. After all necessary
pairs are defined, tap Next. The Point Pair Info screen displays
(Figure 10-25 on page 10-23).

LA |# 2D Transform Close
+ + From Pt N E

2Drm 1 1499.981 1000.000

2 1000.000 1699.893

< >

[Delete ] [ Edit ] [ Add ]

Figure 10-24. 2D Transform

2. Enter a pair of points/plane positions and tap OK.
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Figure 10-25. Point Pair

Adjust Points

3. Check the transformation parameters, select points to
transform, either by a range of points, or points from the map/
list, or all points on a layer selected.

4. Tap Calc to perform the two dimensional transformation of
these points (Figure 10-26).
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Transformation | Walue |
Origin Position
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East 1349.947
Offset
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Scale Factor 1.061255801
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Select Points

2 points selected
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Figure 10-26. 2D Transform Parameters
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Traverse Adjustment

Traverse adjustment is performed to provide a mathematically closed
figure and at the same time to get the best estimates for positions of
all the traverse stations.

1. On the first Adjustment screen (Figure 10-27), select initial
data for traverse adjustment: the stations on which the traverse
originates and closes, whether to adjust elevations and sideshots
or not, an Earth curvature value, and a job to store adjusted
traverse stations. Then tap the Next button. The second
Adjustment screen displays (Figure 10-28 on page 10-25).

Q J\F E Adjustment
Start Point |OCC
Adjust Traverse
End Point [111 -

4
[] Adjust Elevation
[ ] Adjust Sideshot
Curvature Iﬁ

Job to store the results
New | [TPS\TopSURV\Jobs\tr. tsj

Figure 10-27. Traverse Adjustment

2. On the next Adjustment screen (Figure 10-28 on page 10-25),
select the method of traverse adjustment to apply (check and
enable either Apply Compass Rule or Apply Angle Balance),
and a technique to close the traverse if it is unclosed.
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[] Apply Angle Balanc

Closed Traverse
Close Traverse Ta

|start Point v

Point: Jocc

Figure 10-28. Adjustment

3. Press the Adjust button to adjust the traverse. The Adjustment
Results screen opens to display the results.

The traverse points adjusted will be saved in the new job as
calculated points.

Traverse

This function is used to calculate Traverse and Sideshot points, based
on horizontal and vertical Offsets, along a direction defined by an
azimuth, or right, left or deflection angles.

On the Traverse Calc screen (Figure 10-29 on page 10-26), select the
initial data for the traverse task and the name and code for the
resulting point (To Point).

The initial data includes the starting point, the azimuth to the
calculated point, and the horizontal and vertical distance to it. The
azimuth can be entered as is, or it can be computed from the right or
left angles, or deflection entered in this field. Enter Backsight
information input with the help of the BS Point button.

1. To calculate the result point (To Point) without changing the
From Point, tap the SideShot button. The 7o Point is
incremented to the next new point in the database.
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COGO

2. To calculate the result point (To Point), tap the Traverse button
to change the From Point to the To Point. The To Point changes
to the next new name in the database.

;7

Traverse

ETraverse Calc Close

—_— Traverse Calc m
From Point |ﬂ|
&= [Azimuth [45.0000  dms
Hz Dist |15.l]l]l:l m
Vert Dist IIII.SIIIIII m
Topoint [iooo7
(2] v
@ Code I v

I BS Point ”Side Shot ” Traverse ]

Figure 10-29. Traverse Calc

To edit angles, azimuths, and distances etc., use the
entry fields to add/subtract angle and linear values,
directly or use the Calculator. Either press the F1
button on the controller keyboard to start the
calculator from this field or tap the Calculator icon
on the pop-up keyboard for controllers with soft
input panels.

10-26
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Appendix A

mmGPS Operations

In the event that a point is lost, the resection operation can measure an
unknown point, based on the measurements of three or more
surrounding points. The self-levelling mechanism may also need to be
measured and the transmitter calibrated to ensure correct grade.

The following operations require that the transmitter and sensor have
already been setup, as seen in “Initializing mmGPS+" on page 8-13

Resection

The resection function measures an unknown transmitter location
using the rover and three or more points.

When performing a resection, use the following guidelines to ensure
accurate measurements of the Rover points:

» Take measurements at 3 or more points around the Base
transmitter in a balanced, symmetrical pattern (not clustered in
one area).

* Have the sensor facing towards the transmitter during each
measurement.

* Angle the sensor between 6° higher or lower than the
transmitter’s beam, not straight on.

1. With the controller and sensor connected, tap Setup » Init
mmGPS. The Init mmGPS+ screen displays (Figure A-1 on
page A-2).
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mmGPS Operations

2. Tap the Position tab, select a transmitter, then tap the Resect
button (Figure A-1 on page A-2). The Resect screen displays
(Figure A-2 on page A-2).

! L = = 4
/F\ - 1 STl ok |cancel
ﬁr Data | Pos | Sensor
Setup GPS mmGPS Init
Name |ID | Point
21 1
2
3
4
< >
lResectl [ Edit l lDeIete l

Figure A-1. Select Transmitter

3. Tap the Sensor tab, then tap the Init Sensor button
(Figure A-2).

Settingsl 0K ICanceI]
Sensor | Resect | Data

Receiver Port ID v
Transmitter ID |1
Sensor Gain IAutl:l v

[]Init Time Improvement

|:| Known Trans Horz Pos

Figure A-2. Initialize Sensor

4. 1If Known Trans Horz Pos was enabled, the Known Point screen
displays (Figure A-3 on page A-3). Select the point over which
the transmitter was setup using the map or list icons and tap
OK.
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Map Icon

Figure A-3. Transmitter Over Known Point

E Known Point OK [ Cancel

Point [TR

Transmitter

Name 21
D 1
Ht 1303 m  [slant v

[]2m Fixed Tripod

—List Icon

Resection

When the sensor is successfully initialized, TopSURYV displays

the setup successful screen. Tap Close to continue.

5. Tap the Resect tab (Figure A-4).

* If using an unknown point, tap Start.

* If using a known point, check and enable the Known Point
box and select a point to occupy by tapping the map or list

icons and enter the antenna’s height. Then tap Start.

Settings l 0K lCanl:eI ]

[ Sensor | Resect | Data ]

il Fived H W
0% 0021 0021 74

Meas 1

[ ]Known Point
|

AntHt 2170 m  [vertic

Settings I 0K ICanl:eI ]

Sensor | Resect | pata
ol Fieed HO W ghef
100% 0015 0016 7+0

Meas 1

Known Point
[RSCT-KWN

|Vertic v

Ant HE [2.170 m

Figure A-4. Use Unknown or Known Point
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mmGPS Operations

‘When the sensor receives the transmitter’s beam, the mmGPS
icon displays (Figure A-5).

During the measurement, the Resect tab displays the number of
GPS epochs used in the resection calculation (Figure A-5).

6. When the desired amount of time has passed, tap the Stop
button (Figure A-5).

Settingsl 0K lCanceI]
Sensor | Resect | pata

il Fieed H W g f
100% 0013 0022 gr 0

Meas 1

e

Logging... 4

[ ]Known Point
|

AntHt 2170 m  [vertic

Figure A-5. Measure Point

7. Move to the next point and repeat steps 4 and 5 for three or
more points.

8. Tap the Data tab to view the results (Figure A-6 on page A-5).

* Only after three or more points have been measured will data
display. The first two points will not display any data.

» Tap the Re-Meas button to clear all data and restart he
resection process (Figure A-6 on page A-5).
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Resection

Settingsl 0K ICanceI]
Sensor IResect| Data ]

M... HRM... |VRM... |Lat
M. 0.539 0.012 37.4.
< >

Figure A-6. Resection Data Results

9. If the resection values are acceptable, tap the Accept button
(Figure A-6) and view the point information for the transmitter

(Figure A-7) on the Add Point screen.
10. Tap OK to save the transmitter’s point information.

 Enter any other desired information (such as, codes or notes).

* If the transmitter is over a control point, check and enable
Control Point box.

Frad ror [ R
Point Info | LayerjStyle | Phutﬂ | L4

[®] Point ITransmitter21
¥ code I A N
Note |Transmitter
WGS84(m)

Lat |55.431349533
Lon |37.390736146
Ell ht |162.713

[] Control Point

Figure A-7. View Point Information
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mmGPS Operations

11. After the resection (Figure A-8), initialize the sensor. See
“Sensor Initialization” on page 8-16 for details.

|

The Sensor must be initialized.

Close

Figure A-8. Initialize Sensor after Resection

After performing a resection, check the results using the Known Point
Offset function. This function also provides an option to adjust the
transmitter’s height using the new offset.

1. On the Init mmGPS+ screen, tap the bitmap menu in the
upper-left corner of the screen and select Known Point Offset
(Figure A-9).

AT ok | cancel
Field Calibration
Known Point Offset
Help |Data |
21 1 OK
2
3
4
| add | [ edit | [pelete |

Figure A-9. Open Known Point Offset
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Resection

2. Select the Rover’s known point using the map or list icons,
then tap Start (Figure A-10).

EKnuwn Point (m

Transmitter Name 21 -

Point [RSCT-KWN-TS
Height Offset [0.000 m

Epoch Count

Figure A-10. Select Rover’s Point and Begin Averaging

When the averaging completes, the screen displays the height
offset for the transmitter’s height (Figure A-11).

EKnuwn LN OK | Cancel
Transmitter Name |21

Point [RSCT-KWN-TS
Height Offset [0.06932 m

Epoch Count 1]

Figure A-11. Transmitter’s Height Offset Averaged

3. Tap OK, then tap Yes at the Warning! screen to adjust the
transmitter height using the results (Figure A-12 on page A-8).
The offset will be automatically added to the transmitter’s
height.
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mmGPS Operations

ot |

Do you want to adjust the
Transmitter Height using this
value?

Figure A-12. Adjust Transmitter’s Height

4. When finished, initialize the sensor. See “Sensor Initialization”
on page 8-16 for details.

Field Calibration

The field calibration function fixes incline error in the self-leveling
mechanism of the transmitter.

1. At the transmitter, hold the plumb beam key, then tap and
release the power key to put the transmitter into calibration
mode.

2. With the rover, walk over 30 meters away from the transmitter
and face the sensor towards the transmitter.

= ~ Use a bi-pole to ensure the sensor remains steady
throughout the calibration process.

3. With the controller and sensor connected, tap Setup GPS » Init
mmGPS. The Init mmGPS+ screen displays (Figure A-13 on
page A-9).
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Field Calibration

4. On the Init mmGPS+ screen, tap the Help Icon menu in the
upper-left corner of the screen and select Field Calibration
(Figure A-13). The Calibration screen displays (Figure A-14).

Einit mmers+ S Bl
Field Calibration
Known Point Offset
Help |Data |
21 1 OK
2
3
4
| add | [ edit | [pelete |

Figure A-13. Open Field Calibration

5. On the Calibration screen, select the transmitter that will be
calibrated from the Transmitter Name drop-down list and tap
Next (Figure A-14).

E Calibration

Set Transmitter to Field
Calibration mode.

Transmitter Name IIIIBIIIIII21 -

Figure A-14. Select Transmitter to Calibrate

6. Adjust the height of the sensor so the angle is less than 1°. Once
the Angle is OK, tap Next (Figure A-15 on page A-10).
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mmGPS Operations

E Calibration E Calibration

Adjust the height of the Adjust the height of the

Sensor if required. Sensor if required.

1 Move UP +~ Angle is OK
-2.3847 dms -0.0651 dms

Figure A-15. Check Angle of Sensor

during any stage of the calibration, an error

@ If the sensor experiences excessive movement
message will display. Tap Close.

7. Tap Calibrate after the auto-levelling process completes
(Figure A-16).

E Calibration E Calibration

Face front of Transmitter Getting Data
towards Sensor and wait for
auto-leveling to complete.

-0.0702 dms

Calibrate I

Figure A-16. Begin Field Calibration

8. Turn the transmitter 180° so the back faces the transmitter. Tap
Calibrate (Figure A-17 on page A-11).
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E Calibration Close

Reverse Transmitter so the
back is facing the Sensor
and wait for auto-leveling to
complete.

Calibrate

Field Calibration

E Calibration Close

Getting Data.....

-0.0702 dms

_—

Figure A-17. Turn Transmitter to Back and Collect Data

9. Turn the transmitter 90° so the left side faces the transmitter.

Tap Calibrate (Figure A-18).
E Calibration

Face the Left side of
Transmitter towards Sensor
and wait for auto-leveling to
complete.

Calibrate

E Calibration

Getting Data.....

-0.0702 dms

_—

Figure A-18. Turn Transmitter to Left and Collect Data

10. Turn the transmitter 180° so the right side faces the transmitter.
Tap Calibrate (Figure A-19 on page A-12).
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mmGPS Operations

E Calibration __ E Calibration Close

Reverse Transmitter so the Getting Data
Right side is facing the
Sensor and wait for auto-
leveling to complete.

-0.0702 dms

Calibrate I

Figure A-19. Turn Transmitter to Right and Collect Data

When the calibration completes, the Update Calib Data screen
displays the offsets (Figure A-20 on page A-13).
If the offsets were outside the tolerance range, TopSURV will
indicate that the transmitter needs to be updated (Figure A-20 on
page A-13).
11. Disconnect the controller and sensor. At the transmitter,
connect the controller and transmitter.

12. On the Update Calib Data screen, select the Com Port that
connects the controller and transmitter and tap the Update
Data button (Figure A-20 on page A-13).
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Field Calibration

EUpdate Calib Data Close ]

X and Y offsets were beyond
tolerences. The Transmitter
needs to be updated.

Connect the Controller to
the Transmitter, then click
Update.

Com Port |COM1 v

X -0.0026 dms
Y 0.0018 dms

Update Data

Figure A-20. Field Calibration Results

TopSURYV uploads the calibration data to the transmitter and
automatically turns off the transmitter.

13. When finished, tap Close on the Message screen (Figure A-21).

oot co o po

X and Y offsets were beyond
tolerences. The Transmitter Transmitter Setup Successfully!
needs to be updated.

Connect the Controller to
the Transmitter, then click
Update.

Com Port i
X -0.0026 d

Y 0.0018 dms

|Retrieving Calibration Data

| Update Data

Figure A-21. Uploading Calibration Data

14. Initialize the sensor according to “Sensor Initialization” on
page 8-16.
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mmGPS Operations

After loading the new calibration data into the

% . transmitter, re-calibrate to check the system. The
transmitter may need to be calibrated a couple of

times depending on site conditions.

mmGPS Options

When configured for mmGPS, an options menu selection provides
further functionality for applying height differences and selecting
whether or not to use mmGPS and weighted height computations.

1. On the Status screen (SRV » Status), tap the bitmap menu in
the upper-left corner of the screen, and select mmGPS+
Options (Figure A-22). The mmGPS+ Opts screen displays.

Settings | Close

Rover Antenna Setup
Config Radio

REEEte TS 13:30:54

mmGPS+ Options d

Help

Morth -10754.334
East 12243.693
Elev  87.856

<% ppop 1.8
H 2201 v 3200 m
Base Dist 3363.249 m

Figure A-22. mmGPS+ Options
2. On the mmGPS+ Opts screen (Figure A-23 on page A-15),
select the following options:
* Use mmGPS+ — tap to enable the use of mmGPS.

» Use weighted height computations — check and enable to use
weighted height computations
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mmGPS Options

3. Height Difference Limit — enter a value here between the GPS
result and the mmGPS result (Figure A-23). tap OK.

mmGP5+ is DISABLED

EmmGPS+ Opts m Cancel

|Tum mmGP5+ ON

Height Difference Limit

ID.BDD m

Figure A-23. Select mmGPS+ Options

If the difference between the measured GPS height and the
mmGPS height is greater than the entered value, the mmGPS icon
changes (Figure A-24).

- T oo [ o |

Pos | Sys | Plots | SVs

ﬂa 13 ﬂ* 13 UTC [13:33:14
Fixed

WGS84(m)

Lat 37 : 39: 2071390 N

Lon 121: 49: 21.14703 W

Ell ht 116.101

<% ppop 1.8

H 0.011 ¥ 0.005 m
Base Dist 47.986 m

oF]

Figure A-24. mmGPS Icon with Height Difference Limit

P/N 7010-0493

A-15



mmGPS Operations

Notes:
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Appendix B

Using Topcon Link with
TopSURV Joh Files

The following pages describe the typical process for importing,
editing, calculating, and exporting TopSURYV data in Topcon Link.
The example applied below performs a simple viewing and editing
process after importing TopSURYV data.

BEFORE importing data from TopSURY, perform the following
actions:

Oinstall Topcon Link and Microsoft® ActiveSync® onto the
computer.

CIConnect the TopSURV controller and computer using
Microsoft ActiveSync.

AFTER importing data from TopSURY, perform the following
functions:

|:|Import TopSURY data (*.tsj file) into the computer.

|:|Open the *.tsj file by Topcon Link.

[CJEdit the instrument height on one station.

ORecalculate the point coordinate.

CJAdd five points in an NADS83 coordinate system into the job.
O calculate localization parameters.

|:|Rep0rt TS coordinates in NADS3.

DExport the points into DXF file format.
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Using Topcon Link with TopSURYV Job Files

Importing TopSURV Jobs

TopSURY stores data in the *.tsj file format. This file format can be
opened by Topcon Link.

The installation of Active Sync® on the computer creates the Mobile
Device folders in the computer. Using this folder it is possible to:

* transfer a file from the controller to the computer
* save this file to any computer folder
Without Topcon Link:
1. Connect the FC 200 controller and computer using the USB

cable and Microsoft ActiveSync.

2. Open Windows Explorer and click the Mobile Device folder.
Navigate to the directory that contains TopSURV’s jobs
(\Storage Card\TPS\TopSRV’Jobs).

3. To import the (TS_Columbus.tsj) file from the FC 200, copy
the selected *.tsj file to the desired computer’s folder
(C:\TopSURV _Jobs) in which to save the downloaded file(s):

= Jobs - [O]X] ® Topsumy_so: - [B[x]|
i Gl
Q Back ~ 0 = ? p Search = Folders E- Q Back ~ (;.) 7 tf 7 Search
Address {3 |5torage Card|TPSITopSURVYIobs v|EJsn | addess |3 citTopsry 0B v Go
Folders X [ hArchive Folders 2
& ) Geo ) [Blpefauttsi [ 52 Poelkon &
) Geoids [ 7s_Columbus.t=) @ O Contral
) Help # [J mobiler
[5) IEFiles # @2 Hero e
& () Images * 4@ Topcan
= '3 Jobs # @ Topeon
1) Archive & €l Topeon
O Lng ~ # & Topoon %
< > < >

Figure B-1. Importing a *.tsj job from the Controller to the Computer

TopSurv must be closed in order to transfer job files
@ because the database is locked by the TopSURV
process and cannot be accessed by another one.
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4. When the process of sending the file(s) from the TPS Controller
to the computer starts, the Copy & Convert Progress window
displays the import in progress:

Copy & Convert to desktop computer format... &

@ B

T5_Columbus

Copying (fiam *obs' o deskiop computer] Iy
NENEEENEEENNEEENNENENNEEEEEN

Cancel

Figure B-2. Import in Progress

5. The downloaded file will be saved in the desired folder.

Opening, Viewing, and Editing
TopSURYV GPS Files

The examples used in the following pages are from the TS project
shown in Figure B-3.

Measurements were collected by a GTS-226 Topcon Total Station in
the ground coordinate system.

Northing, |
UsFeet

5250 —

5000

4750

000 Szs0 5500

Figure B-3. TS Project Used
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Using Topcon Link with TopSURYV Job Files

To open an imported TopSURV PC Job:
1. Click File » Open File.

2. Navigate to the location of the file and select the desired
file.

3. Select the “TopSURYV 7 Job” format name.

File name: |TS_Columbus.tsj

Format name: | TopSURY ¥ Job - TopSURY Jaob [*.ts)) j

Open Cancel

Figure B-4. Open Window

The TopSURYV PC Job displays information on the four tabs:
Points, Lines, TS Obs, and Codes.

=
«° Points |2 Lines | ¢, T50bs | & codes |
1..| Wame | Ground Worthin... | Ground Easting ... | Elevation fusft) | Code Hote | Photo Motes
& Pl 5000,000 5000,000 700,000 WAL
& P2 5468,521 4999,994 702,357 MAIL
< 3 5042,998 5078,655 698,490 MAIL
< 1w 5034,321 4976,045 701,023 BC
< 10t 5035,778 4995,383 700,328 BC
< 102 5036,734 4997485 700,237 BC
ERtic] 039,104 4998115 700,135 BC
PR - E

[ CAD View

Ready USFeel DMs Ground Mone:

Figure B-5. CAD View and Points Tab: Ground Coordinate System
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Editing Instrument Height on the Station

1. To edit the instrument height, click the 7'S Obs tab, right-click the
desired station (CP4) and click Properties.

2. Enter the desired height value (for example, 5,344 US ft).

o° Points | 7] tnes O TS Obs | & codes |
L # | Paint Mame | Instrument Hel... | Ml e
Gt P1 0
ooz (& + Properties : TS Occupation 4.CP4
& 3 Pz
& 4 g | General |
] cps | Paint Name D -
AL P65 \nstrument Height (USH) [5342
& 7 cPL
4 14
| oK | Cancel | ‘
Figure B-6. Editing Instrument Height
3. Click OK

heights, antenna types, antenna height measurement
methods), the point coordinates must be
recomputed.

@ When editing data (point coordinates, antenna

Compute Coordinates

To calculate (or recalculate with new settings) coordinates, click the
Compute coordinates of points icon Ej on the toolbar. The
updated coordinates display on the Points tab.

View Points Coordinates

The Points tab (Figure B-5 on page B-4) lists all points stored in the
file. All points of the job are located in the Ground Coordinate
System.

To calculate the localization parameters between the Ground
Coordinate System and the NAD 83 system, two sets of coordinates in
the different systems are needed for the same points:

* in the NAD 83 coordinate system

* in a Ground Coordinate system.
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Using Topcon Link with TopSURYV Job Files

Add New Points in Different Coordinate

System

We have the list of coordinates for the TS points in NAD 83
coordinate system. These coordinates should be added in the job.

Before adding the points, select the NAD-83 coordinate system in the

Status Bar:

USFeet
Ground

DMS  |Groun ¥ | fone

Datum Lat, Lon, EllLH

1. To add a new point to the file, click on the Add Point

W&sE4 Lat, Lon, EILH
Datum Lat, Lon, Elevation

Datum Lat, Lon, EILH - WADE: =

UZON
MAHE
MARCO
MASSAWA
MERCHI
MEZ2T
MIDWAY
MINEA
MINNA_
MONTSER.
MRT94

USFeet DM3

Figure B-7. Status Bar- Coordinate Type List

the toolbar. The Add Point screens display.

2. Enter a point’s Name (with the extension, _NADS83) and
Coordinates in the NADS3 for all five points (Figure B-8). Click

OK.

: Add Point : Point User1

EX

: Add Point : Point User1

iE]E5]

> icon on

General | Coordinates | PhotoMotes | Codes andstyle | Gereral  Coordinates | PhotoNates | Codes and Stvie |
Name CFZ_NADES
LatLon
Hots ‘ Lattude D7 ——
Longitude [EEaeiserw
Contiol [None =l EllHeight [USH) (510,587
Code | -
Layer [E =l
e [
oK Cancel Apply oK Cancel Apply
& cPe
<4 1000
°  CP2_NADE3 40°06'11,08726N 8295916, 1647w 10,587
©  CP3_NADE3 40°05'07, 628080 8295912, 51460W 06,716
©  CP4_NADE3 40°0613,12269N  B2°59 100, 66572 609,265
= CPS_NADS3 40°06'07, 237870 B2°5906,52397W 807,545
s CP6_NADE3 40°06'05,22798N  82°59'12, 11935W 808,409
<
UsFest | DMS | Datumlat, Lom, ELH | NAD83

Figure B-8. Add Point Dialog Box - General and Coordinates Tabs
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3. To calculate localization parameters, click ¥ (Perform a
localization) on the toolbar. On the Localization screen
(Figure B-9), click Add point and select the corresponding points
in the corresponding columns:

WS Poink [ [ Local point [ 7% Localization
[cPz_napes  ~|

G5 Point | Local Poirk
A CPZNADEI P2
& CP3_NADS3 CP3
& CP4_WADE3 P4
& CPS_WADE3 CPS

& CPE_NADE3
Figure B-9. Adding the Point Pairs

4. Two added points (CP3 and CP5) will be used only in horizontal
localization, and other three points (CP2, CP4, and CP6) will be
used in horizontal and vertical localization. To set this status for
these points, select the desired type in the Use column for each
point (Figure B-10):

(CPZ_MADE3

=
b
@A
=
E
=}
5
%)

Use:

WG5S Poink ‘ Local Point ‘ Use |
Horizontal and Vertical A CPZ_NADEI  CP2 Horizonkal and Yertical
Horizontal and Vertical O CP3_NADSS  CP3 Vertical

& CP4_NADSI P4 Horizontal and Yertical

0O CPS_MADE3 CPS
Horizontal and Yertical A CPE_NADES CPF Horizontal and Yertical

Figure B-10. Selecting point pair type

5. To calculate localization parameters using the desired point pairs,

click the Compare parameters button. The left panel
of the Localization screen displays these parameters:

Ratation [25'3143 6346

Scals [1.0000601586

Deflection Morth |oro1'35. 7985

Deflection East [r0274.3801
Origin Lat [40°0E11,08726M
Origin Lan |62°5916. 10547

Origin EIL H [USA) 810,587
Origin Northing (USH) [5458521
Origin Easting [USH] 43599934
Origin H [USft) |702,257

Figure B-11. Localization Parameters

6. All points in the job have coordinates in both the Ground
coordinate system and the NAD83 coordinate system. To see the
coordinate in the desired coordinate system, select the
corresponding coordinate system on the Status Bar.
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Using Topcon Link with TopSURYV Job Files

7. Figure B-12 displays the coordinate job point in NAD83
coordinate system.

=
= -|
% Points |77 Lines | ¢, Ts0bs | & codes |

1. Name | Latituds | Longitude | EllHeight (USFt) | Code Mote | Phota
<& 110 40°06'07, 06765N  82°59'13,35765W 808,298 BC

& 111 40°06'6, 906160 82°55'13,24045wW 808,228 BC

& 112 40°06'06, B85704N  82°59'13,19629W 808,223 BC

< 113 40°06'6,89281N  82°59'13,15616wW 808,281 BC

< 114 40°06'06, 95757 82°59'13,00163W 808,331 BC

& 115 40°06'6,49076N  82°59'12,66901 W 808,357 BC

< 116 40°06'06,42285H  82°59'12,82911W 808,194 BC

<17 40°06'06,40195H  82°558'12,05410wW 808,227 BC

<

B CAD View

Ready

USFest DMs Datum Lat, Lon, EILH WADE3

Figure B-12. CAD View and Points Tab: NAD83 Coordinate system

Save the File

To save all changes in the file click the Save File [ icon on the

toolbar.

Topcon Link creates a backup of the original file with an additional
extension (*.initial; for example, TS_Columbus.tsj.initial). This
backup file remains in the same folder as the *.tsj file
(TS_Columbus.tsj). Any further changes will be made to the *.tsj file.
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Converting a TopSURY File to an
AutoCAD File Format

This section describes converting the opened ‘T'S_Columbus.tsj’
database file to the ‘AutoCAD DXF’ file format and saving the point

coordinate in the State Plane Coordinate system (Ohio (North)) into
this file.

1. Click Save As on the toolbar. Select the ‘Name,N,E,Z,Code’
format and enter the name of the created file (Figure B-13).

File narne: |T5_Columbug

Farmat name: ‘ AutaCAD DFF - Design [7.def) j

Figure B-13. Select the DXF File Format

2. Click Advanced options. Enter the parameters required after
the conversion (Figure B-14):

e Select Grid,Ell.H, Ohio (North) and NAD 83 in the
corresponding fields.

* Select the AutoCAD Points with Text Fields as point style for
the job’s point.

- Advanced options

Metric unit: ‘[D efault [USFeet)] j
Cooidinate type: ‘Elﬂd, EIH j
Prajection: ‘ Othia (North) j Custom...

Datum: [NaDEZ 3|
Coordinate order: ‘ J
Faint style ‘AuluE'AD Points with Test Fields j

Line Style
[ Use 30 coordinates

Figure B-14. Select Advance Options
3. Click Save to convert the TopSURYV file into a DXF file.
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Notes:

B-10 Topcon Link Getting Started Guide
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